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Important Regulatory and Safety Notices to Service 
Personnel

Before using this product and any associated equipment, refer to the “Important Safety 
Instructions”  listed below to avoid personnel injury and to prevent product damage.

Product may require specific equipment, and/or installation procedures to be carried out to satisfy 
certain regulatory compliance requirements. Notices have been included in this publication to call 
attention to these specific requirements.

Symbol Meanings

Important Safety Instructions

3) Heed all warnings.

4) Follow all instructions.

5) Do not use this apparatus near water.

6) Clean only with a dry cloth.

7) Do not block any ventilation openings. Install in accordance with manufacturer’s instructions. 

Protective Earth This symbol identifies a Protective Earth (PE) terminal, which is 
provided for connection of the supply system’s protective earth (green 
or green/yellow) conductor.
This symbol on the equipment refers you to important operating and 
maintenance (servicing) instructions within the Product Manual 
Documentation. Failure to heed this information may present a major 
risk of damage or injury to persons or equipment.

Warning The symbol with the word “Warning” within the equipment manual 
indicates a potentially hazardous situation, which if not avoided, could 
result in death or serious injury.

Caution The symbol with the word “Caution” within the equipment manual 
indicates a potentially hazardous situation, which if not avoided, may 
result in minor or moderate injury. It may also be used to alert against 
unsafe practices.

Notice The symbol with the word “Notice” within the equipment manual 
indicates a situation, which if not avoided, may result in major or 
minor equipment damage or a situation, which could place the 
equipment in a non-compliant operating state.

Warning Hazardous 
Voltages

This symbol is intended to alert the user to the presence of uninsulated 
“dangerous voltage” within the product enclosure that may be of 
sufficient magnitude to constitute a risk of shock to persons

ESD Susceptibility This symbol is used to alert the user that an electrical or electronic 
device or assembly is susceptible to damage from an ESD event. 

Warning 1) Read these instructions.

2) Keep these instructions.

 



8) Do not install near heat sources such as radiators, heat registers, stoves, or other apparatus 
(including amplifiers) that produce heat.

9) Do not defeat the safety purpose of the polarized or grounding-type plug.  A polarized plug has 
two blades with one wider than the other.  A grounding type plug has two blades and a third grounding 
prong. The third prong is provided for your safety. If the provided plug does not fit in to your outlet, 
consult an electrician for replacement of the obsolete outlet.

10)Protect the power cord from being walked on or pinched, particularly at plugs, convenience 
receptacles, and the point where they exit from the apparatus.

11) Only use attachments/accessories specified by the manufacturer.

12)Unplug this apparatus during lightning storms or when unused for long periods of time.

13)Refer all servicing to qualified service personnel. Servicing is required when the apparatus has 
been damaged in any way. This includes power-supply cord or plug damage, liquid being spilled or 
objects having fallen into the apparatus, the apparatus  being exposed to rain or moisture, the 
apparatus having been dropped, or the apparatus not operating normally.

14)Do not expose this apparatus to dripping or splashing, and ensure that no objects filled with 
liquids, such as vases, are placed on the apparatus.

15)To completely disconnect this apparatus from the AC Mains, disconnect the power supply cord 
plug from the AC receptacle.

16)The mains plug of the power supply cord shall remain readily operable.

17)The SD (Video Production Switcher) chassis is to be rack mounted only.  

19)The safe operation of this product requires that a protective earth connection be provided.  A 
grounding conductor in the equipment's supply cord provides this protective earth.  To reduce the risk 
of electrical shock to the operator and service personnel, this ground conductor must be connected to 
an earthed ground.

20)WARNING:  This apparatus, when equipped with multiple power supplies, can generate high 
leakage currents.  To reduce the risk of electric shock, ensure that each individual supply cord is 
connected to its own separate branch circuit with an earth connection.

21)CAUTION:  These service instructions are for use by qualified service personnel only.  To reduce 
the risk of electric shock, do not perform any servicing other than that contained in the operating 
instructions unless you are qualified to do so.  (Installation Guide only.)

22)This apparatus contains a Lithium battery, which if replaced incorrectly, or with an incorrect type, 
may cause an explosion.  Replace only with the same type.  Dispose of used batteries according to the 
manufacturer’s instruction.

23)Service barriers within this product are intended to protect the operator and service personnel from 
hazardous voltages. For continued safety, replace all barriers after servicing.

24)Certain parts of this equipment still present a safety hazard with the power switch in the OFF 
position.  To avoid electrical shock, disconnect all A/C power cords from the chassis' rear appliance 
connectors before servicing.

25)This product contains safety critical parts, which, if incorrectly replaced, may present a risk of fire 
or electrical shock. Components contained within the product’s power supplies and power supply area 
are not intended to be customer-serviced and should be returned to the factory for repair.

26)To reduce the risk of fire, replacement fuses must be the same type and rating.

Warning 18) Indoor Use: WARNING: To reduce the risk of fire or electric shock, do not expose this 
apparatus to rain or moisture



27)Use only power cords specified for this product and certified for the country of use. Refer to the 
Product Power Cord Requirement section that follows.

28)The safe operation of this equipment requires that the User heed and adhere to all installation and 
servicing instruction contained within the equipment’s manuals.

Product Power Cord Requirements

This product is supplied with certified 10A/125V SVT type supply cords.  Conductors are color coded 
white (neutral), black (line) and green or green/yellow (ground). 

Operation of this equipment at line voltages exceeding 130V requires that alternative supply cords 
with appropriate voltage and current ratings be used.

International  Line Voltages 200 - 240 Volts
This product has been designed for use with certified IEC 320- C13 10A/250V - H03 VV-F3G 
1.00mm2 type line cord. 

International product orders are supplied with a certified 10A/250V line cords, utilizing a molded 
3-pin IEC 320-C13 type connector at one end and stripped conductors on the other. One line cord is 
provided.  Conductors are CEE color coded; blue (neutral), brown (line), and green/yellow (ground).  

Installation by a qualified electrician, of an appropriately approved A/C wall plug certified for the 
country of use, is required.

Alternatively, other IEC 320 C-13 type power cords may be used, provided that they meet the 
necessary safety certification requirements for the country in which they are to be used. Refer to the 
correctly specified line cord above.

EMC Notices

United States of America
FCC Part 15

This equipment has been tested and found to comply with the limits for a class A Digital device, 
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference when the equipment is operated in a commercial environment. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in 
accordance with the instruction manual, may cause harmful interference to radio communications. 
Operation of this equipment in a residential area is likely to cause harmful interference in which case 
the user will be required to correct the interference at his own expense.

CANADA
This Class “A” digital apparatus complies with Canadian ICES-003.

Cet appariel numerique de la classe “A” est conforme a la norme NMB-003 du Canada.

Caution North American Line Voltages 100 - 120 Volt

Notice Changes or modifications to this equipment not expressly approved by 
Ross Video Limited could void the user’s authority to operate this 
equipment.



EUROPE
This equipment is in compliance with the essential requirements and other relevant provisions of CE 
Directive 93/68/EEC.

INTERNATIONAL
This equipment has been tested to CISPR 22:1997 along with amendments A1:2000 and A2:2002, 
and found to comply with the limits for a Class A Digital device.

General Handling Guidelines
• Careful handling, using proper ESD precautions, must be observed.

• Power down the system before PCB removal. 

A Word About Static Discharge  
Throughout the many procedures in this guide, please observe all static discharge precautions.

Notice This is a Class A product. In domestic environments, this product may 
cause radio interference, in which case the user may have to take 
adequate measures.

Notice Avoid handling the switcher circuit boards in high static environments 
such as carpeted areas, and when synthetic fiber clothing is worn. 
Touch the frame to dissipate static charge before removing boards 
from the frame, and exercise proper grounding precautions when 
working on circuit boards.



Warranty and Repair Policy
Ross Video Limited (Ross) warrants its switchers and related options, to be free from defects under 
normal use and service for a period of THREE YEARS from the date of shipment. Fader handle 
assemblies are warranted for the life of the product. If an item becomes defective within the warranty 
period Ross will repair or replace the defective item, as determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted 
at the customer site, reasonable out-of-pocket charges will apply. At the discretion of Ross, and on a 
temporary loan basis, plug in circuit boards or other replacement parts may be supplied free of charge 
while defective items undergo repair. Return packing, shipping, and special handling costs are the 
responsibility of the customer.

Software upgrades for switchers may occur from time to time, and are determined by Ross Video. The 
upgrades are posted on the Ross Video website, and are free of charge for the life of the switcher.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or 
application, or unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential 
damages (including loss of profit). Implied warranties, including that of merchantability and fitness 
for a particular purpose, are expressly limited to the duration of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of 
ownership.



Environmental Information
The equipment that you purchased required the extraction and use of natural 
resources for its production. It may contain hazardous substances that could impact 
health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for 
the extraction of natural resources, Ross Video encourages you to use the appropriate take-back 
systems. These systems will reuse or recycle most of the materials from your end-of-life equipment in 
an environmentally friendly and health conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your 
local or regional waste administration.

You can also contact Ross Video for more information on the environmental performances of our 
products.



Company Address

Ross Video Limited

8 John Street
Iroquois, Ontario, K0E 1K0
Canada

Ross Video Incorporated

P.O. Box 880
Ogdensburg, New York
USA 13669-0880

General Business Office:
Fax:

Technical Support:
After hours emergency:

E-mail (Technical Support):
E-mail (General Information):

Website:

(+1) 613 • 652 • 4886
(+1) 613 • 652 • 4425

(+1) 613 • 652 • 4886
(+1) 613 • 349 • 0006

techsupport@rossvideo.com
solutions@rossvideo.com
http://www.rossvideo.com
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Introduction

A Word of Thanks
Congratulations on choosing the Ross Synergy 100 SD digital video production switcher. You have 
purchased the power and versatility of an advanced Multi-Level Effects (MLE) digital switcher that is 
ready to take on all creative challenges in today’s competitive broadcast environment. You will be 
pleased at how easily your Synergy 100 switcher fits into your working environment.
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About This Guide
This guide covers the operation of the Synergy 100 switcher. The following chapters are included:

• Chapter 1, “Introduction” summarizes the guide and describes the components and 
features that comprise the switcher system.

• Chapter 2, “Control Panel Introduction” provides an overview of the Synergy 100 
control panel. You will learn the various panel sections and details about basic 
functionality. 

• Chapter 3, “Using the Menu System” provides an introduction to the switcher’s menu 
system. 

• Chapter 4, “Switcher Basics” presents basic operating rules and procedures regarding 
crosspoints, buses, knobs and preview mode.

• Chapter 5, “Transitions” outlines operating procedures for manual transitions, cuts, 
dissolves, auto transitions and a variety of other basic transition modes.

• Chapter 6, “Pattern and Effects Control” provides information and instructions for 
using the switcher’s pattern generators and Effects Control groups.

• Chapter 7, “Keying” provides instructions for using the switcher’s Effects Keyers and 
Downstream Keyer.

• Chapter 8, “Memory Functions and More” provides instructions for using the 
switcher’s Memory System.

• Chapter 9, “Peripheral Device Control and More” provides instructions for operating 
Remote Aux Panels, the Serial Tally Interface, and Remote Audio Mixer Control 
Interface.

• Chapter 10, “Ultimatte Insider” provides instructions for operating the optional 
Ultimatte Insider™ chroma keyer function. 

• Appendix A, “Menu Trees” lists the various menu trees that are used within the Synergy 
100 switcher.

• The Glossary provides a reference list of important switching and video terms used 
throughout this guide.

• An Index is also provided for your reference.

If, at any time, you have a question pertaining to the operation of your Ross switcher, please contact us 
at the numbers listed in the front of this guide. Our technical staff is always available for consultation, 
training or service.
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Documentation Conventions
The following conventions are used throughout this guide:

• Rear panel connectors are indicated in bold-faced upper case letters. For example:

The AUX 1 connector is… 
• Control Panel buttons are indicated in bold-faced upper case letters, using a sans-serif 

font. For example:

Press WIPE to…
• Menu names on the preview overlay and switcher control panel areas are indicated in 

bold-faced text. For example:

The Inputs Menu allows you to …
The Downstream Keyer group consists of …
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Documentation Terms
The following terms are used throughout this guide:

• “DVE” refers to the optional Digital Video Effects daughter board that is installed 
directly onto the Synergy 100 frame processor board. 

• “Frame” and “Electronics Frame” both refer to the Synergy switchers’s electronics 
frame.

• “Operator” and “User” refer to the person who uses the Synergy 100 production 
switcher.

• “Panel” and “Control Panel” both refer to the Synergy 100 control panel.

• “SDI” refers to Serial Digital Interface video, a component digital video signal that is 
distributed via a single coaxial cable with BNC connectors.

• “Storage device” refers to a standard 1.44 MB high-density floppy disk or a USB key. 
Either type of storage device can be used to save and recall configurations, setups and 
certain files to the Synergy switcher.

• “System” refers to the entire Synergy 100 system, consisting of its electronics frame and 
control panel.

• “Video system” refers to the mix of interconnected digital equipment (including the edit 
controller, VTRs, DVEs, etc.) in which the Synergy 100 system is included.
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Abbreviations
The following abbreviations are used throughout the text:

Abbreviations

Abbreviation Definition
A-D Analog-to-Digital

AUX Auxiliary

BKGD Background Transition

CG Character Generator

D-A Digital-to-Analog

DA Distribution Amplifier

DDR Digital Disk Recorder

DSK Downstream Keyer

DVE Digital Video Effects

DVR Digital Video Recorder

ID Identification

MLE Multi-level Effects

PGM Program Bus

PST Preset Bus

PST PATT Preset Pattern

PV Preview

RU Rack Unit

TD Technical Director

VCR Video Cassette Recorder

VDCP Video Disk Communications Protocol

VTR Video Tape Recorder
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Product Overview
Ross Video developed the Synergy series for live news, live sports and live production. Because the 
switcher is the center of the action, it must be powerful and versatile, yet easy to operate. This 
operational simplicity frees operators to concentrate on the content — instead of the equipment.

The Synergy series (our fourth generation of switchers) was designed with the direct input of video 
professionals experienced in news, sports, and mobile production. Key members of the Synergy 
design team are part of an ongoing program where they demonstrate the product, assist with 
installations and provide operator training. As a result, the Synergy line continues to advance Ross 
Video’s traditions — power, ease of use and logical panel layouts. 

Product Highlights 
The following list summarizes the key features of the Synergy 100:

• Fully Digital System. The Synergy 100 switcher is fully-digital, including the reference 
video connection. No analog input/output circuitry is provided. This unique concept 
simplifies the design, minimizes the power requirements and reduces the overall cost. 

By requiring all A-D and D-A conversion to be performed outside the system, digital 
noise stays out of the converters. In addition, customers are guaranteed the latest 
converter technology, without burdening the cost of the switcher and with the added 
option to use those converters for other purposes — as they gradually convert to the 
digital domain.

• Multi-Panel Flexibility. For superb flexibility and versatility, the Synergy 1 frame is 
designed to operate with eight different control panels, four of which previously 
operated in an analog environment:

~ GVG 100 (analog)

~ GVG 110 (analog)

~ RVS-210A (analog)

~ RVS-216A (analog)

~ RVS-210D (digital)

~ RVS-216D (digital)

~ Synergy 1 (digital)

~ Synergy 100 (digital)

• Large Input Matrix. The Synergy 1 frame can accept up to 16 digital video inputs — 
not including black and two color background signals (which are generated internally).   
On the Synergy 100 panel with its 10 available crosspoints, you have several crosspoint 
layout options:

~ Assuming that Black and Color Background are mapped to crosspoints 1 and 
10, respectively, and you have not mapped a SHIFT button, the panel gives you 
direct access to 8 inputs. The remaining sources can be mapped internally, allowing 
you to associate key (alpha) signals with their respective fill sources.

~ If you wish to map a SHIFT button to crosspoint 10, with Black and Color 
Background mapped to crosspoints 1 and 9, respectively, the panel gives you 
direct (and shifted) access to all 16 inputs. In this configuration you can also 
internally associate key and fill inputs, for full input matrix flexibility.
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• Compact Size. The 2 RU frame accepts 16 inputs and one fully optioned MLE, 
including eight untimed Aux Buses. There is no extender board available, but the frame 
top can be removed easily for servicing if required. The CPU board has convenient 
ejector handles on each side and plugs easily into the frame’s backplane.

• Low Power. The only power requirements are a maximum 180 watts for the frame and a 
maximum of 19 watts for the control panel. The frame’s power supply is designed for 
easy removal if an exchange is required.

• Growth Path. The Synergy 1 frame provides a versatile growth path, regardless of your 
entry point within the system. If you start with a GVG 100, GVG 110, Ross RVS-210A 
or 210D, Ross RVS-216A or 216D control panel, or a Synergy 100 control panel, you 
can move up to the Synergy 1 control panel and benefit from a full range of advanced 
features. If you start with the Synergy 1 control panel already in place, you can 
optionally add two more Downstream Keyers for added flexibility and creativity in your 
productions. Furthermore, knowledge and skill gained on the Synergy 1 panel allows a 
seamless transition to the larger Synergy switchers — as operation is almost identical.

• Three Powerful Keyers (Standard). The Synergy 100 panel provides access to three 
powerful keyers (two Effects keyers and one Downstream keyer):

~ The Effects Keyers provide self, auto select, preset pattern and chroma key 
capabilities.

~ The Downstream Keyer provides self and auto select keys. 

~ A key border can be generated on the downstream key if the optional border card is 
installed. 

~ With the optional Squeeze & Tease 2D or Squeeze & Tease WARP feature 
installed, the Effects Keyers can also perform simple 2D or more complex 3D DVE 
effects and Squeeze & Tease 2D boxes. Refer to the section “Squeeze & Tease ” on 
page 1-12 or the Squeeze & Tease 3D/WARP Owner’s Guide for more information.

• Squeeze & Tease 2D and Squeeze & Tease WARP. A simple 2D or more complex 3D 
DVE can be built into the Effects Keyers. With either option installed, all key types can 
be repositioned, squeezed, and zoomed. 

With 2 D, you can simultaneously crop, reposition, squeeze or zoom, and adjust the 
border on a key inside a single keyer. With WARP, you can simultaneously crop, rotate, 
squeeze or zoom, and reposition a key in 3D space inside a single keyer.

Refer to the section “Squeeze & Tease ” on page 1-12 or the Squeeze & Tease 
3D/WARP Owner’s Guide for more information.

• Chroma Keying. A standard feature in the Effects Keyers, the chroma keyer features 
auto chroma key, hue suppression, rejection, and adjustable clip and gain parameters.   
Our chroma keyer was designed for use in today’s fast-paced productions.

• Two Pattern Generators (Standard). The Synergy 100 is equipped with a primary 
pattern generator for creating wipes, plus a secondary pattern generator for PST PATT 
keys. The primary generator is equipped with extensive classic, rotary, and matrix wipes.

• Fully Featured “Program/Preset.”   The Program/Preset buses have full multi-level 
effects capability including wipes, chroma keys, and preset patterns.

Note If you prefer, the SHIFT button can be mapped to crosspoint 1, with 
Black being mapped to an alternate crosspoint.
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• Effects Functions (Preview Overlay). This powerful feature presents safe title, center 
crosshairs, and more. Displays are individually selectable on the preview monitor for 
quick reference.

• Rugged Construction. Ross products are tough — they’re built to handle years of 
demanding, continuous use. In addition, the Synergy series is backed by a three-year 
transferable warranty.

Standard Features
The following features are standard in the Synergy 100 switcher:

Complete Control Panel
Regardless of what options are ordered, your control panel is always equipped with every button, 
knob, display, and light. This means that your Synergy 100 switcher and your control room will look 
their very best – even if your budget is tight.

• Serial Digital Inputs

Sixteen serial digital inputs are standard on the Synergy 100. Any input can be assigned 
to any button on the Program/Preset bus, thus simplifying installation and your ability to 
customize the panel layout. Inputs can be used for either video or alpha channels. 

• Panel Tallies

There are 16 panel tallies on the Synergy 100 control panel.

Full MLE Effects
The Synergy 100 switcher includes a full-featured MLE that includes the following functions:

• Two wipe generators are standard. 

• The MLE includes three keyers that each offer matte fill, key invert, mask, adjustable 
clip and gain, and self (luminance) key and linear (auto select) key modes. 

• The downstream keyer offers extensive optional bordering that works with both key 
types.

• The optional Squeeze & Tease 2D or Squeeze & Tease WARP feature can be installed 
in the Effects Keyers, allowing you to squeeze, zoom, or in the case of the WARP 
option, rotate any key type. Refer to the section “Squeeze & Tease ” on page 1-12 or the 
Squeeze & Tease 3D/WARP Owner’s Guide for details. 

• The MLE features five comprehensive matte generators. 

• Full preview capability is provided.

Copy and Swap Functions
The following convenient copy and swap functions are available as standard:

• Copy Key – allows you to copy the contents of one keyer to another keyer.

• Swap Key – allows you to swap the contents of one keyer with another keyer.
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Pattern Generators
The Synergy 100 includes (as standard) both primary and secondary pattern generators that are used 
for wipe transitions and preset patterns. The primary generator is equipped with extensive classic, 
rotary, and matrix wipes. The secondary generator provides classic patterns.

Chroma Keying
Chroma keying is available in the Effects Keyers. Each high quality chroma keyer features internal 
4:4:4 chroma channel interpolation from any of the 4:2:2 inputs. Using the control panel, you can 
adjust the Chroma key’s clip, gain, rejection, suppression, and hue. The Auto Chroma Key feature 
allows the user to quickly and automatically achieve the best chroma key for a selected color.

Untimed Aux Buses
Eight untimed Aux Buses are standard, each of which can be used to route video to monitors, DVE 
channels, still stores, tape machines, etc. Aux Buses 3 through 10 can be used to route any untimed 
signals to other external sources, including: 

• Black (as supplied by the “601 REF IN” BNC), plus all primary inputs

• Clean feed (if the option is installed) 

• MLE program and preview outputs 

Standard Digital Outputs
The following table lists all standard Synergy 100 digital outputs:      

Note Black, clean feed, and program and preview outputs can only be routed 
to the Aux Buses using a Remote Aux Panel. All other signals 
(primary inputs) can be routed using either the remote panels or the 
Synergy 100 control panel itself.

Since the Synergy 1 frame generates its own internal black signal, 
selecting BLACK on an untimed Aux Bus will route to the output 
whatever is connected to your “601 REF IN” BNC. See table below.

Aux Bus Capabilities by Timing Status
Aux Bus Timing Black PV Clean Feed PGM 

3 - 10 Untimed Ref Yes Yes Yes

Synergy 100 Digital Outputs

Output Type Quantity
Program 2

Preview 2

Aux Bus 8

Total Outputs 12
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Disk Drive
Using a standard high-density 3.5-inch floppy disk, you can quickly and easily upgrade your switcher 
software as new versions are released. In addition, each operator can store and recall their own 
complete switcher setups, including memory functions, switcher personalities, installation parameters, 
and 3D wipes.

Memory System
The Synergy 100 switcher is equipped with a standard 100-event memory for complete switcher 
snapshots. At the touch of a button, the entire switcher setup can be recalled using the numbered 
buttons in the Effects Control group, or the 10 and 1 buttons (in conjunction with the SEL button) in 
the System Control group. 

Matte Generators
The Synergy 100 switcher has five simple color generators. These color generators allow you to adjust 
the hue, color saturation, and luminance of the BKGD, wipe pattern borders, Effects key fill, or the 
Downstream key border and matte fill.

Displays and Indicators
The Synergy 100 switcher always keeps you informed.

• PGM bus crosspoints are illuminated red, signifying “on-air” status, except when the 
panel is faded to black. In this case, the crosspoint LEDs will be orange.

• PST bus crosspoints are lit orange, except during a background transition, when they 
will be red.

• KEY bus crosspoints will be lit orange when the key is not on air, and red when the key 
is contributing to the program output.

• The secret-till-lit LEDs to the left of each crosspoint bus will be lit green when the 
source selected on the bus is synchronous, and orange if the source is non-synchronous. 

• Functions that have control of the Effects Control groups will be lit green (e.g. FLY 
KEY).

• The ON AIR secret-till-lit LEDs in the Effects Keyers group and under the key and 
DSK transition buttons in the Transition Control group glow red when the key is on air.

• The EDIT secret-till-lit LED under the MENU button in the System Control group is lit 
when the Editor option is installed and enabled.

• The auto transition rate in the System Control group is constantly visible. 

• When the switcher is in “memory mode”, the last memory register accessed is displayed 
in the System Control group.

• The four-character MODE displays in the Effects Control, Mattes, and System 
Control groups, always inform you of which function has control of each group.

Note If the Clean Feed option is installed, an additional output is provided, 
for a total of 13 outputs.

Aux Buses 1 and 2 are available with the Synergy 1 panel. Contact 
Technical Support for information.
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• The LEDs in the Transition Progress Bar show you how far the transition has 
progressed, and which direction the fader must travel to complete it.

General Purpose Interface
The Synergy 100 switcher is equipped with twelve dedicated GPI inputs. 

• GPI Inputs allow the switcher to interface with peripheral equipment. Each input can be 
assigned to perform functions such as a fade-to-black, a memory recall, or an MLE or 
DSK transition.

Effects Functions (Preview Overlay)
The Effects function makes it possible to present various types of useful information on the two 
preview or Aux1/Aux2 outputs. The overlay can be displayed according to user preferences.    A 
variety of overlay information is available:

• The “Safe Title and Safe Action Area” overlay places a SMPTE standard safe title or 
safe action area indication over the switcher’s main preview output.

~ Safe title is a box that outlines the area within which the vast majority of home TV 
sets will be able to read text. 

~ Safe action area is a box that outlines the region within which viewers should be 
able to follow the action on the screen. 

• The “Center Cross Hairs” overlay places cross hairs on the preview output to indicate 
the center of the picture. It is useful in the alignment of text and other information.

• The “Menu Bkgd” gives you the option of placing a blue background behind the menu, 
as opposed to having the text on top of the preview output.

Digital Reference
The Synergy 100 switcher requires a digital reference signal connected to the 601 REF IN BNC. 
Internal black is regenerated from this digital reference. If only an analog reference is available, an 
external A-D converter is required.

Synergy Slots
The Synergy 100 incorporates a special mode in which pseudo-random information is statistically 
measured on a cumulative basis.

System Options
This section lists the options available for the Synergy 100.

USB Removable Media Drive
The USB Removable Media Drive replaces the floppy disk drive for the control panel, and supports 
industry standard USB keys. This option makes it possible to store and recall complete switcher 
setups including memory functions, switcher personalities, installation parameters, and more, to a 

Note Refer to the section “Options Menu” on page 3-7 for instructions on 
how to verify the status of your installed hardware options. 
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USB key. Operators and technical staff can easily back up their switcher setups and transfer these 
settings to other Synergy production switchers.

Clean Feed
The Clean Feed option provides an additional “program” output that is derived from a different 
location in than the standard program output. Typical applications are live-to-tape productions and 
recording shows for later airing without “call in” numbers inserted.

The Clean Feed output can be generated from before or after all keys, including the DSK, or after the 
Effects Keyers but before the DSK. The Clean Feed alpha output can be derived from any key type on 
Key 1. The point from which the feed is derived is software-configurable. Refer to the diagram below.

 Clean Feed Modes

1. At point 1 above, the clean feed output is pulled after the MLE’s program/preset bus, but 
before the three keys are added.

2. At point 2 above, the clean feed output is pulled downstream of the two Effects keyers, 
but upstream of the DSK.

3. At point 3 above, the clean feed output is pulled downstream of the three MLE keyers 
and effectively mirrors the program output.

Note that the Clean Feed option comprises software plus a hardware “serializer” module that installs 
on the Frame Processor Board. Please call Ross Video Technical Support for more details.

Squeeze & Tease 
One Squeeze & Tease option puts the power of a simple 2-D (two dimensional) or 3D (three 
dimensional), 2 channel, WARP DVE into both Effects keyers. Once installed, the Squeeze & Tease 
2D option can perform the following digital video effects – using only one keyer.

• Squeeze, crop, and reposition an image with variable colored borders.

• Squeeze, crop, and reposition a self key or a chroma key.

• Push on and push off any type of key as a transition.

• Squeeze, crop, and reposition an auto select key. Note that this function “steals” the 
other Effects keyer’s Squeeze & Tease option in order to process the alpha signal, but the 
remaining functionality of the other keyer is unaffected.

• Perform Squeeze & Tease wipes, such as push-offs, pull-ons, and other similar 2D DVE 
transitions.

One Squeeze & Tease WARP option can perform the following digital video effects.

• 10-bit processing using sub-pixel motion for great looking pictures.

Note This option requires version 16 or higher Synergy 100 SD software, 
and version 3 or higher of the control panel CPU board.

PGM 
PST

EFFECTS
KEY1

EFFECTS
KEY2 DSK PGM

CLEAN
FEED

2 31
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• Warp effects include page turn, ripple, wave, mirror, swirl, melt, twist, slats, splits, 
spheres, lenses, star, heart, old film, shards, and more.

• Squeeze, crop, rotate, and reposition any kind of key.

• Create objects (such as slabs) from two images and manipulate them in 3D space.

• Preprocessor effects include defocus, mosaic, posterization, colorization, and strobe 
effects.

• Advanced picture frame borders can be the simple, single color type, or a fancy picture 
frame, including Roman column, tubular, beveled, computer style, tri-color, and more.

• All images can have natural lighting effects applied using a positionable light source 
with ambient light min/max controls. 

Operationally, Squeeze & Tease is exceptionally easy to control. Most effects can be produced simply 
by pressing the FLY KEY button in the Effects Keyer group and using the 3-axis joystick and 
associated end stop knobs. Additional adjustment can be made through the menu system. 

Tally Outputs
There are 16 optional frame tally relays available. Any tally can be assigned to any video input or the 
program output. Note that the Tallies option comprises the hardware relays that install in the switcher 
frame. 

Floating Border Generator
The Floating Border Generator option provides visually dynamic border, shadow, and outline 
effects to the Downstream Keyer group, with either hard or “soft” edges. You can move the border to 
any position on the screen — even above the key. 

Borders are “flown” in real time with the joystick (just like wipe patterns and DVE effects). Please 
note:

• All border edge effects can be modified through the parameters of X and Y position, 
border size, border color, density, and glow (giving a soft defocused look).

• The Floating Border Generator option comprises software plus a “daughter board” 
that installs on the Frame Processor Board.

Editor Interface
The Editor Interface Option allows the Synergy 100 to interface with all popular editing systems. 
The option itself comprises software plus security codes and once installed, the switcher can be 
controlled using an RS-232 or RS-422 interface and industry standard editor protocol. The editor can 
be used to read and write switcher functions including video input selection, pushbutton enable and 
disable, control settings, and memory registers. If GPI control is not sufficient and control of all 
switcher parameters from an editor is necessary, this option is required.

Remote Audio Mixer Control Interface
The Remote Audio Mixer Control Interface Option enables serial control from the Synergy 100 
over an audio mixer for enhanced audio-follow-video, making an integrated A/V production possible.

Note Both Squeeze & Tease options comprise software plus “daughter 
boards” that install on the Frame Processor Board. 
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This protocol supports the association of any audio input with any video input, and is easily 
configured using the Synergy 100 menu system.

Serial Tally Protocol Interface
The Serial Tally Protocol Option allows you to set up communication parameters with tally system 
interface equipment using industry standard protocol. Note that the standard parallel tally interface 
will continue to operate normally when this option is enabled.

Ultimatte Insider
Ultimatte Insider™ Option is a hardware option that adds true Ultimatte capability — directly inside 
the Synergy 100 switcher. The option comprises a hardware board designed by Ultimatte, the 
Oscar-winning industry leader in compositing technology.

Dedicated and Assignable Remote Aux Panels
A Remote Aux Panel is a self-contained switching unit that has its own power supply. It mounts in a 
19-inch rack and fills 1 RU (Rack Unit). There are two types of remote Aux panels available for the 
Synergy 100 switcher:

• A Dedicated Remote Aux Panel controls one Aux Bus output. A sample panel is 
shown below: 

Dedicated Remote Aux Panel

• An Assignable Remote Aux Panel controls all 8 Aux Bus outputs. A sample panel is 
shown below:

Assignable Remote Aux Panel

In addition to the source buttons, each panel includes dedicated buttons for MLE PV, Clean Feed, 
Program, and future DVE Send capabilities, plus a bright “on air” LED. Assignable panels include 
buttons that are used to access the 8 Aux Bus outputs. 

The remote panel itself is connected to the rear of the switcher’s frame via a single six-conductor 
Telco control cable. Typical applications include routing signals to one or more DVE channels and 
switching a monitor between various signals. 

Up to eight Aux panels can be connected to the frame in daisy-chain fashion. 

Please note:

• Both the Dedicated and Assignable Aux panel options include a 33-foot (10 meter) 
cable. Custom cable lengths are available.

• The maximum cable length between panels (as limited by RS-422 specifications) is 
1000 feet (305 meters).

• The communications signal is re-buffered at each Aux panel.
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Conversion Frames
All switcher inputs and outputs are 10-bit SDI, including the system reference. Signal sources of other 
video formats must be converted to serial digital. Ross Video chose to do this conversion externally to 
ensure that the very latest conversion technology and most competitive pricing is available to our 
customers. An added bonus of external conversion is the ability to use those converters elsewhere in 
your facility as you eventually upgrade your switcher sources to serial digital. The table below lists 
the Ross products that qualify as converters.

Please visit our website at http://www.rossvideo.com or contact your Ross Video representative to 
obtain a current Ross Video Product Catalog for detailed information on our complete line of 
converters. 

Spare Parts Kit
A Spare Parts Kit is available which provides switcher parts according to the following criteria:

• the part comes into frequent contact with the user

• the part can be easily damaged or may wear out with excessive use

• the part can be damaged by connecting excessive voltage to an external connector

• the part is used in system power management

• the part can be lost easily

Custom Main Panel Cable
The Main Panel cable connects the control panel to the electronics frame. It is a shielded 8-pin Telco 
cable and the ends are finished with the appropriate connectors. The control panel and frame can be 
separated by a maximum of 1,000 feet (305 meters). 

A 33-foot (10 meter) control panel cable is supplied as standard with the switcher. If cable lengths 
other than 10 meters are needed, a custom cable can be ordered (by the meter).

Ross Converters

Converter Description
ADC-8032B Analog Composite to SDI Digital Decoder

ADC-8032B-S Analog Composite to SDI Digital Decoder with Frame Sync

ADC-8033 Analog Component to SDI Converter

ADC-8035 Dual Analog Composite to SDI Converter

CMA-8011A SDI Component Monitoring Amplifier

CMA-8011A-7 SDI Component Monitoring Amplifier with 7 reclocked SDI Outputs

DAC-8013 SDI to Analog Component Converter 

DAC-8016A SDI to Analog Composite Converter

DAC-8016A-S SDI to Analog Composite Converter with Frame Sync

DAC-8016A-SX SDI to Analog Composite Converter with Frame Sync and X-Color Filter

DAC-8016A-X SDI to Analog Composite Converter with X-Color Filter

QMA-8044 Quad SDI to Analog Composite Monitoring Amplifier

UMA-8017 Universal SDI Monitoring Amplifier
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A Word about Technical Support
At Ross, we take pride in the quality of our products, but if problems occur, help is as close as the 
nearest telephone.

Our 24 Hour Hot Line service ensures you have access to technical expertise around the clock. 
After-sales service and technical support is provided directly by Ross personnel. During business 
hours (eastern standard time), technical support personnel are available by telephone any time. After 
hours and on weekends, a direct emergency technical support phone line is available.  If the technical 
support personnel who is on call does not answer this line immediately, a voice message can be left 
and the call will be returned shortly. These people are available to react to any problem and to do 
whatever is necessary to ensure customer satisfaction.

For Technical Support, call (+1) 613-652-4886 and, for After Hours Emergency, dial (+1) 
613-349-0006.
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Product Comparison Charts
For your reference, following are detailed charts that compare the features and options that are 
available with the different control panel configurations of the Synergy 1. 

Feature Comparison Chart

Notes:
(*1) Panel supports SHIFT button.
(*2) The hidden (inaccessible) inputs can be configured as key signals.
(*3) 2 keyers are standard and 2 external DSKs are optional.
(*4) In this mode, external DVE Sends are not available. The DSK “next transition” button 

becomes the MLE Key 2 button and the DSK is then controlled by dedicated buttons 
(for CUT, AUTO TRANS).

(*5) In 2 Keyer mode only. Timed Aux Bus option must be installed. 
(*6) DSKs on Synergy 1 are optional and external. They only have Self and Auto Select key 

capability.
(*7) DSK can only perform Mix and Cut transitions.
(*8) Variable via Chroma Key button hold down
(*9) Fixed settings
(*10)Bank selectable using the Auto Trans display
(*11)Displays only center, safe action, and safe title area.

Feature Synergy 
100

Synergy 1 GVG-110 
GVG-100

Ross 210A 
Ross 210D

Ross 216A 
Ross 216D 

100 Event Memory Yes Yes Yes (*10) Yes (*10) Yes (*10)
Number of Keyers 3 4 (*3) 2 2 3 (*4)
All 16 Inputs Accessible Yes (*1) Yes Yes (*1) No (*2) Yes
Chroma Key Clip, Gain and Hue 
controls 

Yes Yes Yes Yes Yes

Chroma Key Reject, Blue spill 
suppression controls 

Yes Yes Yes (*8) No (*9) No (*9)

Custom Control (Macros) No Yes No No No
DSK Borders Yes No (*6) Yes Yes Yes
DSK DVE Send Transitions No No (*6) No (*7) Yes Yes
DSK Still Store and Animated 
Logo Generator

No Yes (*6) No No No

DVE Send No Yes Yes Yes Yes (*5)
Extended Wipe Patterns Yes Yes Yes Yes Yes
Favorite CG Button Yes Yes No Yes Yes
Internally Generated Black Yes Yes Yes Yes Yes
Internally Generated Color Yes Yes Yes Yes Yes
Key 1 Borders No Yes No No No
Key 1 Squeeze and Tease Yes Yes Yes Yes Yes
Non-Sync LEDs Yes Yes No Yes Yes
Preview Overlay Yes Yes Yes (*11) Yes (*11) Yes (*11)
Remote Aux Panel GPIs Yes Yes No No No
Software Reset from Panel Yes Yes No No No
Transition Preview Yes Yes No Yes Yes
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Option Comparison Chart
The following chart details which options are available with each Synergy 1 switcher configuration.

Notes:
(*1) Aux 1 and Aux 2 can be timed.
(*2) Panel tallies are standard. See table below.
(*3) In the control panel only
(*4) Floating Border Generator for the Synergy 100.

Tally Comparison Chart
The following chart details the optional tally combinations that are available with each Synergy 1 
switcher configuration.

Option Synergy 100 Synergy 1 GVG-100/110 Ross 210A/D  
216A/D

Audio Server Control No Yes No No

Clean Feed Yes Yes Yes Yes

Dual Aspectizer No Yes No No

Dual Border Generator (*4) Yes Yes Yes Yes

DVE Send No Yes Yes Yes

Editor Interface Yes Yes Yes Yes

External DSKs (up to 2) No Yes No No

FrameTallies Yes Yes Yes Yes 

Panel Tallies Yes (*2) Yes (*2) No Yes (*2)

Redundant Power No Yes (*3) No No

Remote Audio Mixer Control Yes Yes No No

Remote Aux Panels Yes Yes Yes Yes

Remote Camera Control No Yes No No

Routing Switcher Control No Yes No No

Serial Tally Interface Yes Yes No No

Squeeze & Tease Yes Yes Yes Yes

Squeeze & Tease 3D Yes Yes No No

Still Store Control No Yes No No

Timed Aux Buses No Yes (*1) Yes (*1) Yes (*1)

Ultimatte Insider Yes Yes No No

Video Server Control No Yes No No

VTR Remote Control No Yes No No

Tally Configuration Synergy 
100

Synergy 1 GVG-100/1
10

Ross 
210A/D

Ross  
216A/D

Panel Tallies 16 (Standard) 16 (Standard) — 8 (Standard) 14 (Standard)

Frame Tallies 16 16 16 16 16 

Maximum Tallies 32 32 16 24 30
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Control Panel Introduction

In This Chapter
This chapter provides an introduction to the Synergy 100 SD control panel. You will learn the 
various sections of the panel and details about the basic functionality of each. The following topics are 
discussed:

• Control Panel Sections

• Video Flow through the Switcher

• Switcher Timeout

• Resetting the System
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Control Panel Sections
The following figures display a top view of the Synergy 100 control panel, with each control panel 
section identified. The legend beneath the illustrations names each section. An overview of each 
section follows the figures.

Synergy 100 Control Panel — Floppy Disk Drive

Synergy 100 Control Panel — Floppy Disk Drive

1) Program/Preset Buses
2) Key Bus
3) Effects Keyers Group
4) Memory and Effects Control Groups

5) Mattes Groups
6) System Control Group
7) Downstream Keyer Group

8) Transition Control Group
9) Floppy Disk Drive
10)Positioner

EFFECTS  CONTROL MATTES SYSTEM  CONTROL

EFFECTS   CONTROL MATTES DOWNSTREAM  KEYER

TRANSITION  CONTROL

EFFECTS  KEYERS
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Synergy 100 Control Panel — USB Port

Synergy 100 Control Panel — USB Port

The following is an overview of each control panel section. For more detailed graphic descriptions, 
including button labels, please refer to the appropriate sections of this guide.

1. Program/Preset Buses

The Program/Preset Buses are two rows of crosspoint buttons (one button per video 
input source) that represent your primary switcher output selection area. 

• The Program bus is the video source currently on air. This is the switcher’s 
background image — that is, the image that is visually behind all other images (or 
farthest upstream, electronically).

• The Preset bus selects the source on the MLE that you are transitioning to — using 
a cut, dissolve, wipe or DVE transition.

2. Key Bus 

The Key Bus row is used to select key sources that can be keyed (electronically cut) into 
the background. The Key bus is shared between the three keyers (2 Effects Keyers and 
Downstream Keyer). 

3. Effects Keyers Group

The Effects Keyers Group allows you to select the key type and associated parameters 
for the Effects keys. Choose between Self Key, Auto Select Key, Chroma Key, and 
PST PATT Key. Within the group, you can also select a variety of key modifiers and 

1) Program/Preset Buses
2) Key Bus
3) Effects Keyers Group
4) Memory and Effects Control Groups

5) Mattes Groups
6) System Control Group
7) Downstream Keyer Group

8) Transition Control Group
9) USB Port
10)Positioner
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parameters. When any button is selected in the group, the Key bus is assigned to the 
Effects Keyers.

Electronically, the Effects Keyers are downstream (visually in front) of the background 
buses, but upstream (visually in back) of the Downstream Keyer.    

4. Memory and Effects Control Groups 

The Memory and Effects Control Groups are assignable groups of controls that allow 
you to choose wipe patterns and adjust various parameters of the selected pattern. In 
addition, the pattern buttons are used to store and recall switcher parameters, and as a 
means of navigation within the switcher menu system.

5. Mattes Groups

The Mattes Groups are assignable modules that allow you to adjust matte and border 
generator colors. By pressing any matte-related button on the switcher, or the SEL 
button beneath the Mattes display, the Mattes groups are assigned. 

6. System Control Group

The System Control Group includes the SEL button, which, when used in conjunction 
with the 100, 10, and 1 buttons, allows the user to navigate through the menu system 
and assign transition rates to AUTO TRANS, DSK DISS and FADE TO BLACK auto 
transitions. The MENU button is used to access the switcher’s menu system.

7. Downstream Keyer Group

The Downstream Keyer Group allows you to select the key type and associated 
parameters for the Downstream key. Choose between Self Key or Auto Select Key. 

The CLIP knob adjusts the key’s luminance or threshold level and the GAIN knob 
adjusts the sharpness or softness of the key edges. 

With the optional Floating Border Generator installed, the BORD, SHDW, and 
OUTL buttons place a border, drop shadow or outline around the key. 

In addition, there are CHAR GEN1 and CHAR GEN2 buttons, which allow you to 
pick your favorite CGs for immediate keying.

When any button is selected in the group, the Key Bus is assigned to the Downstream 
Keyer. An ON AIR LED under the DSK CUT and DSK DISS buttons in the 
Transition Control group, advises the user when the downstream key is contributing to 
the program output.

Electronically, the Downstream key is downstream (visually in front) of both the 
background buses and the Effects keys.

8. Transition Control Group

The Transition Control Group allows you to select the type of transition that you want 
to perform between the current scene and the next scene. You can transition any 
combination of the Program/Preset and Key buses using a cut, wipe, or dissolve. 

The DVE button allows you to perform transitions using effects from an optional 
internal 2D or 3D DVE daughter board. Transitions can be performed manually with the 
Fader or automatically with the AUTO TRANS button.

Note The Effects Keyers group is used to set up both Key 1 and Key 2. 
Each key can be set to a different key type, if desired, and have its own 
individual set of key modifiers and parameters.
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The Fade to Black button allows you to fade the switcher to black. 

9. Floppy Disk Drive or USB Port 

The Floppy Disk Drive and the USB Port allows you to store and recall your entire 
switcher setup to and from floppy disk. In addition, it serves as a means of upgrading 
your Synergy 100 software, ensuring you have all the latest standard features.

10. Positioner

The Positioner allows you to position wipe patterns on screen. By pressing the WIPE 
button in the Transition Control group or the PST PATT button in the Effects Keyers 
group, the Positioner is assigned. Note that, if the Squeeze & Tease 2D or Squeeze & 
Tease WARP option is installed, the Positioner can be used to manipulate the X, Y, and 
in the case of the Squeeze & Tease WARP option, the Z position of a Squeeze & Tease 
key.

Note If you have the USB Removable Media Drive option installed, the 
USB port replaces the floppy disk drive.
Synergy 100 Operation Guide (v16.10-S100) Control Panel Introduction • 2–5



Video Flow through the Switcher
The following diagram illustrates how video flows through your switcher. The drawing illustrates the 
switcher’s visual and electronic concepts of upstream and downstream and are designed to help you 
visualize and understand the switcher’s architecture from a production standpoint. 

The simplified block diagram below illustrates the flow of video through the Synergy switcher.

Synergy 100 Video Flow 

Please note the following important points:

• The Synergy 100 is a single MLE switcher with 16 inputs. Video flows into the MLE as 
indicated above, where crosspoints can be selected for effects creation.

• The Program and Preset buses are electronically the farthest upstream, the Effects keys 
appear mid stream and the Downstream key appears downstream. 

~ Visually, all images on the Background bus appear behind both keyers. A key 
enabled on the Effects Keyer appears visually over the Background bus (and all 
transitions), but visually under the Downstream Keyer.

~ A key enabled on the Downstream Keyer appears visually over the Background bus 
and the Effects keys.

~ The Fade to Black function is electronically downstream of the entire switcher. 
Regardless of the combination of keys selected, Fade to Black will visually take 
the entire switcher to black.

Input 
Video

MLE Background
(Program / Preset)

Effects Key 1

Effects Key 2

Downstream
Key

Switcher
Output

Fade
to

Black
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Switcher Timeout
If no control panel buttons are touched and no fader arms are moved for a period of 10 minutes, the 
switcher goes into a “sleep” mode and all lights are automatically turned off. This function is 
specifically designed to extend the life of the displays and the button LEDs.

If this timeout occurs, press any button or move the fader or joystick to “wake” the switcher and turn 
on all lights. 

The factory default timeout interval is 10 minutes. For instructions on programming an alternate 
timeout interval, refer to the section, “Personality Setup” in Chapter 8 of the Synergy 100 
Installation Guide.

Note The switcher does not act on a button push when it is coming out of 
“sleep” mode.
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Resetting the System
If required, the switcher can be reset manually from the frame. A Full Reset affects hardware and 
software simultaneously.

Full Reset
This function performs both a hardware (a frame reboot) and a software reset simultaneously. 
Switcher memory registers, personality registers, and installation registers are not affected by the 
reset, but all other switcher parameters (for example, the current state of the panel) are reset. BLACK 
will be selected on all buses.

• To reset the frame and all system hardware and software, press the blue RESET button 
on the front edge of the Frame CPU Board.

In the Synergy 100 Installation Guide, refer to the “Frame Jumpers and Switches” section in 
Chapter 2 for more information on the frame RESET switch.

It is not recommended to reset the frame by turning the power off and then on. However, if this is 
done, the frame software will be reloaded, but the panel settings will come back to the point they were 
at, before the loss of power.

Software Reset
The software reset function is performed in the Effects Control and System Control groups. Use the 
following figure for reference. Note the small “reset” symbols beside each button.

Software Reset Function

Use the following procedure to perform a software reset on the Synergy 100 control panel:

1. Press and hold CNTR/EFF D in the Effects Control Group.

2. Press SEL in the System Control Group.  

This resets the control panel to its default values. Switcher memory registers, personality registers, 
and installation registers are not affected by the reset, but all other switcher parameters (e.g., the 
current state of the panel) are reset. BLACK will be selected on all buses.

Important As an operator, you should never have to perform this procedure. 
However, if a full reset becomes necessary, it should be carried out by 
qualified service personnel, such as your facility engineer. All 
cautionary rules regarding static discharge apply.

Note This procedure can also be performed in reverse, holding SEL and 
pressing CNTR/EFF D, with the same result. 

EFFECTS  CONTROL SYSTEM  CONTROL

SEL

CNTR

REV

MENU SEL

EDIT

BACK

100 10 1

SEL

L
E
A
R
N

0 1 2 3 4

5 6 7 8 9

MODE

AUTO

MATTES
MODE

BKGD
MODE

WIPE

Press simultaneously
to reset control panel

E
F
F

D

DVE
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Using the Menu System

In This Chapter
This chapter provides an introduction to the Synergy 100 SD menu system. The following topics 
are discussed:

• Menu System Basics

• Menu Information

• Pop-Up Help

• Options Menu
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Menu System Basics
The menu system is accessed via the MENU button in the System Control Group and is displayed on 
the preview monitor as a Preview Overlay. 

The user manually navigates or scrolls through the menu tree using either the 100, 10 and 1 buttons, 
the Effects Control buttons, or the ASPECT knob to reach the desired menu or function.

The following figure details the panel buttons on the Synergy 100 that are used to access the menu.

Synergy 100 Panel

Each button has its own specific function:

1. ASPECT Button

The ASPECT button lights to indicate that the associated knob is functional and can be 
used to scroll through values in the menus.

2. Scroll Knob (ASPECT)

The scroll knob can be used to scroll through the menu values when the ASPECT 
button is lit. 

3. Effects Control Buttons

Once you have entered the menu system, you can go directly to any menu, sub menu or 
heading, by pressing the button in the Effects Control Group that corresponds to its 
number. 

1) ASPECT Button
2) Scroll Knob (ASPECT)
3) Effects Control Buttons

4) Enter/Exit (MENU)
5) BACK
6) DOWN Arrow

7) UP Arrow
8) Select/Accept (SEL)
9) Display

EFFECTS  CONTROL SYSTEM  CONTROL

EFFECTS   CONTROL MATTES DOWNSTREAM  KEYEREFFECTS  KEYERS

ROTATE MEM

ASPECT

ASPECT

SEL

CNTR

REV

MENU SEL

BORD SHDW OUTLKEY
MEM

MATTE
FILL

SELF
KEY

AUTO
SELECT

CHAR
GEN1

CHAR
GEN2

EDIT

HUE

SAT

HUE/
TRANSP

GAIN

KEY2MATTE
FILL

FLY
KEY

SELF
KEY

AUTO
SELECT

CHROMA
KEY

PST
PATT

BACK

100 10 1

SEL

L
E
A
R
N

1 2 3 4 5

6
7

8

0 1 2 3 4

5 6 7 8 9

MODE

AUTO

MATTES
MODE

BKGD
MODE

WIPE

9

E
F
F

D

DVE
3–2  • Using the Menu System Synergy 100 Operation Guide (v16.10-S100)



As well, when in a particular menu, if you press another Effects Control button after 
you have set a value, it will automatically save the value and jump directly to the new 
menu heading. 

4. Enter/Exit (MENU)

The Preview Overlay menus are entered and exited by pressing the MENU button. 

5. BACK Button 

Pressing the BACK button will take you to the previous menu or position in the menu 
tree.

6. DOWN Arrow (10) 

Pressing the 10 button (DOWN arrow) will send you DOWN the screen to the next 
menu heading. 

7. UP Arrow (1) 

Pressing the 1 button (UP arrow) will send you UP the screen to the previous menu 
heading. 

8. Select/Accept Button (SEL)  

Pressing the SEL button will select/accept your option, setup or position in the menu 
tree. 

9. Display  

Located within the display, you will find three individual four-character displays (under 
the heading “MODE”) which identify the area of the panel that has control of the 
Effects Control, Mattes, or System Control functions. When you are in the menu 
system, MENU will appear in the displays in the Effects Control and System Control 
groups.
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Menu Information
Each menu comprises the following elements:

Main Menu

1. Menu Title 

Each menu is named in the upper left corner.

2. Software Version 

The Main Menu is the only one that displays the software version number in the upper 
right hand corner. 

3. Headings 

Headings that have not been selected are white.

There will always be one menu heading number highlighted in yellow to indicate that it 
is active and can be selected via the SEL button or the button in the Effects Control 
Group associated with its heading number. When selected, the information for that 
heading will turn to cyan.

However, if a value associated with a heading is grayed out, it indicates that the value 
can not be changed. In addition, some headings simply state “Reserved”, waiting for 
new features to be added. If you try to select it, the heading will turn yellow, but will not 
be selectable.

4. Navigation Keys 

The MENU, 100, 10, 1, and SEL, navigation button functions are displayed on the 
preview overlay as a reminder.

5. Background Color 

The default background color for the Preview Overlay is blue. However, the 
background color can be turned off in the Effects Menu, leaving the menu displayed on 
top of the selected PST bus output. Refer to the section “Menu Background” on 
page 3-5 for details.

1) Menu Title
2) Software Version

3) Headings
4) Navigation Keys

5) Background Color

Main Menu - Synergy 100

0. Effects
1. Inputs

MENU
Exit

100
Previous

10
Down

1
Up

SEL
Accept

2. Outputs
3. GPIs
4. Communication

vX.XX-S100

5. Disk
6. Personality
7. Options
8. S&T 3D
9. Default

1 2

3

4

5
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Pop-Up Help
The Pop-Up Help feature is designed to alert the operator when an illegal function is attempted. 
When the illegal button is pressed, a message appears on the preview output, providing a brief 
explanation of why the operation can not be performed. A sample message is shown below.

 
Pop-Up Help on Preview Monitor

The Pop-Up Help disappears after approximately five seconds.

Menu Background
The Menu Background feature enables you to display the Synergy menu system with a blue 
background, covering the preview output. This function is provided strictly for the user’s preference, 
and has no impact on the output of the preview monitor.

Use the following procedure to enable the Menu Background feature:

1. Navigate to the Effects Menu as follows:    

• Press MENU to display the Main Menu.
• Press 0. Effects to display the Effects Menu.

Note If you have the Squeeze & Tease WARP option installed, and the 3D 
Fan is not installed or not functioning properly, a Pop-Up Help 
message will appear on the Preview output. As well, a Help message 
will appear on the Main Menu, where it will remain until the fan is 
functioning correctly. Refer to the Synergy 100 Squeeze & Tease 
3D/WARP Owner’s Guide for details.

Squeeze and Tease wipes are not available at
this time.
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Effects Menu

2. Enable the Menu Background feature as follows:

• Press 4. Menu Bkgd.
• Toggle the 4. Menu Bkgd button between On and Off as follows: 

~ On — Use this option to enable the blue background of the Synergy menu 
system on your preview monitor.

~ Off — Use this option to display the Synergy menu system on top of the 
selected PST bus output.

3. Press SEL to accept the new setting.

4. Press MENU to display the Installation Change Screen.

5. Accept or cancel these changes as follows:

• Press 0. Confirm to accept the changes.
• Press 1. Cancel to exit the menus safely, without making any changes. The system 

returns to the previously stored settings.

This completes the procedure to enable the Menu Background feature. For more information on the 
features of the Effects Menu, refer to the section “Effects Menu Functions” on page 6-4.

Effects

MENU
Exit

100
Previous

10
Down

1
Up

SEL
Accept

0. Editor          On
1. GPIs            Off
2. Center         Off
3. SafeTitle      Off
4. Menu Bkgd  On
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Options Menu
The Options Menu lists both the software and hardware options that have been installed in your 
system. The following topics are discussed in this section:

• Verifying Your Software Options

• Hardware Options 

• Other Options

Verifying Your Software Options
There are three software options available with the Synergy 100 panel – Editor control, Audio Mixer 
control, and the Serial Tally Interface. The Software Options Menu will indicate if an option is 
installed, with either an On or an Off indicated in gray.   
Use the following procedure to verify your software options:

1. Navigate to the Options Menu as follows:

• Press MENU to display the Main Menu.
• Press 7. Options to display the Options Menu. 

Synergy 100 Options Menu

2. Press 0. Software Options to display the Software Options Menu. 

Software Options Menu

Note The DVE option is not yet implemented.

Options  S/N:F422342234

0. Software Options
1. Opt Card   Ultimatte

MENU
Exit

100
Previous

10
Down

1
Up

SEL
Accept

2. S&T DVE 3D
3. Border Yes
4. Tallies 16

5. Panel ID
6. Frame ID

4100-2
4216-4

Software Options - S/N:F422342234

MENU
Exit
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1
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SEL
Accept

0. Add
1. Editor

A6F8
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2. DVE Off
3. Audio On
4. Ser Tal On
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3. Verify that your software options have been installed as follows:

• On — If the software option heading is toggled to On, installed on your system.
• Off — If the software option heading is toggled to Off, it is not installed on your 

system.

This completes the procedure to verify your installed software options.

Hardware Options 
On the Options Menu, the installation status of each hardware item, Options 1 – 4, is indicated in 
grey to the right of the option.

Use the following procedure to verify your hardware options:

1. Navigate to the Options Menu as follows:

• Press MENU to display the Main Menu.
• Press 7. Options to display the Options Menu. 

Synergy 100 Options Menu

2. Verify your installed hardware options as follows: 

• Opt Card — This option displays either None or Ultimatte depending on 
whether you have installed the Ultimatte Insider option.

• S&T DVE — This option displays either 2D, 3D, or None depending on whether 
you have installed either the Squeeze & Tease 2D or the Squeeze & Tease 3D / 
WARP DVE option.

• Border — This option displays either Yes or No depending on whether you have 
installed the Floating Border Generator option.

• Tallies — This option shows either 16 or 32. If you have installed the frame tally 
option, 32 will be displayed. If you have only the standard panel tallies, 16 will be 
displayed.

This completes the procedure to verify your hardware options.

Note When a word in any menu is greyed out, this indicates that it is for 
information only and can not be changed.

Note Refer to Appendix B of the Synergy 100 Installation Guide for all 
hardware installation instructions.

Options  S/N:F422342234
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Other Options
On the Options Menu, the version numbers of the Synergy 100 control panel and Synergy 1 frame 
processor boards, headings 5 and 6, are indicated in grey to the right of the option.

Use the following procedure to verify the Panel ID and Frame ID of your system:

1. Navigate to the Options Menu as follows:

• Press MENU to display the Main Menu.
• Press 7. Options to display the Options Menu.

Synergy 100 Options Menu

2. Verify your Panel ID and Frame ID as follows:

• Panel ID — This heading displays the version number of the Synergy 100 panel’s 
processor board.

• Frame ID — This heading displays the version number of the Synergy 1 frame’s 
processor board.

This completes the procedure to verify the Panel ID and Frame ID of your system.

Note When a word in any menu is grayed out, this indicates that it is for 
information only and can not be changed.

Options  S/N:F422342234

0. Software Options
1. Opt Card   Ultimatte
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Exit
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Switcher Basics

In This Chapter
This chapter presents detailed basic switcher operating procedures, rules and methods. The following 
topics are discussed:

• Before Starting

• Software Reset

• System Reset Notes

• Power Fail Indicators

• Power Failure Recovery

• Basic Switcher Functions

• General Button Rules

• Crosspoint Buttons

• SHIFT Button

• Reverse SHIFT Mode 

• Flip Flop Operations

• Key Bus 

• On-Air Indicators

• Knobs

• Fade to Black

• Changing Fade to Black Rates

• Using Fade to Black
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Before Starting
If you are unfamiliar with the operation of a multi-level effects switcher, it is always advisable to 
check the initial condition of the switcher’s control panel and reset the panel if required. By 
performing a software reset, you can guarantee a base default condition and eliminate any special 
setups that may be present on the panel (as left by the last TD).

Software Reset
Refer to the section “Software Reset” on page 2-8 for the procedure to perform a software reset.

System Reset Notes
Please note the following important point regarding the system reset function:

• Turning the frame power off and then on again does not reset the control panel. When 
frame power is restored, the panel is restored with all control panel settings returned to 
their previous state.

Power Fail Indicators
There are two important POWER FAIL indicator LEDs on the front of the Synergy 1 frame:

Fan Fail and Power Fail LEDs

• The FAN FAIL LED, when lit, indicates that the fan is drawing too much current or has 
stopped turning. 

• The PWR FAIL LED, when lit, indicates that the power supply has failed or is not 
connected properly. 

• The PWR ON LED should be lit green during normal operations. It indicates that there 
are no error conditions in the fan or power supply. This LED is off if any of the two 
“fail” LEDs are lit.

Power Failure Recovery
The Synergy frame’s power failure recovery feature protects the entire panel setup in situations where 
power is lost. When power is restored after a failure, the panel is restored to its previous state before 
the failure.

FAN
FAIL

PWR
FAIL

PWR
ON

POWER TO REDUCE THE RISK OF
FIRE REPLACE WITH SAME
FUSE AND RATING.

CAUTION:

FUSE
   T4A/250 V
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Basic Switcher Functions
This section provides basic information and general rules regarding Synergy 100 operation. The 
following topics are discussed:

• General Button Rules

• Crosspoint Buttons

• Flip Flop Operations

• Key Bus

• On-Air Indicators

• Knobs

General Button Rules
Please note the following general button rules:

• All button presses are registered (acknowledged) by the switcher when a selected button 
lights. Pressing a button can switch a crosspoint (and affect the video output), perform a 
transition, toggle a function or have no affect (if the function is not valid for the current 
setup).

• Buttons can be latching (in the case of valid crosspoints and “toggle” functions such as 
key parameters), or momentary (in the case of transition buttons such as CUT). Latching 
buttons remain lit when selected, while momentary buttons illuminate when pressed but 
do not stay lit. 

Crosspoint Buttons
When a button (or crosspoint) is pressed on the PGM, PST and KEY buses, a video source is 
selected. Video sources can be internally generated or derived from external sources that are 
connected to the chassis via BNC connectors.

Please note the following important rules:

• There are two internally generated sources available:

~ BLACK (defaulted to the first or left-most crosspoint in a bus row).

~ COLOR BKGD (defaulted to the first shifted crosspoint in a bus row).

• External sources can be turned off as part of switcher setup or placed on more than one 
crosspoint. In the Synergy100 Installation Guide, refer to Chapter 6, “BNC 
Configuration and Check” for details.

• If you enabled the Look Ahead Serial Tally option, crosspoint selections on the Key 
Buses will be delayed by the specified number of fields. Refer to Chapter 7, 
“Communications Setup” in the Synergy 100 Installation Guide for instructions on 
how to enable the Look Ahead Serial Tally option with a delay.

Note To have access to black on a Remote Aux Panel, you must feed the 
“601 REF IN” BNC on the rear of the chassis with a stable black signal 
that is low in jitter and that originates from a reliable digital source.
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SHIFT Button
On each bus, the SHIFT button is used to access video and key sources that have been mapped to 
crosspoints beyond the number of available buttons. The mapping itself is performed during the 
installation procedure.

Use the following procedure to access a shifted source on any bus:

1. Press and hold the SHIFT button.

2. Press the desired crosspoint.

3. Release both buttons.

The SHIFT button plus the selected source both stay lit, as indicated in the sample illustration below:

Shifted Crosspoint Selected on Key Bus

Please note:

• With a shifted source selected on a bus row, to take an unshifted source, simply press its 
button.

• With a shifted source selected, to take another shifted source, repeat the 3-step procedure 
above.

• If you press SHIFT and then decide not to select a source, simply release the SHIFT 
button. No change will occur on the bus.

Reverse SHIFT Mode 
A special mode called Reverse SHIFT can be activated during switcher setup. Activating the 
Reverse SHIFT mode makes each Key Bus button shifted all the time — as its default state.

This effectively acts as a shift lock, giving you one-button access to the higher-numbered inputs on the 
Key Bus (without having to press SHIFT each time to reach them).

If the Reverse SHIFT mode has been implemented, you may notice that the crosspoint labels on each 
KEY bus will be different from the PGM and PST bus labels. 

Please consult with your facility’s engineer to determine if the Reverse SHIFT mode is implemented. 
For additional information, refer to the “Setting Up Panel Buttons” section in Chapter 6 of the 
Synergy 100 Installation Guide.

Note Active crosspoints 11 through 20 can only be accessed via SHIFT.
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Flip Flop Operations
The Program and Preset buses are configured to operate in flip-flop mode. When you perform a cut, 
dissolve or wipe transition between the Program and Preset buses, the two selected sources exchange 
places. This is called a flip-flop.

For example, in the following figure, VTR 2 is selected on the PGM bus and VTR 1 is selected on 
PST.

Buses Prior to Transition

After the cut, dissolve or wipe transition is performed, the two buses flip-flop as shown below. VTR 1 
is now selected on PGM and VTR 2 is selected on PST.

 
Buses Flip-flopped, after Transition

In this manner, the PGM bus always provides the background output source and the PST bus always 
provides the next source to be brought to air with a transition. In addition, after a transition, the PST 
bus always shows the source last-selected on PGM, until you change it. 
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Key Bus
The Key Bus is the following illustration:

Key Bus

The Key Bus allows you to make key and fill selections on all three keyers — the 2 Effects Keyers 
and the Downstream Keyer. Even though the Key Bus buttons are shared between the three keyers, 
each keyer can have its own independent key and fill selections. Please note:

• Pressing any button in a keyer switches control of the Key Bus to that keyer.

• When the Key Bus is assigned to the Effects Keyers, changing a button on the bus has 
no effect on the Downstream Keyer. Similarly, when the bus is assigned to the 
Downstream Keyer, changing a button has no effect on the Effects Keyers. 

On-Air Indicators
There are several ON AIR Indicators on the Synergy 100 control panel. Refer to the following figures.

On Air Indicators, Transition Control Group
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ON AIR Indicator, Effects Keyers Group

The ON AIR lamps indicate, when lit, that the Effects keys and Downstream keys are contributing to 
the switcher’s main program output. These lamps illuminate at the beginning of a transition to bring a 
key on air and remain lit until the key is taken off air.

Knobs
The rotary knobs used on the Synergy 100 control panel are End-stop Knobs.

End-stop Knobs, Mattes Group 

Note the following important points regarding End-stop Knobs:

• All End-stop Knobs cannot be rotated past the absolute upper and lower limits of the 
function being adjusted. 

• Because an End-stop Knob’s electrical position can be overwritten by memory recalls, 
the electrical knob position may not match the knob’s current physical position. In this 
case, the knob can be adjusted but you may not have the full range available.

Operating
Tip

To fully re-synchronize an End-stop Knob’s physical-to-electrical 
position, turn the knob fully clockwise, then fully counter-clockwise. 
Full-range adjustments can now be made.
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Fade to Black
The following topics are discussed in this section:

• Changing Fade to Black Rates

• Using Fade to Black

Changing Fade to Black Rates
Use the following procedure to change the Fade to Black rates:

1. Press the SEL button in the System Control Group until the FADE mode illuminates.

Setting the Fade to Black Transition Rate

2. Using the 100, 10, and 1 buttons, program the rate at which the fade is to take place.

This completes the procedure to change the Fade to Black rates.

Using Fade to Black
The switcher’s “Fade to Black” function allows you to fade (auto-transition) the entire switcher output 
to black, including the downstream key and all effects currently on air. It is the last effect that the 
switcher is capable of performing before the final video signal is passed to the output. The button 
labeled Fade to Black in the Transition Control Group controls the fade to black function.   

Fade to Black Button in the Transition Control Group

"FADE" Mode

SEL Button
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MENU SEL

EDIT

BACK

100 10 1
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TRANSITION  CONTROL

BKGD KEY1 KEY2SHIFT

SHIFT

SHIFT

DISS WIPE DVE

CUT AUTO
TRANS

HOLD FOR TRANSITION PREVIEW

TRANS
LIMIT

PST
BLACK

FADE
TO

BLACK

ON AIR ON AIR

ON AIR

DSK
CUT

DSK
DISS

FADE TO BLACK
Button
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Use the following procedure to cause the switcher to do a fade to black:

1. Press the Fade to Black button located in the Transition Control Group while 
observing the program monitor.

2. The fade will take place at the rate programmed in the section “Changing Fade to 
Black Rates” on page 4-8.

3. The LED on the Fade to Black button will be lit orange while fading to or fading from 
black. However, when the switcher is in a “Fade to Black” state, the LED will flash red.

Reverse Fade
A reverse fade is accomplished by pressing the Fade to Black button again. This causes the switcher 
to do a fade from black to the previous scene. A reverse fade can take place during an active fade 
process. In a situation where a scene is being faded down, pressing the Fade to Black button a 
second time will cause the scene to automatically fade back up.

Notes on Using the Fade to Black Function
Please note the following important points regarding the Fade to Black function:

• The Fade to Black transition is independent of all other switcher transitions.

• When the switcher has faded to black, keys can still be modified and cut off and on. 
Source selections can also be changed. This allows one to fade down to one scene and 
fade up to another.

• A Fade to Black transition cannot be previewed. The appropriate rate must be set by 
reference to the fade appearance on the program output.

• Once the switcher is in black, it stays in black until the Fade to Black button is pressed 
again.

• When the switcher is in black, the LED on the Fade to Black button continues to flash 
red as long as the switcher remains in full Fade to Black mode. 

• If you are performing a long Fade to Black and you wish to change your mind, press 
Fade to Black again (during the fade transition) to reverse direction — and return to 
the starting point (full program).
Synergy 100 Operation Guide (v16.10-S100) Switcher Basics • 4–9



Aspect Ratio
The Synergy 100 switcher operates in either 4:3 or 16:9 mode. Setting the output aspect ratio to 4:3 
automatically defines the aspect ratio of all the inputs as 4:3 and greys out the Aspect value on the 
Inputs Menu. Conversely, setting the output aspect ratio to 16:9 automatically defines all of the 
inputs as 16:9. This procedure of changing the internal aspect ratio ensures the circle wipe remains a 
perfect circle in either mode.

Use the following procedure to set the output aspect ratio: 

1. Navigate to the Outputs Menu as follows:

• Press MENU to display the Main Menu on the Preview Overlay.
• Press 2. Outputs to display the Outputs Menu.

Outputs Menu

2. Set the output aspect ratio as follows:

• Press 0. Aspect.
• Toggle the 0. Aspect button to select a mode. You can choose between the 

following:
~ 4:3 — Setting the output aspect ratio to 4:3 automatically defines the aspect 

ratio of all the inputs as 4:3

~ 16:9 — Setting the output aspect ratio to 16:9 automatically defines all of the 
inputs as 16:9.

• Press the right SEL button to accept the new settings.
3. Press MENU to display the Installation Change Screen.

Note If you are operating in 16:9 mode and all inputs are 16:9 video sources, 
you must have your outputs feeding 16:9 monitors in order to view the 
video without distortion. By the same token, if you are operating in 4:3 
mode with 4:3 video sources feeding your inputs, ensure that you have 
4:3 monitors with which to view your output.

Note Dual aspect ratio production is not available in this software release. 
However, future releases which incorporate Ross Video’s Dual 
Aspectizer will offer full dual aspect ratio production capabilities. 

Outputs

0. Aspect
1. Ref Dly

4:3
300

2. Clean BeforeKeys

MENU
Exit

100
Previous

SEL
Accept

10
Down

1
Up

3. Ancillary data
4. Rem Aux  Off
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4. Accept or cancel these changes as follows:

• Press 0. Confirm to accept the changes.
• Press 1. Cancel to exit the menus safely, without making any changes. The system 

returns to the previously stored settings.

This completes the procedure to set the output aspect ratio.
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Transitions

In This Chapter
Transitions are the most frequently used switcher operations. The simplest transition is a direct 
selection of the next picture on the PGM (Program) bus, performed by pressing another crosspoint. 
This simple “cut” provides an instantaneous change but does not allow you to preview the next 
picture.

Other types of transitions involve the PST (Preset) bus and the controls in the Transition Control 
group. Here, using cuts, dissolves, wipes, as well as DVE transitions, you have a full preview of the 
upcoming picture. 

The following topics are discussed in this chapter:

• Transition Control Group

• Working with Next Transitions 

• Eight Steps to Flawless Transitions

• Auto Transitions

• Changing Auto Transition Rates

• Using Manual Transitions

• Using Cuts

• Using Dissolves

• Transition Limit

• Transition Preview

• Preset Black
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Transition Control Group
The following figure illustrates the Transition Control group. 

Transition Control Group

Following are descriptions of each section. 

1. Fader Section 

The Fader handle is used to perform manual transitions. The “type” of transition is 
based on the transition button that is selected in the Transition Type Section — be it a 
Dissolve, a Wipe or a DVE transition. The Fader performs one complete transition 
when it is moved from one limit to the other. Due to the switcher’s flip-flop architecture, 
it does not matter at which limit the transition begins. The PGM bus always remains the 
program output.

The Transition Progress Bar located to the left of the Fader indicates the direction of 
Fader travel during a transition. As the transition progresses, the LED segments of the 
bar will illuminate. For full or partial transitions (when the Fader is paused part-way 
through), the unlit portion of the bar indicates the direction that the Fader must be 
moved in order to complete the transition.

Please note that the Transition Progress Bar will also illuminate when the AUTO 
TRANS button is used to perform the transition.

1) Fader Section
2) Next Transition Section

3) Transition Type Section
4) DSK Transition Section

5) Transition Parameter Section
6) Fade To Black Button
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2. Next Transition Section 

The Next Transition Section includes three buttons that allow you to select the 
combination of actions that will be included in the next transition. When pressed, all 
buttons remain lit until another combination of button(s) is selected — they can be 
enabled in any combination. When pressed, the program video is not affected — only 
the actions in the next transition are affected.

• Enable BKGD to include a transition between the PGM and PST buses. When a 
manual or auto-transition is performed, the video selected on PST transitions to 
PGM.

• Enable KEY1 to perform a transition of the Effects Keyers’ first key.
~ If the keyer is currently off, the transition brings on the key and the ON AIR 

LED below the button lights red. 

~ If the keyer is currently on, the transition removes the key and the ON AIR 
LED below the button turns off.

• Enable KEY2 to perform a transition of the Effects Keyers’ second key.
~ If the keyer is currently off, the transition brings on the key and the ON AIR 

LED below the button lights red.

~ If the keyer is currently on, the transition removes the key and the ON AIR 
LED below the button turns off.

Remember that any combination of actions can be selected. Refer to the section 
“Working with Next Transitions” on page 5-5 for more information on the three Next 
Transition buttons and the ON AIR LEDs.

3. Transition Type Section

The buttons in the Transition Type Section allow you to choose the type of transition 
and initiate the transition itself.

• The DISS button selects a dissolve as the transition type. When a dissolve is 
performed, the video on the PST bus gradually mixes into the video on PGM. At 
the end of the transition, PST video completely replaces PGM video and the buses 
flip-flop. 
The DISS button is mutually exclusive with the WIPE and DVE buttons. Refer to 
the section “Using Dissolves” on page 5-9 for instructions.

• The WIPE button selects a wipe as the transition. When performed, the video on the 
PST bus gradually replaces the PGM video using a wipe pattern chosen from the 
Effects Control group. At the transition’s end, PST video completely replaces 
PGM and the buses flip-flop.
The WIPE button is mutually exclusive with the DISS and DVE buttons. Refer to 
the “Using Wipes” section in Chapter 6 for instructions.

• The DVE button selects a 2-D or 3-D DVE effect as the transition. When 
performed, the video on the PST bus gradually replaces the PGM video using a 2-D 
or 3-D DVE effect pattern chosen from the Effects Control group. At the 
transition’s end, PST video completely replaces PGM and the buses flip-flop.
The DVE button is mutually exclusive with the WIPE button. Refer to the section 
“Using Wipes” on page 6-12 for instructions.

BKGD

KEY1

ON AIR

KEY2

ON AIR

DISS

WIPE

DVE
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• The CUT button performs an instantaneous “cut” between the PST and PGM bus 
sources. The buses flip-flop after the cut is performed. The button itself is 
momentary — it does not stay lit.

• For dissolves, wipes and DVE transitions, AUTO TRANS performs an automatic 
transition between PST and PGM.   The button is momentary and stays lit only 
during the transition. Rates are entered in the System Control group. 

4. DSK Transition Section

The two buttons in the DSK Transition Section are used to initiate a transition of the 
Downstream key. 

• The DSK CUT button performs an instantaneous “cut”, either bringing on the 
downstream key or removing it, depending on your current setup. The button itself 
is momentary — it does not stay lit.

• The DSK DISS button performs an automatic transition, initiating a dissolve to 
either bring on the downstream key or remove it, depending on your current setup. 
The button is momentary and stays lit only during the transition. Rates are entered 
in the System Control group.

5. Transition Parameter Section

The buttons in the Transition Parameter Section allow you to choose various transition 
attributes, if desired.

• The TRANS LIMIT button allows you to stop a transition at a preset position – in 
between the two absolute Fader limits. Refer to the section “Transition Limit” on 
page 5-10 for details.

• The PST BLACK button is a special two-stage transition that takes the switcher to 
black (or any other desired source) and then proceeds to the next transition 
previously indicated. Refer to the section “Preset Black” on page 5-12 for details.

6. Fade To Black Button

• Press Fade To Black to initiate an “on air” fade-to-black (or fade up from black if 
pressed during a fade down) at the rate set for Fade To Black in the Auto 
Transition Rate Group.

Note As an alternative, the DVE and WIPE buttons can be pressed 
simultaneously to select a DVE effect as the transition type.

The optional Squeeze & Tease 2D Board or Squeeze & Tease WARP 
Board must be installed to enable DVE transitions.

Note Although we have used BKGD transitions between the PGM and PST 
buses as examples, remember that all types of transitions operate in the 
same manner, regardless of the Next Transition buttons selected.

Note If the keyer is currently off, the transition brings on the key and the ON 
AIR LED below the buttons lights red. Similarly, if the keyer is 
currently on, the transition removes the key and the ON AIR LED 
below the buttons turns off.

CUT

AUTO
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DSK
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Working with Next Transitions
The Next Transition Section includes three buttons that allow you to select the combination of 
actions that will be included in the next transition. The section also includes two ON AIR LEDs that 
indicate the state of the Effects keys. 

Next Transition Section of the Transition Control Group

Please note the following important points:

• The three buttons define what you want to change on your program output. Any 
combination of the background and keys can be changed. You can change up to three 
elements as desired — simply by pressing the appropriate combination of buttons. 

• If a button is lit, that element will change when the transition is performed, either 
manually (with the Fader) or automatically (with the AUTO TRANS or CUT button). 
When the transition has completed, buttons that are lit will stay lit — until you change 
them.

• A “lit” key button should not be confused with the fact that you want a key to appear on 
air. Instead, it means that you want to change the state of the key.   If a key button is lit, 
the key will change state. If a key’s state is on, the ON AIR LED will be lit red.

• The ON AIR LEDs have two states: 

~ When the LED is Off, the Effects key is turned off. It is not contributing to the 
output of the switcher.

~ When the LED is lit Red, the key is turned on. It is contributing to the program 
output of the switcher.

Eight Steps to Flawless Transitions
Following are several easy steps for using the three “next transition” buttons to get the images you 
want on air — flawlessly. 

1. Ensure that you have a Preview monitor connected.

2. Look at your Program monitor and determine what video elements you want to change 
— the background, Effects keys, or a combination of the elements.

3. Press the desired “next transition” button(s).

4. Look at your Preview monitor and confirm that the monitor shows the desired video 
elements in the desired states (e.g., keys on, keys off, proper background video selected).

5. If one of the key elements is in the wrong state, press its associated “next transition” 
button and re-confirm the new composite image on Preview. 

Operating
Tip

Always check your preview monitor! The preview monitor output will 
always show you the next scene. For example, if a key’s state is 
currently on and the desired key button is lit, the preview monitor will 
show the key off.

BKGD KEY1 KEY2

ON AIR ON AIR
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6. If you are bringing on a new key, ensure that the correct key source is selected and that it 
appears properly on Preview. If required, adjust the key source accordingly.

7. If the background image is wrong, select the correct image on the PST bus — or 
alternately, change the state of the BKGD button.

8. Once you have confirmed that the next image is correct on Preview, perform the 
transition — either manually with the Fader or automatically using CUT or AUTO 
TRANS. Remember that the “next transition” buttons stay lit after the transition is 
complete.

Auto Transitions
The AUTO TRANS button is used to start an automatic (smooth) transition between the selected 
Preview and Program monitor outputs. Note the following important rules:

• To “escape” from an auto transition in progress, you can either press CUT during the 
transition or manually pull the Fader in the proper direction. The “cut” action instantly 
completes the transition.

• You can not initiate an auto transition or a cut in the Transition Control Group if the 
Fader is off its upper or lower limit.

• If you disable the Audio Cut mode in the Personality Menu, by selecting the Off 
option, the audio transition will reflect the type of transition selected. If you press the 
AUTO TRANS button, the audio transition will be performed at the same rate as the 
video transition.

Changing Auto Transition Rates
The System Control Group is used to set and display the three separate auto transition rates in 
television frames. A frame is 1/30 (NTSC) or 1/25 (PAL) of a second, depending on the television 
standard in use. NTSC has 525 lines of video, while PAL has 625 lines of video. The three rates 
shown on the control panel are:

• AUTO — initiated by the AUTO TRANS button located in the Transition Control 
Group.

• DSK — initiated by the DSK DISS button located in the Transition Control Group.

• FADE — initiated by the Fade To Black button found in the Transition Control 
Group.

The SEL button is used to select which of the three rates is shown on the display. Repeated pressing 
of this button cycles through the three selections listed above. The transition rate shown corresponds 
to the selection appearing in the display. Therefore, three different transition rates can be stored, one 
for each function, and these rates will apply to the auto transitions activated by the appropriate 
buttons.

This section provides instructions for changing auto transition rates.

1. In the System Control Group, note the current transition rate in the display. 
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System Control Group

2. Press the SEL button until the “Mode” for the desired function appears.

3. Using the 100, 10, and 1 buttons, scroll to the desired rate in frames — from 1 to 999. 
The new rate is automatically updated and appears in the display as you scroll.

System Control Group

Please note:

• Since the transition rate updates automatically as you scroll, there is no means of 
canceling the procedure. If you wish to “clear” the new rate, simply scroll to the original 
transition rate, as instructed above. 

• If you scroll past the rate desired, use the 100, 10, and 1 buttons to scroll forwards until 
the desired value again appears in the display.

• You can reset the values in the hundreds and tens columns to 0 simply by holding down 
the 100 and 10 buttons. The value in the ones column will default to 1 frame by holding 
down the 1 button. 

• You cannot program a transition rate of 0 frames as this is the same as a cut.

Mode

SEL Button

SYSTEM  CONTROL

MENU SEL

EDIT

BACK

100 10 1

MODE

AUTO

Mode

SEL Button

SYSTEM  CONTROL
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EDIT
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Using Manual Transitions
Use the following procedure to perform a manual transition:

1. Ensure that your PGM bus, PST bus, and keys are set up as desired. 

2. In the Next Transition Section, select BKGD, KEY1, or KEY2, or any combination 
thereof as the next transition.

3. In the Transition Type Section, select the desired transition type — dissolve, wipe, or 
DVE effect.

4. Move the Fader from its current limit to the opposite limit. The speed at which you 
move the Fader determines the manual transition rate. 

• Remember that during a transition, the Transition Progress Bar LED segments 
illuminate as the Fader travels, with the unlit portion signifying the direction the 
Fader must be moved in order to complete the transition.

This completes the procedure to perform a manual transition.

Using Cuts
A “background cut” is an instant switch between the PGM and PST buses.

Use the following procedure to perform a cut:

1. Select an input on the PGM bus. 

2. Select a different input on the PST bus.

3. In the Next Transition Section, select BKGD as the next transition. The figure below 
illustrates a sample setup and the associated monitor outputs — before the cut.

Note The manual transition will be applied to audio transitions when the 
Audio Cut feature is Off. Refer to the section “Audio Cut Mode 
Setup” in the Synergy 100 Installation Guide for information on this 
feature.

Note When the fader is off a limit, all buttons in the Transition Control 
group are disabled.

Note You can also perform a background cut simply by switching inputs on 
the PGM bus itself. This type of cut does not allow you to preview the 
next picture.

Although we have used BKGD transitions between the PGM and PST 
buses as examples, remember that all types of transitions operate in the 
same manner, regardless of the Next Transition buttons selected.
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Sample Setup – Before a Cut

4. Press CUT. The inputs selected on the PGM and PST buses instantly exchange and the 
buses flip-flop. The figure below illustrates the MLE and monitor setup after the cut.

Sample Setup – After a Cut

5. Press CUT again to repeat the process and restore the original background.

This completes the procedure to perform a cut.

Using Dissolves
In a “background dissolve” transition, the PGM bus video and PST bus video signals are gradually 
mixed together, until the PST bus video completely replaces the PGM bus video.

Use the following procedure to perform a dissolve:

1. Select an input on the PGM bus. 

2. Select a different input on the PST bus.

3. In the Next Transition Section, select BKGD as the next transition. The figure below 
illustrates a sample setup and the associated monitor outputs — before the dissolve.

Sample Setup – Before the Dissolve

Note Although we have used BKGD transitions between the PGM and PST 
buses as examples, remember that all types of transitions operate in the 
same manner, regardless of the Next Transition buttons selected.
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4. In the Transition Type Section, press DISS. 

5. To perform a manual transition, move the Fader from limit to limit. To perform an auto 
transition, press the AUTO TRANS button. During either transition, the PST bus video 
signal gradually mixes into the PGM signal, as shown below.

Sample Setup – Performing a Transition

At the end of the transition, the PST video completely replaces the PGM video and the 
buses flip-flop. The figure below illustrates the MLE and monitor setup after the 
dissolve.

Sample Setup – After the Dissolve

This completes the procedure to perform a dissolve.

Transition Limit
The TRANS LIMIT button in the Transition Control group allows you to stop a transition at a preset 
position — in between the two absolute Fader limits. 

Use the following procedure to perform a transition limit effect:

1. Ensure the Fader is at an upper or lower limit and note the limit that you choose. The 
Fader must be returned to this limit in a subsequent step.

2. Select a dissolve or a wipe as your next transition. 

Note If a very short auto transition rate is selected (typically five frames or 
less), this may appear the same as a cut. This type of transition is often 
called a “soft cut”.

Refer to the section “Using Wipes” on page 6-12 for complete 
instructions on performing wipe transitions.

Note Trans Limit will be applied to audio transitions when the Audio Cut 
feature is Off. Refer to the section “Audio Cut Mode Setup” in the 
Synergy 100 Installation Guide for information on this feature.
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3. Move the Fader and manually set the transition to the desired position.

• In the case of a dissolve, visually set the desired mix (superimposition) between 
Program and Preset.

• In the case of a wipe, visually set the desired split screen position between Program 
and Preset.

4. Leave the Fader at its preset position and press TRANS LIMIT. The button lights 
momentarily and the fader position is stored. 

5. Move the Fader back to the limit selected in step 1.

6. Press TRANS LIMIT to turn on the Transition Limit function. A single LED in the 
Transition Progress Bar illuminates, corresponding to the manually set position in step 
3.

7. Use the AUTO TRANS button to perform the transition. The transition moves to the 
limit that you selected in step 3 and stops.

8. There are two ways to continue the transition:

• Leave the TRANS LIMIT button turned on. When you use the AUTO TRANS 
button again, the transition reverses — and returns to its starting point. 

• Turn off the TRANS LIMIT button. When you use the Fader or AUTO TRANS 
again, the transition continues to its end.

This completes the procedure to perform a transition limit effect.

Transition Preview
The “transition preview mode” allows you to rehearse a complete preset-to-background transition 
without affecting the program output. When in this mode, the full transition occurs on Preview, 
leaving the Program output signal undisturbed. You can create, rehearse and preview any transition. 
With the transition preview mode engaged, the Fader is effectively disconnected from program.

Use the following procedure to utilize the Transition Preview function:

1. Select the desired Next Transition button or buttons, depending on which video 
elements you want to change.

2. Press and hold the desired Transition Type button – DISS or WIPE.

3. Use the Fader or AUTO TRANS to preview the current effect. Make any modifications 
desired.

4. Once you are satisfied with the effect, release the Transition Type button. The preview 
monitor reverts back to its look-ahead preview mode.

5. Perform the transition on air. The program output shows the exact effect as previewed 
previously on the preview monitor using “transition preview mode.”

This completes the procedure to utilize the Transition Preview function.

Note A DVE transition cannot be previewed.

Note If there is a transition in progress when the Transition Type button is 
released, the preview monitor output will not return to its look-ahead 
preview mode until the transition is complete.
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Please note the following important points:

• Transition preview mode is highly recommended for previewing complete effects.

• If you are unable to perform a transition preview as per the instructions above, please 
refer to Chapter 8, “Additional Installation Setups” in the Synergy 100 Installation  
Guide.

Preset Black
The Preset Black function is a special two-stage transition that allows you to take the switcher to 
black (or any other desired source) with the first transition, and then proceed to the next transition 
previously indicated. This function is quite useful for dipping the switcher quickly to black or 
transitioning to a commercial. 

Pressing PST BLACK causes the BLACK crosspoint to be selected on the PST bus, replacing the 
currently selected PST source. The buttons in the Next Transition Section may change, depending on 
what is currently on air. 

There are two stages to the transition:

• When you press PST BLACK, the switcher presets a dissolve to black. An alternate 
transition type can be selected, if desired. If a key or a combination of keys are on, but 
their “next transition” buttons are not lit, the switcher automatically lights the button for 
you.

The first transition dissolves the switcher to black and dissolves off all keys. The 
buttons in the Next Transition Section then change, presetting the switcher with the 
original preview scene. This scene now appears on the Preview monitor.

• The second transition brings the switcher back up from black to the scene previously 
shown on Preview — regardless of the combination of background and key sources 
selected. 

Use the following procedure to perform a Preset Black transition:

1. Press PST BLACK. The preview monitor will now show a black picture.

2. Perform a transition with the Fader, AUTO TRANS or CUT. The program transitions 
to black. Note that when black is reached, the switcher presets the previous scene (from 
step 1) which also appears on Preview.

3. Perform a second transition using the Fader, AUTO TRANS or CUT. The switcher 
transitions to the previous scene, at the end of which the PST BLACK light turns off.

This completes the procedure to perform a Preset Black transition.

Operating
Tip

After Step 1, a different source other than black can be selected on 
PST. This would allow you to dip to COLOR BKGD (white, for 
example), for a creative “flash-frame” transition. In addition, BLACK 
can be permanently overridden by holding down the PST BLACK 
button while selecting the desired source on the PST bus. This 
override can be stored to disk or USB key in the Personality register.
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Pattern and Effects Control

In This Chapter
This chapter provides information and instructions for using your switcher’s Effects Control groups. 
The following topics will be discussed:

• Effects Control Groups

• Effects Control Modes

• Effects Menu Functions

• Wipes Overview

• Using Wipes

• Selecting Wipes 

• Mattes Group
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Effects Control Groups
The two Effects Control groups are assignable groups of controls that allow you to choose wipe 
patterns, and adjust wipe parameters and key modifiers. For example, by pressing WIPE or FLY 
KEY, the groups are assigned to that specific function.   

The top Effects Control Group includes a four-character display labeled “MODE”, and its 
associated SEL button. This display identifies which area or button on the switcher has control of the 
Effects Control groups. In addition, the button of the controlling feature (i.e., WIPE or FLY KEY) 
will illuminate green, instead of yellow.

The following figure illustrates the Effects Control groups on the Synergy 100 control panel: 

Effects Control Groups 

Effects Control Modes
• The SEL button in the Effects Control Group allows you to cycle through several 

“modes”, depending on the area or button which currently has control of the Effects 
Control groups. The modes displayed are linked to the area or button selected, as 
outlined in the table on the following page.

In addition, by holding down the SEL button and pressing one of the buttons listed in 
the following table, you can change the button that has control without having to toggle 
it on and off.

EFFECTS  CONTROL

SEL

CNTR

REV

MODE

MATTES

SEL

MODE

L
E
A
R
N

EFFECTS   CONTROL

ROTATE MEM

ASPECT

ASPECT

BORDERSOFT

AUX3
E
F
F

D

SEL
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Notes:

(*1) Selecting PST PATT in the keyer automatically turns on the FLY KEY.

(*2) Except when the key type is a Squeeze & Tease Box.

(*3) If you have the Squeeze & Tease WARP option installed, the key can also be rotated.

(*4) Only valid when in the S&T 3D Menu.

(*5) Refer to the Synergy 100 Squeeze & Tease 3D/WARP Owner’s Guide for full details.

Effects Control Mode Table

Mode Button Selected Features Controlled
FLY1 FLY KEY in Effects Keyer, Key 1 (*1) (*3) Size, aspect ratio, and position of flown key in 

Keyer 1

FLY2 FLY KEY in Effects Keyer, Key 2 (*1) (*3) Size, aspect ratio, and position of flown key in 
Keyer 2

CRP1 MASK when a Squeeze & Tease Box is active 
in Effects Keyer, Key 1

Cropping all edges of the video in a Squeeze & 
Tease Box on Key 1

CRP2 MASK when a Squeeze & Tease Box is active 
in Effects Keyer, Key 2

Cropping all edges of the video in a Squeeze & 
Tease Box on Key 2

MSK1 MASK in the Effects Keyer, Key 1 (*2) Masking areas of a Self, Auto Select, or Chroma 
key on Key 1

MSK2 MASK in the Effects Keyer, Key 2 (*2) Masking areas of a Self, Auto Select, or Chroma 
key on Key 2

MSKd MASK in the Downstream Keyer Group Masking areas of a Self or Auto Select key in 
the Downstream Keyer

MEM“#” MEM in the Effects Control Group Access to the Memory Store and Recall features

WIPE WIPE in the Transition Control Group All Wipe controls, including pattern selection 
and modifiers

PP1 PST PATT (with FLY KEY off) in Effects 
Keyer, Key 1

All modifiers for the Preset Pattern key type on 
Key 1

PP2 PST PATT (with FLY KEY off) in Effects 
Keyer, Key 2

All modifiers for the Preset Pattern key type on 
Key 2

DVE DVE in the Transition Control Group Pattern selection and wipe direction for the 
Squeeze & Tease wipes

BORD BORD, SHDW, or OUTL in the Downstream 
Keyer Group

All modifiers (softness, size, etc.) for the 
optional border generator on the DSK

ACK1 CHROMA KEY in Effects Keyer, Key 1 The Auto Chroma Key feature when setting up a 
Chroma Key or Ultimatte Key on Key 1

ACK2 CHROMA KEY in Effects Keyer, Key 2 The Auto Chroma Key feature when setting up a 
Chroma Key or Ultimatte Key on Key 2

NONE *see next column If any of the above features have control, 
turning them off will set the mode to NONE.

HIDE and SHOW SEL to the left of the “Mode” display toggles 
between the two modes. (*4) (*5)

When in any 3D menu, sections of the menu can 
be hidden. If the mode is set to “HIDE”, only 
the currently selected item, and its 
corresponding data values will remain 
displayed. “SHOW” displays the entire S&T 3D 
menu and all data values. 
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Effects Menu Functions
There are several options in the Effects Menu that allow you to enable editors and GPIs and place 
displays on top of the selected preview output. Please note the following important points:

• When in the Effects Menu, each press of the SEL button or corresponding option 
number in the Effects Control Group toggles a specific effect function on and off.

• All functions are independent. They can be enabled or disabled in any combination 
desired.

The following topics are discussed in this section:

• Center Overlay

• Safe Title Overlay

Each of these functions is described below. 

Center Overlay
The Center Overlay feature places cross hairs on the preview monitor to indicate the center of the 
picture, as shown below. Once enabled, the Center Overlay feature can be used to align text and 
other information, both horizontally and vertically.

Preview Monitor — Center Overlay

Use the following procedure to enable the Center Overlay feature:

1. Ensure that your preview monitor is properly connected. 

2. Navigate to the Effects Menu as follows:

• Press MENU to display the Main Menu.
• Press to display the Effects Menu.

Note Enabling the Editor feature using the Effects Menu is discussed in the 
section the section “Editor Interface” on page 9-5.
For information on enabling the GPIs interface feature, refer to the 
section “GPIs” on page 9-2. 
Refer to the section “Menu Background” on page 3-5 for information 
on enabling the Menu Background feature. 
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Effects Menu

3. Enable the Center Overlay feature as follows:

• Press 2. Center.
• Toggle the 2. Center button between On and Off as follows:

~ On — Use this option to enable the Center Overlay feature. This will place 
cross hairs on the preview monitor to indicate the center of the picture.

~ Off — Use this option to disable the Center Overlay feature. This is the default 
setting.

• Press the right SEL button to accept the new settings.
4. Press MENU to display the Installation Change Screen.

5. Accept or cancel these changes as follows:

• Press 0. Confirm to accept the changes.
• Press 1. Cancel to exit the menus safely, without making any changes. The system 

returns to the previously stored settings.

This completes the procedure to enable the Center Overlay feature.

Safe Title Overlay
The Safe Title Overlay feature places a SMPTE standard safe title and safe action grid on the preview 
monitor, as shown below:

Preview Monitor - Safe Title Overlay

Please note the following points about the Safe Title Overlay:

• The “Safe Title” box (inner box) outlines the area within which the vast majority of 
home television sets will be able to read text. 

Effects

MENU
Exit

100
Previous

10
Down

1
Up

SEL
Accept

0. Editor          On
1. GPIs            Off
2. Center         Off
3. SafeTitle      Off
4. Menu Bkgd  On

Safe Title
Safe Action
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• The “Safe Action” box (outer box) outlines the region within which viewers should be 
able to follow action on their television screen.

Use the following procedure to enable the Safe Title Overlay feature:

1. Navigate to the Effects Menu as follows:

• Press MENU to display the Main Menu.
• Press to display the Effects Menu.

Effects Menu

2. Enable the Safe Title Overlay feature as follows:

• Press 3. Safe Title. 
• Toggle 3. Safe Title between On and Off as follows:

~ On — Use this option to enable the Safe Title Overlay feature. A grid will be 
displayed on the preview monitor.

~ Off — Use this option to disable the Safe Title Overlay feature. This is the 
default setting.

• Press the right SEL button to accept the new settings.
3. Press MENU to display the Installation Change Screen.

4. Accept or cancel these changes as follows:

• Press 0. Confirm to accept the changes.
• Press 1. Cancel to exit the menus safely, without making any changes. The system 

returns to the previously stored settings.

This completes the procedure to enable the Safe Title Overlay feature.

Note To suppress the above two overlay elements of the Effects Menu, 
ensure that the overlays are toggled to the Off position.

Effects

MENU
Exit

100
Previous

10
Down

1
Up

SEL
Accept

0. Editor          On
1. GPIs            Off
2. Center         Off
3. SafeTitle      Off
4. Menu Bkgd  On
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Wipes Overview
The Effects Control groups also include two pattern generators:

• Pattern Generator 1 is shared by the Wipe Generator and the Preset Pattern 
Generator for the Effects Keyers’ KEY1. This pattern generator is full-featured — all 
wipe patterns are available.

• Pattern Generator 2 is used by the Preset Pattern Generator for the Effects Keyers’ 
KEY2. This generator is restricted to the Classic wipe patterns, minus the circle. Rotary 
and Matrix wipes are not available.

To select a wipe, press WIPE in the Transition Control Group and select the desired pattern button. 
Once selected, the pattern can be modified and used on air. A single press of a button will illuminate 
its LED, and select the wipe as pictured. If you double-press the button, the LED will flash, indicating 
“user wipe mode”, and you will be able to choose any of the more than sixty wipes available. Refer to 
the section “Using Wipes” on page 6-12 for more information on selecting and using wipes.

Effects Control Group Sections
The top Effects Control Group includes 10 buttons which display 10 “classic” wipes. In addition, 
each button provides access to any of the more than 60 “user” wipes available. 

• If you have the Squeeze & Tease 2D option installed, an additional 40 two-dimensional 
DVE effects are available. 

• If you have the Squeeze & Tease WARP option installed, there are several 
three-dimensional DVE effects to choose from.

Also included in the top Effects Control Group are the following two buttons: 

• The REV/LEARN button controls the direction of the wipe. Three choices of wipe 
directions are available:

~ The default state of the REV/LEARN button is off. The wipe will proceed in the 
normal fashion, with the new picture being revealed from the black area (as shown 
on the pattern button) to the white area. The button’s LED will not be lit.

~ Press REV/LEARN to set the direction of the wipe to reverse. The new picture is 
revealed from the white area to the black area. The button’s LED will be on.

~ Double-press REV/LEARN to set the direction of the wipe to “flip-flop”. Wipe 
direction is normal for the first transition, reverse for the second, then normal for the 
third, etc. The button’s LED will be flashing.

• The CNTR/EFF D button is used to return a border, wipe positions, masks, and 
cropping features to their default state or position. In addition, it is used to default flown 
keys, including Squeeze & Tease 2D and Squeeze & Tease WARP boxes, to full 
screen. When recalling memories, this button enables you to perform an “effects 
dissolve” between two switcher setups.

Note Because Pattern Generator 1 is shared, you cannot select a WIPE 
transition if PST PATT is selected on Keyer 1. Similarly, if WIPE is 
enabled and you select a PST PATT key type in Keyer 1, the WIPE 
button turns off and the transition type reverts to DISS.

REV
L
E
A
R
N

CNTR
E
F
F

D
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The lower Effects Control Group provides two buttons and three “end-stop” knobs that modify the 
selected pattern.  

• The BORDER knob allows you to adjust pattern borders, from no border to full-screen 
borders on all wipe patterns, with the exception of pattern number 111, which does not 
accept a border. (Refer to the section “Selecting Wipes ” on page 6-13 for information 
on how to access additional patterns.)

~ Turning the knob clockwise increases border width.

~ Turning the knob counter-clockwise decreases border width.

• The SOFT knob allows you to adjust pattern edge softness from hard-edge to full 
soft-edge on all patterns, with the exception of pattern number 111, which does not allow 
edge softness. (Refer to the section “Selecting Wipes ” on page 6-13 for information on 
how to access additional patterns.) 

~ Turning the knob clockwise increases edge softness.

~ Turning the knob counter-clockwise decreases edge softness.

•  When the ASPECT button is lit, the adjacent knob can be used to adjust the aspect ratio 
of selected patterns.

~ Turning the knob clockwise increases the pattern’s vertical   aspect ratio, and, at the 
same time, reduces the horizontal aspect ratio.

~ Turning the knob counter-clockwise increases the pattern’s horizontal aspect ratio, 
and, at the same time, reduces the vertical aspect ratio. 

• The ASPECT button enables the use of the adjacent knob.

~ When the button is on, patterns with both horizontal and vertical angles to their 
edges can have their aspect ratios adjusted. Circles can be adjusted into ovals, 
squares into rectangles, etc.

~ When the button is off, all aspect ratio adjustment is   removed and the pattern 
returns to its default shape.

Notes on using the Aspect Button
Note the following points regarding the ASPECT button:

• If you adjust the aspect ratio of one pattern, then select another pattern that can not have 
its aspect adjusted, the ASPECT light will stay on until it is turned off manually by 
pressing the button. 

Important As an overall reminder about the knobs in the Effects Control Group, 
please note the following important point regarding end-stop knobs:

Because an End-stop Knob’s electrical position can be overwritten by 
recalling a memory register, the electrical knob position may not match 
the knob’s current physical position. In this case, the knob can still be 
adjusted but you may not have the full adjustment range available.

Operating
Tip

To fully re-synchronize an End-stop Knob’s physical-to-electrical 
position, turn the knob fully clockwise, then fully counter-clockwise. 
Full-range adjustments can now be made.

BORDER

SOFT

ASPECT

ASPECT
6–8  • Pattern and Effects Control Synergy 100 Operation Guide (v16.10-S100)



• The ROTATE button enables the use of the positioner as a wipe pattern modifier.

~ When the button is on, wipe patterns 00 and 07 (horizontal wipes) and 10 and 17 
(vertical wipes) can be rotated a full 360 degrees. Only these four patterns can be 
rotated.

~ When the button is off, all rotation is removed and the pattern returns to its default 
position.    .       

Classes of Wipes
The switcher’s WIPE feature allows you to select from over 60 wipes, including those that are 
normally hidden from view on the panel. If your switcher has the optional Squeeze & Tease 2D 
Board installed, another 40 DVE effects, such as pushes and tumbles, are available. If you have the 
Squeeze & Tease WARP option installed, there are several 3-dimensional DVE effects to choose 
from.

The classes of wipes are as follows:

0. classic wipes 
1. rotary wipes
2. matrix wipes
3. special wipe

Each class of wipe is illustrated in the following sections.

Classic Wipes
The following figure illustrates the available “Classic” Wipes – Class 0.

             
Classic Wipes – Class 0

Note If you have the Squeeze & Tease WARP option installed, the 
ROTATE button has further functionality. Refer to the Synergy 100 
Squeeze & Tease 3D/WARP Owner’s Guide for details.

ROTATE

009000 001 002 003 004 005 006 007 008

020 021 022

010 011 012 013 014 015 016 017 018 019

023
Synergy 100 Operation Guide (v16.10-S100) Pattern and Effects Control • 6–9



Rotary Wipes
The following figure illustrates the available “Rotary” Wipes – Class 1.

Rotary Wipes – Class 1

Matrix Wipes
The following figure illustrates the available “Matrix” Wipes – Class 2.

Matrix Wipes – Class 2

Special Wipes
The following figure illustrates the available “Special” Wipes – Class 3.

Wipe number 300 is the special animated “fire” wipe, and wipe number 301 is a “plasma” wipe — 
give them a try!

This completes the procedure to select a Wipe.

1 2 3 4 5 6 7 8 9 10

11 12 13 14 15 16 17 18 19 20

21 22 23 24 25 26 27 28

200 202 203 204 205201 206 207 208 209

210 211 212 213 214 215 216

300 301
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Optional Squeeze & Tease 2D Wipes 
If your Synergy 100 switcher has the optional Squeeze & Tease 2D Board installed, you have access 
to 40 DVE wipe effects, such as push-offs, pull-ons and other similar DVE transitions.

Optional Squeeze & Tease 2D Wipes

DVE Wipe Effects
The 10 pattern buttons in the Effects Control Group represent 10 DVE wipe effects, as represented 
in the following figure in order of buttons. 

Effects Control Group – 10 DVE Wipe Effects

Note The numbers under the wipe patterns indicate the pattern number as 
selected using the System Control Group.

The graphical representations of the wipes do not correspond with the 
patterns on the actual keys in the Pattern Control Group.

00 01 02 03 04 05 06 07 08 09

10 11 12 13 14 15 16 17 18 19

24 25 26

30 31 32

22 23

34 35 36 37

29

38

2120 27 28

33 39

004 006 022 010

002 000 009 033 020

027
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Using Wipes
In a “background wipe” transition, the PGM bus video is gradually replaced with the PST bus video 
according to a wipe pattern pre-selected in the Effects Control Group. 

The following topics are discussed in this section:

• Performing a Wipe

• Selecting Wipes 

Performing a Wipe
Use the following procedure to perform a wipe:

1. Select an input on the PGM bus. 

2. Select a different input on the PST bus.

3. In the Transition Control Group, select BKGD as the next transition. 

The following figure illustrates a sample setup and the associated monitor outputs — 
before the wipe.

MLE and Monitor Setup – Before the Wipe

4. Press WIPE. This action causes the lamp on the WIPE button to illuminate green and 
automatically assigns the Effects Control groups to the transition.

5. Press the pattern button for the desired wipe.

6. Choose the direction for the wipe. Select between normal, reverse, or flip-flop by 
pressing or double-pressing the REV/LEARN button.

7. Turn the BORDER knob fully clockwise, then fully counterclockwise. For this first 
exercise, this ensures that there is no border.

8. Perform a transition using one of the following methods:

• To perform a manual transition, move the Fader from limit to limit. 
• To perform an auto transition, press the AUTO TRANS button. 
During the transition, the PST bus video signal gradually replaces the PGM signal using 
the selected wipe, as the following figure illustrates.

Preview Monitor Program Monitor

PST BLACK

PGM BLACK
CAM

1

CAM
1

CAM
2

VTR
1

VTR
2

VTR
3

CAM
2

VTR
2

VTR
3

INS KF OVR KF DEL KF KF DUR TOSTART TOEND

Aux PV Aux Clean Aux PGM

POSN BORDER PREPROC LIGHT OBJ BLD STILLS

VTR
1
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MLE and Monitor Setup – Performing a Transition

At the end of the transition, the PST video completely replaces the PGM video and the 
buses flip-flop. The following figure illustrates the MLE and monitor setup after the 
wipe.

.
MLE and Monitor Setup – After the Wipe

This completes the procedure to perform a wipe.

Selecting Wipes 
Use the following procedure to select a Wipe:

1. Press WIPE in the Transition Control Group. The lamp on the button will illuminate 
green.

2. To choose one of the 10 patterns as shown in the Effects Control Group, simply press 
the desired button. 

3. To access the additional user wipe patterns, double press any of the pattern buttons. The 
selected LED will flash, and the current “extended wipe” pattern number will be 
displayed in the System Control Group.

4. You will now have control of the System Control Group, and can use the 100, 10, and 
1 buttons to scroll through the patterns as desired. Refer to the following figure: 

Note Wipe borders can be modified to be any matte color. Refer to the 
section “Mattes Group” on page 6-16 for details.
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System Control Group

The first (hundreds) digit in the display represents the “class” of wipe. The classes of 
wipes are as follows:

0. classic wipes 
1. rotary wipes
2. matrix wipes
3. special wipe

5. Use the 100 button below the display to scroll through the classes. The 10 and 1 buttons 
are used to scroll through the wipe pattern numbers, represented by the last two (tens and 
units) digits in the display. 

6. Once you have selected the desired pattern, you can perform your transition in the usual 
manner.

This completes the procedure to select a Wipe.

Selecting a DVE Wipe Effect
Use the following procedure to select a DVE wipe effect:

1. Press DVE in the Transition Control Group. The DVE button illuminates green 
indicating that the transition is active.

2. Select a DVE Wipe effect by pressing the one of the 10 pattern buttons in the Effects 
Control Group represent 10 DVE wipe effects.

3. To gain access to all 40 DVE wipe patterns, double press any of the pattern buttons in 
the Effects Control Group. The selected LED will flash, and the DVE function will 
have control of the System Control Group. 

Operating
Tip

As an alternative, the DVE and WIPE buttons can be pressed 
simultaneously to select a DVE effect as the transition type. Both the 
DVE and WIPE buttons illuminate green indicating that the transition 
is active.

Note The numbers under the wipe patterns indicate the pattern number as 
selected using the System Control Group.

The graphical representations of the wipes do not correspond with the 
patterns on the actual keys in the Pattern Control Group.

SYSTEM  CONTROL

MENU SEL

EDIT

BACK

100 10 1

MODE

WIPE
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4. Use the 10 and 1 buttons to scroll through the patterns as desired. Refer to the following 
figure. 

System Control Group

5. Use the 10 and 1 buttons are  to scroll through the Squeeze & Tease 2D Wipes numbers, 
represented by the last two digits in the display.  

6. Once you have selected the desired pattern, you can perform your transition in the usual 
manner.

This completes the procedure to select a DVE wipe effect.

Notes on Selecting a Squeeze & Tease Wipe
Please note:

• When enabled, the Squeeze & Tease Wipe mode selects a free channel or two free 
channels as required. If channels are not available, you can not select a Squeeze & 
Tease wipe. 

• You can perform a Squeeze & Tease wipe on the background or an individual key, by 
pressing either the BKGD, KEY1, or the KEY2 button in the Transition Control 
Group. However, you can not select more than one at a time. 

• Background (BKGD) and key (KEY1 or KEY2) transitions only require one Squeeze 
& Tease channel to perform a Squeeze & Tease wipe. However, wipes involving Auto 
Select keys require two channels.

• If you want to perform a Squeeze & Tease wipe on the key, for example, and the Effects 
Keyers Group is already performing a Squeeze & Tease 2D box, the Squeeze & Tease 
wipe is allowed. If the keyer is not performing a Squeeze & Tease box, the system 
temporarily borrows a single Squeeze & Tease channel (or two channels if you are 
performing the wipe on an Auto Select key).

Note If your Synergy 100 switcher has the optional Squeeze & Tease 
WARP Board installed, you have access to 100 pre-programmed 
2-dimensional and 3-dimensional DVE wipe effects. Refer to the 
Squeeze & Tease 3D/WARP Owner’s Guide for full details.

SYSTEM  CONTROL

MENU SEL

EDIT

BACK

100 10 1

MODE

DVE
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Mattes Group
The Mattes Group provides a set of assignable controls that allow you to select specific matte 
generators and adjust colors for wipe patterns, borders, the color background, and matte fills. The 
Mattes Group is assigned to a specific function by pressing a PST PATT, WIPE, COLOR BKGD, 
BORD or MATTE FILL button. 

The following figure illustrates the Mattes Group: 

Mattes Group

1. Matte Color Knobs 

The three Matte Color Knobs allow you to adjust the color of the selected matte 
generator. Each knob is an “end-stop” knob. Refer to the section “Knobs” on page 4-7 
for additional information on end-stop knobs.

• Hue is the characteristic of a color signal that determines whether the color is red, 
yellow, green, blue, etc. Adjust the HUE knob to change the color of the selected 
matte generator. A full 360 degrees of hue adjustment is provided.

• Saturation is the intensity of the color. Adjust the SAT knob to change the color 
saturation of the selected matte generator. Saturation can be adjusted from 0 
(monochrome or no saturation) to 100 percent — full color saturation.

• Luminance is the component of the signal that represents the brightness in a video 
picture. Adjust the LUM knob to change the luminance of the selected matte 
generator. Luminance can be adjusted from 0 (minimum brightness, or black) to 100 
percent (maximum brightness, or white). 

2. Matte Destination Section 

1) Matte Color Knobs 2) Matte Destination Section

MATTES

MATTES

HUE/
TRANSP

GAIN

SEL

MODE

BKGD

HUE

SAT

LUMCLIP

1

2

DVE

HUE
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The SEL button in the Matte Destination Section allows you to select one of five 
standard and two optional matte generators. Each generator is capable of generating one 
color. The generators are selected automatically (as outlined below) or they can be 
selected manually. 

• Press SEL in the Mattes Group and scroll through the seven options until BKGD 
appears in the display. This matte generator is automatically selected when the 
COLOR BKGD buttons on the bus rows are pressed.
When BKGD is selected, you can adjust the selected COLOR BKGD color using 
the three Matte Color knobs. 

• Press SEL in the Mattes Group and scroll through the seven options until WIPE 
appears in the display. This matte generator is automatically selected when the 
WIPE button in the Transition Control Group is pressed.
When WIPE is selected, you can adjust the selected wipe border color using the 
three Matte Color knobs. 

• Press SEL in the Mattes Group and scroll through the seven options until DSK 
appears in the display. This matte generator is used by the Downstream Keyer’s 
matte fill and optional border and shadow generator. It is automatically selected 
when the following buttons are pressed:
~ Any of the buttons in the Downstream Keyer Group.

When DSK is selected, you can adjust the downstream key’s matte fill color and, if 
you have the Border Generator option installed, the downstream key’s border 
color using the three Matte Color knobs. Refer to the section “Bordering Keys” on 
page 7-25 for more information.

• Press SEL in the Mattes Group and scroll through the seven options until KEY1 
appears in the display. This matte generator is used by the Effects Keyers Key 1’s 
matte fill. It is automatically selected when the following buttons are pressed:
~ Any of the buttons relating to Key 1 in the Effects Keyer Group except PST 

PATT.

When KEY1 is selected, you can adjust the matte fill color of the Effects Key 1, 
using the three Matte Color knobs. 

• Press SEL in the Mattes Group and scroll through the seven options until KEY2 
appears in the display. This matte generator is used by the matte fill of the Effects 
Keyers Key 2. It is automatically selected when the following buttons are pressed:
~ Any of the buttons relating to Key 2 in the Effects Keyer Group except PST 

PATT.

When KEY2 is selected, you can adjust the matte fill color of Effects Key 2 using 
the three Matte Color knobs. 

Note The default COLOR BKGD color is blue. 

Note If PST PATT is selected in the Effects Keyers Group, you can not 
select MATTE FILL.

SEL

DVE
Synergy 100 Operation Guide (v16.10-S100) Pattern and Effects Control • 6–17



• Press SEL in the Mattes Group and scroll through the seven options until S&T1 
appears in the display. This matte generator is used by the optional Squeeze & 
Tease 2D Board and Squeeze & Tease WARP Board for adjusting the color of the 
border around a Squeeze & Tease box. It is automatically selected when the PST 
PATT button for Keyer 1 in the Effects Keyers Group is pressed.
When S&T1 is selected, you can adjust the Effects Key 1 Squeeze & Tease box’s 
border color using the three Matte Color knobs. 

• Press SEL in the Mattes Group and scroll through the seven options until S&T2 
appears in the display. This matte generator is used by the optional Squeeze & 
Tease 2D Board and Squeeze & Tease WARP Board for adjusting the color of the 
border around a Squeeze & Tease box. It is automatically selected when the PST 
PATT button for Keyer 2 in the Effects Keyers Group is pressed.
When S&T2 is selected, you can adjust the Effects Key 2 Squeeze & Tease box’s 
border color using the three Matte Color knobs. 
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Keying

In This Chapter
This chapter provides instructions for using the switcher keys of your Synergy 100 SD. The following 
topics are discussed:

• Introduction to Keying

• Effects Keyers Group

• Downstream Keyer Group

• A Word About Clean Feed

• Performing a Self Key

• Performing an Auto Select Key

• Performing a Chroma Key

• Chroma Key Lighting Tips

• Performing a Preset Pattern Key

• Performing Squeeze & Tease Boxes

• Split Keys

• Programming a Favorite CG

• Using Auto Transitions

• Using Key Modifiers 

• Filling a Key with Matte

• Masking Keys 

• Inverting Keys

• Bordering Keys

• Flying Keys

• Positioner  
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Introduction to Keying
The “Keying” function allows you to insert (or electronically “cut”) portions of one scene into another 
or to place titles over background images. Two signals are essentially required for a key:

• The “key” signal (also known as an alpha signal) is used to electronically cut a hole in 
the background video.

• The “fill” signal (also known as the key foreground) is used to electronically fill the key 
signal’s hole with video.

Visually, keys appear as layers that can be built up to create the desired composite image. The MLE 
can generate three individual keys that appear downstream of the background images. 

Refer to the section “Video Flow through the Switcher” on page 2-6 for additional information on 
basic video flow, MLE priority and layering.

Key Group Basics
The Synergy 100 panel includes two Key groups — the Effects Keyers Group and the 
Downstream Keyer Group. Please note the following basic rules regarding the two key groups:

• For all key types (except Preset Patterns) the Key Bus is used to select key alpha and 
fill sources. Even though the buttons on the Key Bus are shared between the three 
Keyers, three sets of independent keying electronics allow each keyer to have its own 
key and fill selections. For Preset Pattern keys, the alpha signal is chosen by selecting a 
wipe pattern in the Effects Control Group.

• Functionally, the range of patterns available for a Preset Pattern key on Key 2 of the 
Effects Keyers Group is restricted to the classic patterns, minus the circle. On the other 
hand, the Wipe Generator, that is also used for a Preset Pattern key on Key 1 of the 
Effects Keyers Group, is full-featured — all wipe patterns are available.

Effects Keyers Group
The controls in the Effects Keyers Group allow you to choose Key types and a variety of key 
modifiers. The following topics are discussed in this section:

• Key Type Section

• Key Modifier Section

• Key Assignment Section

The figure  on page 7-3 illustrates the Effects Keyer Group. 
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Effects Keyers Group

1. Key Type Section

The Key Type Section provides four buttons that select the type of key that will be 
inserted over background video.

• Press SELF KEY to select a “Self” key type, also known as a luminance key. With 
a Self Key, the luminance (or brightness) values of the key source itself (as selected 
on the Key Bus) are used to cut the hole.
The key hole is filled with the same video signal as the key cutter. The key hole can 
also be filled with color matte. Self Keys are often used to key images from tape as 
there is no separate alpha available.

• Press AUTO SELECT to choose an “Auto Select” key type, also known as a linear 
key.
With Auto Select keys, two signals are used to cut and fill the hole — a key (alpha) 
signal and a fill (video) signal. These signals originate from devices such as 
character generators, still stores, DVEs, and graphics systems.

When you choose an Auto Select key and press a key source (on the Key Bus), the 
switcher automatically selects both the alpha and fill signals. These signals were 
linked together during the installation procedure. Refer to the section, “Setting Up 
BNC Inputs” in Chapter 6 of the Synergy 100 Installation Guide for details.

• Press CHROMA KEY to select a “Chroma” key type. With a Chroma Key, the hole 
is cut based on a selected color value (hue), rather than on a luminance value or an 
alpha signal. The color is then electronically removed and replaced with 
background video from another image.
Similar to Self Keys, the Chroma Key hole is filled from the same video source as 
the key cutter, except that the fill is composed of all colors that remain after the 
selected chroma key color is removed. The hole can also be filled with color matte. 
Chroma Keys are typically used to key the weathercaster over a weather map.

1) Key Type Section 2) Key Modifier Section 3) Key Assignment Section
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If your switcher has the optional Ultimatte™ Insider installed, refer to Chapter 10 
“Ultimatte Insider” on page 10-1 for complete operational instructions.  

• Press PST PATT to select a “Preset Pattern” key type. If you have installed the 
optional Squeeze & Tease 2D Board or Squeeze & Tease WARP Board, this 
action will automatically turn on the FLY KEY button (in the Key Modifier 
Section), and apply a 2-D or 3-D box effect to the key. 
Refer to the section “Performing Squeeze & Tease Boxes” on page 7-17 for 
information on Squeeze & Tease 2D. For information on Squeeze & Tease WARP, 
refer to the Squeeze & Tease 3D/WARP Owner’s Guide.

For a standard Preset Pattern key, the hole is cut based on a pattern that you select in 
the Effects Control Group. The pattern (which acts just like the auto select key’s 
alpha signal) is filled with video from the Key Bus.

2. Key Modifier Section 

The buttons and knobs in the Key Modifier Section allow you to modify the key that is 
currently selected. 

• Press KEY INVERT to invert the polarity of the selected key signal. For example, if 
a Self Key source has white letters on a black background, the white letters 
normally cut the hole. When KEY INVERT is pressed, the polarity of the signal is 
reversed and the black background cuts the hole. This function is often used to key 
black text that is printed on a white background. 
Note that all key types can be inverted, except the optional Squeeze & Tease boxes.

• Press MASK to activate the Mask controls. These controls allow you to selectively 
eliminate unwanted portions of a key signal, similar to the “crop” function found on 
many DVEs. Using an adjustable box pattern, you can size and position the mask to 
hide the top, bottom, left or right edges of the key.
In addition, the REV/LEARN button in the Effects Control Group can be used to 
invert the mask. All key types except Preset Pattern keys and Squeeze & Tease 
boxes can be masked. Refer to the section “Masking Keys” on page 7-24 for 
information and instructions. 

• Press FLY KEY to enable or disable the Squeeze & Tease 2D or Squeeze & Tease 
WARP function, allowing you to apply 2-D or 3-D DVE effects to any of the four 
key types. The button illuminates automatically when PST PATT is pressed, but 
must be pressed manually to fly a CHROMA KEY, AUTO SELECT or SELF 
KEY.
Once enabled, you can control the flying image’s size, horizontal and vertical 
position and much more. The FLY KEY button will not illuminate if one of the 
options is not installed. Refer to the section “Flying Keys” on page 7-27 for 
instructions. If you have the Squeeze & Tease WARP option installed, refer to the 
Squeeze & Tease 3D/WARP Owner’s Guide for instructions.

Note Unlike analog switchers that require separate RGB signals to perform a 
Chroma Key, with the Synergy 100 Switcher, you can Chroma Key on 
any source that you select on the Key Bus. 

Operating
Tip

Pressing the button that is currently lit in the Key Type Section is a 
quick way to simply activate a keyer for adjustment, when both keyers 
are in use.

PST
PATT

KEY
INVERT

MASK

FLY
KEY
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• Press MATTE FILL to fill the selected key hole with a matte color — instead of the 
key foreground video from the Key Bus. All key types except Preset Pattern keys 
can be filled with matte color. Use the controls in the Mattes signal’s  to choose the 
matte’s hue, luminance, and saturation. Refer to the section “Mattes Group” on 
page 6-16 for matte fill instructions.

• The HUE/TRANSP knob has two functions. 
~ With a Chroma key, it is used to select the color that you want to key out – 

essentially, the color to be replaced by the background video. The knob rotates 
through the full 360-degree color spectrum.

~ If you setting up a Self Key or Auto Select Key, the HUE/TRANSP knob is 
used to adjust the key’s transparency.

• Rotate CLIP to adjust the key’s luminance or threshold level. Only the areas of the 
source video that are higher than the setting of the threshold will cut a hole in the 
background video.

• Rotate GAIN to adjust the key’s gain. The control acts on all keys (except the 
optional Squeeze & Tease boxes) and softens the key edge, allowing you to adjust 
the way that the key blends into the background. 

3. Key Assignment Section 

The button in the Key Assignment Section allows you to toggle control of all key 
modifiers between the two keys in the Effects Keyers Group. 

• Press KEY2 to assign control of all the key modifier buttons and knobs to the 
Effects Keyers’ second key. This action will cause the button to illuminate. 

• To return control of all modifiers to the Effects Keyers’ Key 1, simply press the 
KEY2 button again to turn it off. 

This completes the discussion on the Effects Keyers Group.

Downstream Keyer Group
This section outlines the areas of the Downstream Keyer Group. 

The following topics are discussed:

• Key Type Section

• Key Modifier Section

• Border Controls

• DSK PV Button

The figure on on page 7-6 illustrates the Downstream Keyer Group.
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Synergy 100 Downstream Keyer Group

1. Key Type Section

The Key Type Section provides two buttons that select the type of key that will be 
inserted over background video. 

• Press SELF KEY to select a “Self” key type, also known as a luminance key. With 
a Self Key, the luminance (or brightness) values of the key source itself (as selected 
on the Key Bus) are used to cut the hole. 
The key hole is filled with the same video signal as the key cutter or the hole can 
also be filled with color matte. Self Keys are often used to key images from tape.

• Press AUTO SELECT to choose an “Auto Select” key type, also known as a linear 
key. 
With Auto Select keys, two signals are used to cut and fill the hole — a key (alpha) 
signal and a fill (video) signal. These signals originate from devices such as 
character generators, still stores, DVEs, and graphics systems.

When you choose an Auto Select key and press a key source (on the Key Bus), the 
switcher automatically selects both the alpha and fill signals. These signals were 
linked together during the installation procedure. Refer to the section “Setting Up 
BNC Inputs” in Chapter 6 of the Synergy 100 Installation Guide for details.

In addition to these buttons, there are two buttons used as hotkeys for your “favorite” 
auto select keys originating from character generators, still stores, DVEs, etc.

• Press CHAR GEN1 to select your most frequently used “favorite” auto select key, 
without having to hunt for it on the Key Bus. When pressed, the key type and key 
source are automatically selected, KEY MEM is turned on and key modifiers are 
turned off to provide a clean CG key. Refer to the section “Programming a 
Favorite CG” on page 7-20 for instructions. 

• Press CHAR GEN2 to choose an alternate frequently used “favorite” auto select 
key. This button works in the exact same manner as CHAR GEN1, and is also 
programmed as per the section “Programming a Favorite CG” on page 7-20.

1) Key Type Section
2) Key Modifier Section

3) Border Controls
4) DSK PV Button
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2. Key Modifier Section

The buttons and knobs in the Key Modifier Section allow you to modify the key that is 
currently selected. 

• Press KEY INVERT to invert the polarity of the selected key signal. For example, if 
a Self Key source has white letters on a black background, the white letters 
normally cut the hole. When KEY INVERT is pressed, the signal’s polarity is 
reversed and the black background cuts the hole. This function is often used to key 
black text that is printed on a white background. Note that all key types can be 
inverted.

• The KEY MEM (memory) function applies to Auto Select Keys only. This function 
allows you to store and recall one set of clip and gain settings per crosspoint. 
The KEY MEM button turns on automatically when you press AUTO SELECT 
and choose an Auto Select key source on the Key Bus. This function recalls the 
key’s settings from memory. With the button lit, clip and gain settings are locked. If 
you press KEY MEM to turn off the light, you unlock clip and gain, allowing you to 
make temporary adjustments to the linear key’s settings. Turning the button back on 
again restores the key source’s default settings from memory.

Although the default clip and gain settings were set during the switcher installation 
process, you can also use the KEY MEM button to store new default values for the 
selected linear key source. Refer to the section “Performing an Auto Select Key” 
on page 7-11 for details.

• Press MASK to activate the Mask controls. These controls allow you to selectively 
eliminate unwanted portions of a key signal, similar to the “crop” function found on 
many DVEs. Using an adjustable box pattern, you can size and position the mask to 
hide the top, bottom, left or right edges of the key. 
In addition, the REV/LEARN button in the Effects Control Group can be used to 
invert the mask. Both key types can be masked. Refer to the section “Masking 
Keys” on page 7-24 for information and instructions. 

• Press MATTE FILL to fill the selected key hole with a matte color — instead of the 
key foreground video from the Key Bus.   Both key types can be filled with matte 
color. Use the controls in the Mattes Groups to choose the matte’s hue, luminance, 
and saturation. Refer to the section “Mattes Group” on page 6-16 for matte fill 
instructions.

• Rotate CLIP to adjust the key’s luminance or threshold level. Only the areas of the 
source video that are higher than the setting of the threshold will cut a hole in the 
background video.

• Rotate GAIN to adjust the key’s gain. This control softens the key edge, allowing 
you to adjust the way that the key blends into the background. For Auto Select 
(linear) keys, the adjustment ensures the correct key transparency.
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3. Border Controls

• Press BORD to add a border behind the selected key type. The border can appear as 
a simple surrounding border or as a detached shadow. Width, softness, color, and 
transparency are adjustable using the appropriate knobs in the Effects Control and 
Mattes Groups. Refer to the section “Bordering Keys” on page 7-25 for 
instructions.

• Press SHDW to add a drop shadow behind the selected key type, with variable 
width, softness, color, and transparency. Refer to the section “Bordering Keys” on 
page 7-25 for instructions.

• Press OUTL to add an outline around the selected key type, with variable width, 
softness, color, and transparency. With OUTL selected, the key fill is completely 
transparent. Refer to the section “Bordering Keys” on page 7-25 for instructions.

4. DSK PV Button

• Press and hold DSK PV to set up and adjust your downstream keyer effect by 
watching the preview monitor. If the DSK is not currently on air, the preview 
monitor will show the downstream keyer effect superimposed on top of the Program 
output. If the DSK is currently on air, the preview monitor will display the Program 
output without the DSK.            

This completes the discussion on the Downstream Keyer Group.

A Word About Clean Feed
If you have the Clean Feed Option installed, your program output may be set up in a special mode 
using the Outputs Menu. Please consult with your facility engineer to determine how your switcher 
is configured. 

The Clean Feed output can be generated from different locations in the video path. The Clean Feed 
alpha output can be derived from any key type on Key 1. Refer to the “Setting Up Outputs” section 
in Chapter 8 of the Synergy 100 Installation Guide for full details. The point from which the feed is 
derived is software-configurable. Refer to the diagram on page 7-9. 

Note The Floating Border Generator option must be installed to enable 
border control operation.

Borders are available in all keyers. Refer to the section “Bordering 
Keys” on page 7-25, for details.

Important The DSK PV function is not available when Key 1 or Key 2 have a 
border applied, and are on air.

Note The DSK PV button is active only as long as the button is held down. 
When released, the preview monitor once again displays the Preview 
output (based on the “Next Transition” buttons selected) and the 
button’s LED turns off. 
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PV
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Clean Feed Modes

1. At point 1 above, the clean feed output is pulled after the Program/Preset Bus, but before 
the three keys are added.

2. At point 2 above, the clean feed output is pulled downstream of the two Effects Keyers, 
but upstream of the DSK.

3. At point 3 above, the clean feed output is pulled downstream of the three Keyers and 
effectively mirrors the program output.
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EFFECTS
KEY1
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CLEAN
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Using Keys
This section includes detailed instructions for using keys. Prior to proceeding, ensure that you have 
read the section “Introduction to Keying” on page 7-2 thoroughly. 

Performing a Self Key
A Self Key is one in which the luminance (or brightness) values of the key source itself are used to cut 
the hole. 

Use the following procedure to perform a Self Key in Key 1: 

1. Select a background source on the PGM bus. This provides the background over which 
the key will appear.

2. Press KEY1 in the Transition Control Group to preview the key. This step will also 
server to assign the Key bus and Effects Keyers Group to Key 1.

3. Select a key source on the Key 1 bus.

4. Press SELF KEY in the Effects Keyers Group.

5. Adjust the Clip and Gain of the key as follows:

• Use the CLIP knob in the Effects Keyers Group to adjust the luminance level of 
the key. The lower the threshold setting, the more the key is visible.

• Use the GAIN knob in the Effects Keyers Group to adjust softness of the edges of 
the key.

6. Select any additional key modifiers you want to use. You can select between the 
following:

• MATTE FILL — Select this button to fill the hole cut by the clip and gain of the 
source with a matte color.

• KEY INVERT — Select this button to invert the key polarity of the hole cut by the 
clip and gain of the source.

• MASK — Select this button to activate the mask feature and mask out a rectangular 
part of the source video.

• Border Effects  — Select these effects to add borders, shadows and outlines to your 
key.

7. Perform a CUT, AUTO TRANS, or move the fader from one limit to the other to take 
your Self Key on-air. 

This completes the procedure to perform a Self Key in Key 1.

Note This procedure will show you how to perform a Self Key in Key 1, the 
same procedure can be used to perform a Self Key in Key 2 or DSK.

Note If you select a different Self Key source, you will need to re-adjust the 
Clip and Gain of the source. However, each crosspoint will remember 
its own individual clip and gain setting.
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Performing an Auto Select Key
An Auto Select (or “linear”) Key is one in which two signals are used to cut and fill the hole — a key 
(alpha) signal and a fill (video) signal. These signals originate from devices such as character 
generators, still stores, DVEs, and graphics systems.

Use the following procedure to perform an Auto Select Key in Key 2:

1. Select a background source on the PGM bus. This provides the background over which 
the key will appear.

2. Press KEY2 in the Transition Control Group to preview the key. This step will also 
serve to assign the Key bus and the Effects Keyer Group to Key 2.

3. Select a key source on the Key 2 bus.

4. Press AUTO SELECT in the Effects Keyers Group.

5. Select any additional key modifiers you want to use. You can select between the 
following:

• MATTE FILL — Select this button to fill the hole cut by the clip and gain of the 
source with a matte color.

• KEY INVERT — Select this button to invert the key polarity of the hole cut by the 
clip and gain of the source.

• MASK — Select this button to activate the mask feature and mask out a rectangular 
part of the source video.

• Border Effects — Select these effects to add borders, shadows and outlines to your 
key.

6. Perform a CUT, AUTO TRANS, or move the fader from one limit to the other to take 
your Auto Select Key on-air.

This completes the procedure for performing an Auto Select Key in Key 2. 

Storing New Clip and Gain Settings
If the KEY MEM button is off, you can adjust the clip and gain settings of the key on a temporary 
basis. In this mode, if you want to permanently store the new clip and gain settings, use the following 
procedure. This procedure re-locks the clip and gain values, and stores the new settings in memory. 

1. Ensure that the KEY MEM button is toggled Off.

2. Adjust clip and gain for the desired appearance.

3. Press and hold the AUTO SELECT button.

4. Press KEY MEM.

5. Release both buttons.

Operating
Tip

If you are setting up an Auto Select Key in the Effects Keyer Group, 
you can adjust the Clip and Gain as needed. In the Downstream Keyer 
Group you will have to toggle the KEY MEM button Off before you 
will be able to adjust the Clip and Gain as needed.

Important There is no undo function. If you re-store clip and gain, you cannot 
recall previous values unless you recall settings from memory. Refer to 
the section “Storing Memory Registers” on page 8-3 for information.
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Performing a Chroma Key
A Chroma Key is one in which the hole is cut based on a color value (hue), rather than on a 
luminance value or an alpha signal. The color is electronically removed and replaced with background 
video from another image. You can Chroma Key on any source selected on the Key Bus. 

Use the following procedure to perform a Chroma Key in Key 1: 

1. Select a background source on the PGM bus. This provides the background over which 
the key will appear.

2. Press KEY1 in the Transition Control Group to preview the key. This step will also 
serve to assign the Key bus and Effects Keyers Group to Key 1.

3. Select the key source on the Key 1 Bus.

4. Press CHROMA KEY in the Effects Keyers Group. This action causes the following 
to occur:

• The auto chroma key function is activated and crosshairs appear on the preview 
output.

• The switcher presets a transition to the source selected on the key bus. If a key is on 
but its “next transition” button is not lit, the switcher automatically illuminates the 
button for you.

5. Use the positioner to place the crosshairs on top of the color you want to key out. 

• You will notice that the right-most four-character mode display in the System 
Control Group reveals the text “Grab”. 

6. Press the associated SEL button. 

7. Adjust the clip, gain, and hue as follows:

• Use the CLIP knob in the Effects Keyers Group to adjust the clip threshold. The 
lower the threshold setting, the more key is visible. 

• Use the GAIN knob in the Effects Keyers Group to adjust the softness of the edges 
of the key.

• Use the HUE/TRANSP knob in the Effects Keyers Group to select the color (hue) 
that you want to remove.

8. Adjust the Chroma suppression and rejection as follows:

• Press and hold CHROMA KEY and rotate the SAT knob in the Mattes Group to 
adjust chroma suppression.

• Press and hold CHROMA KEY and rotate the HUE knob in the Mattes Group to 
adjust the chroma rejection (hue selectivity).

Refer to the section “Chroma Key Tips” on page 7-13 for a basic sequence of steps for 
clipping Chroma Keys.

9. Select any additional key modifiers you want to use. You can select between the 
following:

Note If there are flaws and blemishes in the Chroma Key set’s background, 
they will appear as shadows. Normally, a superb set with careful 
lighting is required for natural Chroma Key shadows. Refer to the 
section “Chroma Key Lighting Tips” on page 7-14 for tips on 
lighting Chroma Key sets.
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• MATTE FILL — Select this button to fill the hole cut by the clip and gain of the 
source with a matte color.

• KEY INVERT — Select this button to invert the key polarity of the hole cut by the 
clip and gain of the source.

• MASK — Select this button to activate the mask feature and mask out a rectangular 
part of the source video.

10. Perform a CUT, AUTO TRANS, or move the fader from one limit to the other to take 
your Chroma Key on-air.

This completes the procedure for performing a Chroma Key in Key 1. The same procedure is applied 
to performing a Chroma Key in Key 2.

Chroma Key Tips
Adjusting a Chroma Key is an iterative process. To achieve the best looking key, you must adjust a set 
of parameters and then return to those parameters for subsequent adjustment — after other values 
have been set. 

Use the following procedure to modify your Chroma Key in Key 1:

1. Press CHROMA KEY.

2. Press KEY1 in the Transition Control Group.

3.  Select a Key source on the Key 1 Bus.

4. Ensure KEY INVERT is turned off.

5. Turn GAIN to zero by rotating the GAIN knob all the way to the right (clockwise), and 
then all the way to the left (counter clockwise).

6. Set the CLIP very low to a point where you see a prominent change on screen, even if 
only portions of the background are clipped out — and even if those portions are the 
incorrect color.

7. Rotate the HUE/TRANSP knob until you begin to see the proper color key out 
(typically blue or green). 

• Note that position and continue turning until you move beyond that hue to another 
color. 

• Rotate the HUE/TRANSP knob back and position the knob in the center of this 
range — finding the spot where the maximum amount of the proper color is keyed 
out.

8. Re-adjust CLIP to the maximum value possible — without bringing in shadows and 
other defects in the chroma key set.

9. Adjust GAIN to the maximum value possible — without making the key transparent and 
without bringing in the background. Getting the highest possible gain is essential for 
obtaining clean, smooth edges. 

Operating
Tip

Select MATTE FILL and fill the key with white. This will make clip 
and gain setup errors visible.

Operating
Tip

If you cannot get the edges smooth without bringing in the 
background, try reducing the clip slightly — and then increasing the 
gain slightly.
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10. Turn off MATTE FILL if you turned it on, and select the desired background for your 
key on the Preset bus.

11. Perform a CUT, AUTO TRANS, or move the fader from one limit to the other to take 
your Chroma Key on-air.

This completes the procedure to modify a Chroma Key in Key 1. The same procedure is applied to 
modifying a Chroma Key in Key 2.

Chroma Key Memory
Unlike Self keys, Chroma keys do not retain the clip and gain values with each crosspoint. Instead, 
there is only one set of values associated with the entire switcher at a given time. Therefore, each time 
you change the source of the Chroma Key, you will have to re-clip the key as outlined above.

Chroma Key Lighting Tips
Achieving a good, clean chroma key is often considered one of the most challenging exercises in a 
studio. There are several elements that contribute to an effective chroma key including, lighting, 
distance of the talent from the background, type of background used, and the type of camera used. 
However, lighting is often considered the most important. Here are a few lighting hints which you 
may find helpful when setting up your chroma key. 

Lighting the Background
• There are several different kinds of lights typically used to light chroma key 

backgrounds. The most common are, cyclorama lights, soft lights, scoops, florescent 
lights, HMIs, and umbrella lights.

For the most part, the one thing that they all have in common is the fact that they are 
“fill” type lights, as opposed to “key” lights. These lights provide an even, diffused, flat 
light, which is critical in lighting chroma key backgrounds. 

• For best results, lights are usually hung in an even pattern from a grid above the 
background but space requirements may dictate the lights be positioned on stands beside 
the background. If side lighting is used, ensure the lights are positioned at equal 
distances from the background being lit, in order to achieve balance.

• The number of lights used to light a background is directly related to the size of the 
background surface. Therefore, a larger, longer surface requires more lights than a 
smaller one. But whatever size of surface you are lighting, the most important point to 
remember is the background should be lit as evenly as possible to avoid “hot spots” in 
the chroma key.

• When lighting the background, experienced lighting directors will first of all eyeball the 
background for hot spots, adjusting and readjusting the lights, but then check their work 
using either a waveform monitor or a photographer’s light meter. Waveform monitors 
are most useful since they display a graphical representation of the video level and any 
small variation in light level is immediately apparent. On the other hand, a light meter in 
the hands of an experienced professional can achieve the same results.

• Generally speaking, the best chroma key results are achieved with an even level of light 
on the background in the area of 60 – 75 IRE on a waveform monitor. However, 
conditions specific to your application may dictate a value outside of that range.

• If you only have access to key type lights, you can simulate the effect of fill lights by 
bouncing a key light off of a reflector and then on to the chroma key background. 
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Alternatively, you can use diffused glass, gels, or scrims to soften the light from a key 
light. If you use any of these methods it’s important to note that you will lose a 
significant amount of the original light intensity. Therefore, it takes more lights to reach 
the optimum IRE level required for a good chroma key. 

Lighting the Foreground (Talent)
• You can maximize the quality of your chroma key if you separate the foreground (talent) 

from the background by 6 – 8 feet. This enables you to light the foreground and the 
background separately, thus reducing or avoiding “spill” and/or shadows. 

Separation also allows you more flexibility in how you light your talent. You may still 
choose to use a flat lighting technique, but with separation, the option exists to light your 
talent using a more dramatic 3-light, “Rembrandt style of lighting”, typically used in 
other lighting applications. This style is characterized by 3 lights – a key, a fill, and a 
back light.

• If spill does occur between the background and the foreground, a blue “halo” or “matte 
line” appears around the talent’s shoulders and hair. This can be reduced or eliminated 
by using a yellow, straw, or amber colored light for the talent’s back light. It will wash 
out or neutralize the blue reflection from the background on the back of the talent. (Note: 
this technique is not applicable to Ultimatte, as Ultimatte has circuitry designed to 
remove blue spill.)

• As a general rule, it is good practice to light the foreground and the background to 
approximately the same IRE levels but this is often varied when dramatic lighting effects 
are required for the talent. 

• And finally, be careful not to mix lights with different color temperatures on the same set 
(either foreground or background). The human eye and brain are able to deal with the 
subtle differences in color temperatures but cameras aren’t nearly that smart. If you must 
use lights with different color temperatures, make sure you use colored gels to 
compensate for the differences. Otherwise, you may experience holes in your chroma 
key that will be very difficult to remove. 

Additional Chroma Key Tips and Considerations
Along with lighting, there are a number of other studio elements that should be taken into account 
when setting up your chroma keys. They include, the background material itself, the camera and its 
setup, keying from a prerecorded signal on VTR, and using compressed video sources.

• Green and blue are the two most common colors used for chroma keying backgrounds 
and are equally effective. Blue was initially chosen because it is the complimentary 
color to flesh tone and, therefore, the easiest to key out (we don’t want to key out the 
faces, do we …). Given today’s technology, almost any color can be used but blue and 
green are still the most widely used.

• There are a number of different materials commonly used as chroma key backgrounds 
and each has its benefits. The most common are paper, fabric, and paint. Paper is not as 
durable but can be more cost effective and more easily set up than the other two. Paint 
takes time and must be applied in several coats to ensure a deep, complete covering, 
while fabric also takes time and must be mounted and hung properly. Contact your 
television set and lighting distributor for details on the material that best meets your 
budget and application.

• If you are creating your chroma key on a studio set, it is generally accepted that the 
quality of your chroma key is directly related to the quality of the camera shooting the 
scene. The background video can come from any number of sources and may be quite 
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acceptable but the foreground video is what is being keyed and where your attention is 
most focused. Therefore, the camera must be as high a resolution and low in noise as 
your budget will allow. In the end, low cost cameras may never produce “acceptable” 
chroma key results no matter how well the lighting has been configured.

• Always use the SDI or component output of your camera as your chroma key source. 
Composite outputs are considered monitoring, not broadcast, outputs and lack sufficient 
color and luminance information to achieve an acceptable chroma key. 

• As well, never shoot a chroma key with the detail turned on in your camera. Detail adds 
noise to the video signal and makes it much more difficult for the chroma key circuits to 
process the video. Turning on the camera detail is not the solution to a low light level – 
more lights are! 

• And finally, a few other points for your consideration. Avoid using foreground chroma 
key sources from 4:1:1 formats, highly compressed material (more than 4 to 1), or 
composite analog recordings. The technical nature of their formats and storage 
algorithms defeat the chroma key circuits and will seldom deliver acceptable results. 

Performing a Preset Pattern Key
A Preset Pattern key is one in which the hole is cut based on a wipe pattern that you select in the 
Effects Control Group. The pattern (which acts just like the alpha signal used with an auto select 
key) is filled with video from the Key Bus.

Use the following procedure to perform a Preset Pattern Key in Key 1:

1. Select a background source on the PGM bus. This provides the background over which 
the key will appear.

2. Press KEY1 in the Transition Control Group to preview the key. This step will also 
serve to assign the Key bus and Effects Keyers Group to Key 1.

3. Select the key source on the Key 1 Bus.

4. Press PST PATT in the Effects Keyers Group. 

5. Select the desired wipe pattern in the Effects Control Group.

6. Press the FLY KEY button to turn it off. 

7. Press KEY1 in the Transition Control Group to preview the Key. 

Important If you perform a Preset Pattern key on Effects Keyer 2, the pattern 
generator is restricted to all the classic wipe patterns (minus the circle).

Note This section of the Synergy 100 Operation Guide explains Preset 
Pattern keys without the flying key mode enabled. For instructions on 
the flying key mode, refer to the section “Performing Squeeze & 
Tease Boxes” on page 7-17 or the Squeeze & Tease 3D/WARP 
Owner’s Guide, as required. 

Operating
Tip

You can adjust the Clip and Gain as needed by using the CLIP and 
GAIN knobs in the Effects Keyer Group. You can also adjust the size 
and location of the pattern using the Positioner.
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8. Adjust wipe parameters such as ASPECT and BORDER in the Effects Control 
Group. 

9. Select any additional key modifiers you want to use. You can select between the 
following:

• MATTE FILL — You cannot Matte Fill a Preset Pattern Key.
• KEY INVERT — Select this button to invert the polarity of the key.
• MASK — Select this button to activate the mask feature and mask out a rectangular 

part of the source video (both alpha and fill).
10. Perform a CUT, AUTO TRANS, or move the fader from one limit to the other to take 

your Preset Pattern Key on-air.

This completes the procedure for performing a Preset Pattern Key in Key 1. The same procedure is 
applied to performing a Preset Pattern Key in Key 2.

Performing Squeeze & Tease Boxes
The flying PST PATT Key (also known as a Squeeze & Tease Box) function allows you to apply a 
2-D box effect to the PST PATT Key type, with the ability to control the size, horizontal position, and 
vertical position of the Key. 

The information in this section is applicable when using the Squeeze & Tease 2D card. If you have 
the Squeeze & Tease WARP option installed, please refer to the Squeeze & Tease 3D/WARP 
Owner’s Guide. 

Use the following procedure to perform a Squeeze & Tease Box Key in Key 1:

1. Ensure that the Squeeze & Tease 2D Option is installed. Refer to the section “Options 
Menu” on page 3-7 for instructions on how to verify the status of your installed 
hardware options. 

2. Select a background source on the PGM bus. This provides the background over which 
the key will appear.

3. Press the KEY1 in the Transition Control Group to preview the key. 

4. Select a key source on the Key 1 Bus.

5. Press PST PATT in the Effects Keyers Group. This action automatically turns on the 
FLY KEY button and assigns the Effects Control Group to the key. 

6. Adjust the size, and position of the key as follows:

• Size — Twist the Z-axis of the positioner to adjust the size of the key.
• Position — Move the positioner Up/Down or Left/Right to change the position of 

the key on screen.

Operating
Tip

The SOFT knob has the same function as GAIN in the Effects Keyer 
Group.

Note Preset Pattern modifiers (for example, clip, gain, soft) do not affect a 
Squeeze & Tease Box. 

Operating
Tip

For additional information about using the Positioner of the Synergy 
Switcher, refer to the section “Positioner ” on page 7-29.
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7. Press the MASK button to activate the cropping feature. Crop the key as follows:

• Moving the Positioner up and down will crop the image from the top edge. 
• Moving the Positioner left and right will crop the image from the left edge.

8. Press the REV/LEARN button in conjunction with the MASK button for additional 
cropping capabilities.

• Moving the Positioner up and down will crop the image from the bottom edge. 

• Moving the Positioner left and right will crop the image from the right edge. 

9. Press the MASK button to turn off the cropping feature and assign the Effects Control 
Group back to the FLY KEY button.

10. Adjust the border on the key as follows:

• Use the BORDER knob to adjust the size of the border on the key.
• Use the SOFT knob to adjust the softness of the border on the key.

11. Adjust the color of the Squeeze & Tease box border as follows:

• Press PST PATT in the Effects Keyer Group to assign control of the Mattes 
Group, as indicated by S&T1 or S&T2 appearing in the Mattes Group display.

• Make your color selections, as desired.
12. Press the ASPECT button and rotate the associated knob to change the aspect ratio of 

the key.

13. Perform a CUT, AUTO TRANS, or move the fader from one limit to the other to take 
your Squeeze & Tease Box Key on-air.

This completes the procedure for performing a Squeeze & Tease Box Key in Key 1. 

Split Keys
A Split Key is one in which you assign a different fill source for a key. This is a key source that is 
different than the default key/fill associations that are set up during installation and different from 
those that are set up automatically for the various key types. Split keys are typically used for creative 
montages and for keying moving video inside key shapes.

Important As you crop the right edge, the right edge moves towards the left. 
However, as you crop the left edge, the right edge once again appears 
to move towards the left. This occurs because all fly key manipulations 
are registered (locked) to the upper left edge of the image. This feature 
gives you a constant and accurate frame of reference when 
manipulating fly key images.

Note If a Squeeze & Tease box is enabled, pressing SELF KEY, AUTO 
SELECT, or CHROMA KEY automatically turns the Squeeze & 
Tease mode off and changes to the selected keying mode.

Operating
Tip

If you wish to default all of the Squeeze & Tease modifiers, simply 
press the CNTR/EFF D button in the Effects Control Group. The  
Squeeze & Tease box keys clear to the upper left corner.
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There are two different split key functions:

• Split Key — A Split Key allows you to hold (retain) the alpha signal of the key and 
assign a new video source to fill the hole. A typical application is when you fill your 
character generator alpha signal with the live output from a VTR or camera.

• Split Video — A Split Video allows you to hold a (non-alpha) key cutter and select a 
new video source to fill the hole. A typical application is when you fill your title 
camera’s luminance key signal with the live output from a VTR.

In both cases, a new fill source is assigned while the hole cutter is held. The following methods allow 
you to perform split keys quickly — without having to return to the Inputs Menu and change your 
key/fill associations..

Performing a Split Key
The Split Key function allows you to hold the alpha signal of a key and assign a new video source to 
fill the hole. A split key can be formed in both of the Effects Keyers, and the DSK.

Use the following procedure to perform a split key in Key 1:

1. Select a background source on the PGM bus. This provides the background over which 
the key will appear.

2. Press Key1 in the Transition Control Group to preview the key. This step will also 
serve to assign the Key bus and Effects Keyer Group to Key 1.

3. Select a key source on the Key 1 bus.

4. Press AUTO SELECT in the Effects Keyers Group.

5. Press and hold AUTO SELECT.

6. Select the new fill source on the Key 1 bus. 

7. Release both buttons. 

8. Adjust the Clip and Gain of the key as needed. Refer to the section “Performing an 
Auto Select Key” on page 7-11 for instructions.  

This completes the procedure for performing a split key in Key 1. The same procedure is applied to 
performing a split key in Key 2.

Important When a flying SELF KEY is Split, the flying is turned off. If you press 
SELF KEY on a Split Key a message stating: “You cannot fly a Split 
Self Key.” will be displayed on the preview monitor.

Operating
Tip

Both buttons will now be lit on the Key 1 bus. The selected key alpha 
video source will still be lit, and the new split fill video signal will be 
flashing.

Note The Split Key function is a temporary assignment. If, after setting up 
the split, you press any button on the Key Bus, the split is released and 
you must set up the split again. Pressing AUTO SELECT again does 
not re-establish the split.
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Performing a Split Video
The Split Video function allows you to hold a luminance key cutter and assign a new video source to 
fill the hole. 

Use the following procedure to perform a split video in Key 1:

1. Select a background source on the PGM bus. This provides the background over which 
the key will appear.

2. Press Key1 in the Transition Control Group to preview the key. This step will also 
serve to assign the Key bus and Effects Keyer Group to Key 1.

3. Select a key source on the Key 1 bus.

4. Press SELF KEY in the Effects Keyers Group.

5. Press and hold the SELF KEY button.

6. Select the new fill source on the Key 1 bus. 

7. Release both buttons. 

8. Adjust the Clip and Gain of the key as needed. Refer to the section “Performing a Self 
Key” on page 7-10 for more information. 

This completes the procedure for performing a split video in Key 1. The same procedure is applied to 
performing a split video in Key 2.

Programming a Favorite CG
This procedure allows you to select a “favorite” CG that you can place on the CHAR GEN1 or 
CHAR GEN2 buttons in the Downstream Keyer Group. The feature is designed so that you can 
quickly select a “clean” CG in the Auto Select mode, with no key modifiers enabled.

Use the following procedure to program the CHAR GEN1 button:

1. Press and hold CHAR GEN1 in the Downstream Keyer Group. 

Operating
Tip

Both buttons will now be lit on the Key 1 bus. The selected key alpha 
video source will still be lit, and the new split fill video source will be 
flashing.

Note The Split Key function is a temporary assignment. If, after setting up 
the split, you press any button on the Key Bus, the split is released and 
you must set up the split again. Pressing SELF KEY again does not 
re-establish the split.

Note If you have a simple or complex key type already set up, when you 
press CHAR GEN1 or CHAR GEN2, the entire Keyer is cleared. In 
addition to the favorite CG, the system will automatically select AUTO 
SELECT and KEY MEM (provided the Auto Select Key with the 
appropriate Key Memory values has been set up in the installation). 
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2. Select the favorite CG source on the Key Bus.

3. Release both buttons. 

This completes the procedure for assigning a source to the CHAR GEN1 button. The same procedure 
is applied to assigning a video source to the CHAR GEN2 button. The selected CG will be stored in 
memory and will be recalled each time CHAR GEN1 is pressed.

Using Auto Transitions
The AUTO TRANS button in the Transition Control Group is used to start an automatic (smooth) 
transition that brings the selected key on or off-air. Refer to the section “Auto Transitions” on 
page 5-6 for more information on performing an Auto Transition.

• Two different auto-transition rates can be used to dissolve or wipe a key:

~ Auto Rate — If the AUTO TRANS button in the Transition Control Group is 
used in conjunction with the “next transition” buttons, the rate is controlled by the 
AUTO rate in the System Control Group.

~ DSK Rate — If the DSK DISS button in the Transition Control Group is used, 
that rate is controlled by the DSK rate in the System Control Group. 

Each auto transition button has its own unique rate. This important feature allows you to perform 
background transitions and downstream key transitions at different rates.

For example, with an AUTO rate of 20 frames and a DSK rate of 15 frames, you could fade in a key at 
20 frames (using the AUTO TRANS button in the Transition Control Group) and fade out the 
downstream key at 15 frames using the DSK DISS button in the Transition Control Group.

Refer to the section “Changing Auto Transition Rates” on page 5-6 for complete instructions on 
changing the Auto Transition rates.

Key Auto Transition Notes
Please note the following important points regarding key auto transitions:

• There are two ways to quickly finish an Auto Transition that is already in progress:

~ Press CUT during the transition immediately.

~ Move the Fader from one limit to the other. 

• You cannot perform an Auto Transition if the Fader is off its upper or lower limit. 

• The DSK can only be transitioned using the DSK DISS or DSK CUT buttons. The 
position of the Fader or the next transition selections does not affect a Downstream 
Keyer transition.

• Wipes can only be performed on the Effects Keyer transition or Background 
transitions. 

Important Once you move the Fader off-limit, the transition will stop. If you 
continue to move the Fader until the AUTO TRANS button goes out, 
the transition control has been passed to the Fader. If you move the 
Fader back to the original limit, you can continue the transition by 
pressing the AUTO TRANS button again or by pressing the CUT 
button.
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Key Cut Notes
Downstream Key transitions using the DSK CUT button in the Transition Control Group can be 
performed when the fader is off its upper or lower limit. This is due to the Downstream Key Transition 
buttons being totally independent of the rest of the Transition Control Group. Therefore, the 
position of the fader has no bearing at all on the DSK transition.
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Using Key Modifiers 
This section provides basic instructions for using key modifiers. The following topics are discussed:

• Filling a Key with Matte

• Masking Keys

• Inverting Keys

• Bordering Keys

• Flying Keys

Filling a Key with Matte
Use the following procedure to fill a key with matte color in Key 1: 

1. Select a background source on the PGM bus. This provides the background over which 
the key will appear.

2. Press Key1 in the Transition Control Group to preview the key. This step will also 
serve to assign the Key bus and Effects Keyers Group to Key 1.

3. Select a key source on the Key 1 bus.

4. Select either SELF KEY, AUTO SELECT, or CHROMA KEY in the Effects Keyers 
Group.

5. Press MATTE FILL in the Effects Keyers Group. The key fill will now be replaced 
with the current color from the matte generator.

6. Adjust the color of the matte as follows:

• HUE — Use the HUE knob in the Mattes Group to adjust the color of the matte 
generator.

• SAT — Use the SAT knob in the Mattes Group to adjust the color saturation. The 
color saturation can be adjusted from monochrome, or no saturation, to full color 
saturation.

• LUM — Use the LUM knob in the Mattes Group to adjust the luminance of the 
color. The luminance can be adjusted from minimum brightness to maximum 
brightness.

7. Add additional key modifiers as required.

8. Perform a CUT, AUTO TRANS, or move the fader from one limit to the other to take 
your key on-air.

This concludes the procedure for filling a key with matte color in Key 1. 

Note You cannot apply MATTE FILL to a PST PATT key. Matte Fill can 
be applied to all other key types.

Operating
Tip

Refer to the section “Mattes Group” on page 6-16 for more detailed 
color instructions.
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Masking Keys
Use the following procedure to mask a key in Key 1: 

1. Select a background source on the PGM bus. This provides the background over which 
the key will appear.

2. Press Key1 in the Transition Control Group to preview the key. This step will also 
serve to assign the Key bus and Effects Keyers Group to Key 1.

3. Select a key source on the Key 1 bus.

4. Select either SELF KEY, AUTO SELECT, or CHROMA KEY in the Effects Keyers 
Group.

5. Press MASK in the Effects Keyers Group. The current settings of the mask generator  
will be applied to the key.

6. Adjust the size, position, and aspect of the mask as follows:

• Size — Twist the positioner to increase or decrease the size of the mask. 
• Position — Move the positioner Up/Down or Left/Right to place the mask where 

you want it.
• Aspect — Use the ASPECT knob in the Effects Keyers Group to adjust the 

aspect ratio of the mask.
7. Invert the mask as follows:

• Press the REV button in the Effects Keyers Group to invert the mask. 
8. Add additional key modifiers as required.

9. Perform a CUT, AUTO TRANS, or move the fader from one limit to the other to take 
your key on-air.

This concludes the procedure to mask a key in Key 1. 

Inverting Keys
Use the following procedure to invert a key in Key 1:

1. Select a background source on the PGM bus. This provides the background over which 
the key will appear.

2. Press Key1 in the Transition Control Group to preview the key. This step will also 
serve to assign the Key bus and Effects Keyers Group to Key 1.

3. Select a key source on the Key 1 bus.

Note You cannot mask a PST PTT key or a Squeeze & Tease box key. A 
mask can be applied to all other key types.

Operating
Tip

You can return the mask to its default size, position, and aspect by 
pressing the CNTR/EFF D in the Effects Keyers Group.

Note You cannot invert Squeeze & Tease boxes. Invert can be applied to all 
other key types.
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4. Select either SELF KEY, AUTO SELECT, CHROMA KEY, or PST PATT in the 
Effects Keyers Group.

5. Press KEY INVERT in the Effects Keyers Group. The polarity of the selected key is 
now reversed.

6. Adjust the Clip and Gain of the key as follows: 

• Use the CLIP knob in the Effects Keyers Group to adjust the luminance of the key. 
The lower the threshold setting, the more the key is visible.

• Use the GAIN knob in the Effects Keyers Group to adjust the softness of the edges 
of the key.

7. Add additional key modifiers as required.

8. Perform a CUT, AUTO TRANS, or move the fader from one limit to the other to take 
your key on-air.

This concludes the procedure to invert a key in Key 1. 

Bordering Keys

The Key Border function allows you to place borders, shadows, and outlines around keys in any one 
of the keyers. The Border Generator option must be installed. The border buttons will not illuminate 
if the option is not installed. 

The following figures display examples of the three types of borders that can be created by the 
Border Generator:

• Press BORD to add a border behind the selected key type. The border can surround the 
key or it can appear as a detached shadow that can be offset to any distance and 
direction. Border width, softness, color, and transparency are all adjustable.

• Press SHDW to add a drop shadow behind the selected key type. The shadow is 
connected to the key signal, instead of being detached. Shadow width, softness, color, 
and transparency are all adjustable.

• Press OUTL to add an outline around the selected key type, with variable width, 
softness, color, and transparency. With OUTL selected, the key fill is completely 
transparent.

Note The border defaults to DSK. 
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Assigning a Border to a Key  

 Use the following procedure to assign and modify a border to a key in Key 1:

1. Ensure that the Floating Border Generator option is installed. Refer to the section 
“Options Menu” on page 3-7 for instructions on verifying the status of your installed 
hardware options.

2. Select a background source on the PGM bus. This provides the background over which 
the key will appear.

3. Press Key1 in the Transition Control Group to preview the key. This step will also 
serve to assign the Key bus and Effects Keyers Group to Key 1.

4. Select a key source on the Key 1 bus.

5. Select either SELF KEY, AUTO SELECT, or CHROMA KEY in the Effects Keyers 
Group.

6. Assign a border generator to the key as follows:

• Press and hold the currently selected key type button.
• Select a border type while continuing to press the selected key type button. You can 

choose from the following:
~ BORD — Double press this button to add a border behind the selected key 

type.

~ SHDW — Double press this button to add a drop shadow behind the selected 
key type.

~ OUTL — Double press this button  to add an outline around the selected key 
type, with variable width, softness, color, and transparency.

7. Adjust the size, position, glow, and transparency of the border as follows:

• Size — Twist the positioner to adjust the border width.
• Position — Move the positioner Up/Down or Left/Right to adjust the border 

position.
• Glow — Use the SOFT knob in the Effects Control Group to adjust the glow 

applied to the border.
• Transparency — Use the BORDER knob in the Effects Control Group to adjust 

the transparency applied to the border.  

Note You can only assign a border to one key (Key 1, Key 2, or DSK) at a 
time. 

Note When BORD, SHDW, or OUTL is selected, DSK is automatically 
selected in the Mattes Group. Refer to the section “Bordering Keys” 
on page 7-25 for more information on the three types of borders.

Note Press CNTR/EFF D in the Effects Control Group to reset the vertical 
and horizontal positioning parameters of the border to their default 
values.

Operating
Tip

To create the widest possible border, set both the positioner and SOFT 
controls to their maximum settings.
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8. Adjust the color of the border as follows:

• HUE — Use the HUE knob in the Mattes Group to adjust the color of the border 
generator.

• SAT — Use the SAT knob in the Mattes Group to adjust the color saturation. The 
color saturation can be adjusted from monochrome, or no saturation, to full color 
saturation.

• LUM — Use the LUM knob in the Mattes Group to adjust the luminance of the 
color. The luminance can be adjusted from minimum brightness to maximum 
brightness.

9. Perform a CUT, AUTO TRANS, or move the fader from one limit to the other to take 
your key on-air.

This concludes the procedure to assign and modify a border to a key in Key 1. This procedures applies 
to assigning a border to a key in Key 2.

Flying Keys
The Fly Key function allows you to apply 2D effects to any key type, with the ability to control the 
size, rotation, horizontal position and vertical position of the key.  

Use the following procedure to fly a key in Key 1:

1. Ensure that the Squeeze & Tease 2D Option or Squeeze & Tease WARP Option is 
installed. The FLY KEY button will not illuminate if the option is not installed. 
Refer to the section “Options Menu” on page 3-7, for instructions on how to verify the 
status of your installed hardware options. 

2. Select a background source on the PGM bus. This provides the background over which 
the key will appear.

3. Press Key1 in the Transition Control Group to preview the key. This step will also 
serve to assign the Key bus and Effects Keyers Group to Key 1.

4. Select a key source on the Key 1 bus.

5. Select either SELF KEY, AUTO SELECT, or CHROMA KEY in the Effects Keyers 
Group.

6. Press FLY KEY in the Effects Control Group. The key is now re-routed through the 
internal DVE, and you can now adjust its size and position.

7. Adjust the Clip and Gain of the key as follows: 

• Use the CLIP knob in the Effects Keyers Group to adjust the luminance of the key. 
The lower the threshold setting, the more the key is visible.

• Use the GAIN knob in the Effects Keyers Group to adjust the softness of the edges 
of the key.

Note All key types can be flown, but applying the fly key function to a 
Preset Pattern key creates a Squeeze & Tease Box. Refer to the section 
“Performing Squeeze & Tease Boxes” on page 7-17.

For information on using 3D DVE effects, refer to the Squeeze & 
Tease 3D/WARP Owner’s Guide.
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8. Adjust the size, position and aspect of the key as follows:

• Size — Twist the positioner clockwise and counter-clockwise to increase or 
decrease the size of the key.

• Position — Move the positioner Up/Down or Left/Right to control the position of 
the key on screen.

• Aspect — Press the ASPECT button in the Effects Control Group and use the 
ASPECT knob to adjust the aspect ratio of the key.

9. Add additional key modifiers as required.

This concludes the procedure to fly a key in Key 1.

Fly Key Notes
Note the following important points regarding the Fly Key function:

• You can only fly one AUTO SELECT key at a time. If one Keyer is already flying an 
AUTO SELECT key, you cannot enable the FLY KEY button in the other Keyer.

• You can fly any combination of Preset Pattern Keys (Squeeze & Tease Boxes), 
CHROMA KEYS or SELF KEYs – one in Keyer 1 and the other in Keyer 2. You can 
fly any two 3D Preset Pattern Keys in Keyer 1.

• When a flying SELF KEY that is Split, the flying is turned off.

• If a key is processed using Fly Key but its size is not reduced, the image can be 
repositioned without any picture degradation.

• You can program a flying Key to move from position to position, using an effects 
dissolve. Refer to the section “Effects Dissolve ” on page 8-7 for details.

• If you are flying both Effects keys and you need to adjust the one that is not currently 
active, simply press the KEY2 button to select the alternate Keyer, and then the Key 
type button to activate its “fly key” functionality. 

Note Press the CNTR/EFF D button in the Effects Control Group to clear 
the aspect ratio, size, and position back to default values.
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Positioner 
The Positioner is an assignable module that allows you to manipulate the size and position of wipe 
patterns, flying keys, borders, mask and crop edges, PST PATT keys, and Squeeze & Tease box keys 
— depending upon the selected mode.   

The control of the 3-axis Positioner (also known as a joystick) is illustrated below:

Positioner (Joystick)

• Moving the Positioner left and right controls the horizontal position of the wipe pattern, 
flying keys, mask, Squeeze & Tease box or border. It also controls the left and right 
edges of the Squeeze & Tease box in cropping mode and the horizontal rotation of a 
flown key when the Squeeze & Tease WARP option is installed. 

• Moving the Positioner up and down controls the vertical position of the wipe pattern, 
flying keys, mask, Squeeze & Tease box or border. It also controls the upper and lower 
edges of the Squeeze & Tease box in cropping mode and the vertical rotation of a flown 
key when the Squeeze & Tease WARP option is installed.

• Twisting the Positioner clockwise and counter-clockwise controls the size of the wipe 
pattern, flying keys, mask, Squeeze & Tease box, and border. It also provides a means 
of rotating the vertical and horizontal wipes when the ROTATE button is active and the 
planar (or Z-axis) rotation of a flown key when the Squeeze & Tease WARP option is 
installed.

Left / Right 
(X-Axis) Movement:

Horizontal Position Control

Up / Down 
(Y-Axis) Movement:

Vertical Position Control

Clockwise / 
Counter-clockwise

(Z-Axis) Movement:
Size Control
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Memory Functions and More

In This Chapter
This chapter provides instructions for using your switcher’s Memory System, plus additional features 
such as Effects Functions and Aux Buses. The following topics are discussed:

• Memory Functions

• Storing Memory Registers

• Recalling Memory Registers

• Effects Dissolve 

• Copy and Swap Functions

• Synergy Slots
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Memory Functions
The Synergy memory system stores and recalls complete switcher set-ups including key source and 
fill information, wipe pattern selection, masking, transition rates, borders, key attributes, and color 
matte levels — all the control panel settings that comprise a typical built-up scene.

The memory controls consist of the MEM button, the CNTR/EFF D button, and the REV/LEARN 
button located in the Effects Control groups. These buttons are used in conjunction with the System 
Control Group and the Effects Control pattern buttons. Please refer to the following diagrams:

MEM, CNTR/EFF D, and REV/LEARN Buttons

System Control Group

A memory register is a “snapshot” of the switcher — and up to 100 registers, numbered 00 to 99, can 
be stored and recalled. The digit in the tens column represents the memory bank number. Ten banks of 
10 registers each are provided, laid out in the following fashion:

• Bank 0 (registers 00 to 09)

• Bank 1 (registers 10 to 19)

• Bank 2 (registers 20 to 29) etc.

The digit in the ones column represents the memory register within the selected bank. 

When the MEM button in the Effects Control Group is selected, the numbers 0 through 9 under the 
pattern buttons identify memory locations, not pattern numbers. With these buttons, you can store and 
recall 10 complete switcher set-ups directly. To access different memory banks, use the 10 (down 
arrow) button in the System Control Group. One bank is active at any given time.

EFFECTS CONTROL

SEL

CNTR

REV

MODE
MATTES

SEL

MODE

L
E
A
R
N

EFFECTS  CONTROL

ROTATE MEM

ASPECT

ASPECT

SOFT

E
F
F

D

Memory
Controls

"MEM" Mode

SEL Button

SYSTEM  CONTROL

MENU SEL

EDIT

BACK

100 10 1

MODE

MEM

10 and 1
Buttons
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Storing Memory Registers
This section provides instructions for storing memory registers. 

Remember that when you store a panel setup, you store everything, including all underlying data. For 
example, if you store a register that includes one or more keys, not only is the key data stored for the 
current on air keys, but data (e.g., clip and gain) is also stored for keys that are not currently on air.

There are two ways to store a scene - a quick store, and an advanced store. The only difference 
between the two is the ability to gain access to other than the currently selected memory bank. Both 
methods are discussed in this section.

Quick Store
Use the following procedure to perform a quick store:

1. Set up the switcher to create some desired scene.    

2. Press the MEM button to assign the Effects Control buttons and System Control 
Group controls to memory stores and recalls. The MEM button lights green. 

Note the bank number in the tens column of the System Control Group display as you 
will need it to recall the correct memory. The memory bank is also displayed following 
the text MEM in the left-most four-character mode display of the Effects Control 
Group.

Effects Control and System Control Groups

3. Press the REV/LEARN button to enter memory store mode.

4. Press one of pattern buttons 0 through 9 (now being used as storage locations). 

The switcher setup has been stored and the LED on the REV/LEARN button turns off.

This completes the procedure to perform a quick store.

Note If you wish to use the AutoRecall feature, as detailed in Chapter 7 of 
the Synergy 100 Installation Guide, you must toggle on the Effects 
Dissolve button (CNTR/EFF D) prior to storing.

Note A store operation can be canceled only if a memory location has not 
already been selected (by pressing a pattern button). Press MEM or 
REV/LEARN to abort the store operation.

EFFECTS  CONTROL SYSTEM  CONTROL

SEL

CNTR

REV

MENU SEL

EDIT

BACK

100 10 1

SEL

L
E
A
R
N

0 1 2 3 4

5 6 7 8 9

MODE

MEM

MATTES
MODE

BKGD
MODE

MEM2

Memory Bank

Pattern Buttons

E
F
F

D

DVE
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Advanced Store
Use the following procedure to perform an advanced store:

1. Set up the switcher to create some desired scene.

2. Press the MEM button to assign the Effects Control buttons and System Control 
Group controls to memory stores and recalls. The MEM button lights green.

3. Press the REV/LEARN button to enter “store” mode.

4. Press the 10 (down arrow) button in the System Control Group to scroll to the desired 
bank. 

 Effects Control and System Control Groups    

5. Press the 1 (up arrow) button to select the memory register.

If you prefer, after selecting the desired memory bank with the 10 button, you can 
simply press one of buttons 0 through 9 in the Effects Control Group to choose the 
register number. The switcher setup stores to memory and the MEM and REV/LEARN 
buttons automatically turn off. 

6. Press SEL in the System Control Group to store the scene to memory.

 This completes the procedure to perform an advanced store.

Note If you wish to use the AutoRecall feature, as detailed in Chapter 7 of 
the Synergy 100 Installation Guide, you must turn on the Effects 
Dissolve button (CNTR/EFF D) prior to storing. 

Important The store operation can be aborted any time prior to pressing the SEL 
button.
Storing a setup in a specific register overwrites any previous 
information that may have been contained in that register.
A store operation cannot be undone.

EFFECTS  CONTROL SYSTEM  CONTROL
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MENU SEL
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BACK
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Recalling Memory Registers
This section provides instructions for recalling memory registers. 

There are two ways to recall a scene - a quick recall, and an advanced recall. The only difference 
between the two is the ability to gain access to other than the currently selected memory bank. Both 
methods are discussed in this section.

Quick Recall
Use the following procedure to perform a quick recall:

1. Press the MEM button. The button will illuminate green.

2. Press one of pattern buttons 0 through 9 (now being used as storage locations). The 
switcher setup is recalled.

Effects Control and System Control Groups

This completes the procedure to perform a quick recall.

Advanced Recall
Use the following procedure to perform an advanced recall:

1. Press the MEM button. The button will illuminate green.

2. Press the 10 button in the System Control Group to scroll to the desired bank.

3. Press the 1 button to scroll to the desired memory register.

Note If this memory was stored with the Effects Dissolve feature activated, 
and the AutoRecall option is set to On, (refer to Chapter 7 of the 
Synergy 100 Installation Guide), the CNTR/EFF D button will 
illuminate, and the current switcher setting will “slew” to the new 
recalled setting. 
This method of recalling memories can only be done within a specific 
bank. If you need to change banks, you will need to perform an 
advanced recall.

Important A recall operation cannot be undone. 
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4. Press SEL to recall the previously stored scene.

If you prefer, after selecting the desired memory bank with the 10 button, you can 
simply press one of buttons 0 through 9 in the Effects Control Group to choose the 
register number. The switcher setup is automatically recalled.    

This completes the procedure to perform an advanced recall.

After a recall, the panel responds to the recalled values and not to the current position of the knobs. 
This may result in the control knob reaching its mechanical stop before the full value is reached. If this 
happens, it will be necessary to rotate the knob away from the mechanical stop to a point where some 
change is again observed. At this point, the knob is totally returned to operator control and it will 
respond in a normal fashion. This makes it possible to make adjustments on the program output 
without observing any jump as the control knob is re-synchronized.

Recall Register Notes
Please note the following important points regarding memory register recalls:

• When a register is recalled that includes an off-limit Fader, the system brings the effect 
back as a temporary “wipe limit.” You can use the AUTO TRANS button in the normal 
way to complete the transition. 

• It is possible to recall a memory while retaining a current video crosspoint. This is 
accomplished by holding down the crosspoint of the video that you want to keep, and 
then recalling the desired memory. This feature applies to both key buses and DSK bus, 
as well as the background and preset buses.

• It is possible to trigger a memory recall using a frame GPI input. Refer to the “Setting 
Up Frame GPIs” section in Chapter 8 of the Synergy 100 Installation Guide for 
details. 

Note If this memory was stored with the Effects Dissolve feature activated, 
and the AutoRecall option is set to On, (see Chapter 7 of the Synergy 
100 Installation Guide), the CNTR/EFF D button will illuminate, and 
the current switcher setting will “slew” to the new recalled setting. 
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Effects Dissolve 

The CNTR/EFF D button in the Effects Control Group enables you to “slew” a switcher setup from 
its current setting to a new recalled setting. In DVE terms, an Effects Dissolve is a two-keyframe 
effect whereby the switcher interpolates between two different settings (a source effect and a 
destination effect) at a given rate. Please note:

• Only analog functions (such as border color, clip levels and pattern positions) slew 
between a current setting and a new recalled setting. However, when the CNTR/EFF D 
button is armed and the recall function is performed, the Synergy 100 first recalls all 
non-dissolving values prior to beginning the effects dissolve itself. 

This means that everything that is not an analog value (e.g., key priorities, crosspoints, 
patterns, next transition data) is recalled in the first frame of the effects dissolve, 
followed by all analog values in the second frame. By presetting the switcher with the 
correct backgrounds and priorities (immediately prior to performing the effects 
dissolve), this feature guarantees the correct ending position for your effects. 

• If the CNTR/EFF D button is off, recalled effects cut between registers.

• The Effects Dissolve function is valid for recall operations only. Storage operations are 
not affected.

• The duration of the Effects Dissolve is governed by the transition rate that is 
programmed into the destination register. For example:

~ Effect #1 is a box wipe that is positioned in the upper left of the screen. It is stored 
in register 1 with a transition rate of 10 frames.

~ Effect #2 is a box wipe that is positioned in the upper right of the screen. It is stored 
in register 2 with a transition rate of 45 frames.

If you cut to register 1 and then recall register 2 with an Effects Dissolve, the box wipe 
moves from the upper left to the upper right at a 45 frame duration.

• The Effects Dissolve function will not transform a circle wipe into a box wipe. For 
example:

~ Effect #3 is a circle wipe that is positioned in the center of the screen. It is stored in 
register 3 with a transition rate of 30 frames.

• If you cut to register 1 and then recall register 3 with an Effects Dissolve, the system 
cuts to the circle wipe and then moves it from the upper left to the center at a 30 frame 
duration.

• You can slew as many functions within the MLE as desired.

Performing an Effects Dissolve
Use the following procedure to perform an Effects Dissolve:

1. Program an effect with the intention of performing an Effects Dissolve — that is, a 
change between two different analog settings (e.g., a wipe in two positions, a border 
with two unique colors, two different “fly key” positions).

Note The Effects Dissolve feature can be stored and automatically recalled 
with the memory. Refer to Chapter 7 of the Synergy 100 Installation 
Guide for details. 
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2. Enter the desired transition rate. Refer to the section “Changing Auto Transition 
Rates” on page 5-6 for instructions.

3. Store the effect in the desired memory register. Refer to the section “Storing Memory 
Registers” on page 8-3 for instructions. Remember that the transition rate determines 
the duration of the Effects Dissolve — how long it takes to slew to this setup.

4. Repeat steps 1 through 3 for the second effect (remember that two setups are required to 
perform an effects dissolve — essentially, a source effect and a destination effect).

5. Recall the first setup from memory. Refer to the section “Recalling Memory Registers” 
on page 8-5 for details.

6. To perform the Effects Dissolve, press CNTR/EFF D and recall the second setup from 
memory. The system first recalls all non-dissolving values (with a cut) and then slews all 
analog values.

7. Repeat step 6 if you want to slew back to the first setup or to any additional registers that 
have been properly stored in preparation for the Effects Dissolve function. 

• You can slew or cut between as many setups as desired, simply governed by the 
CNTR/EFF D button and the way that the effect was programmed.

This completes the procedure to perform an Effects Dissolve. 
8–8  • Memory Functions and More Synergy 100 Operation Guide (v16.10-S100)



Copy and Swap Functions
The following copy and swap functions are available:

• Copy Key — allows you to copy the contents of one keyer to the other key location 
within the Effects Keyers Group. 

• Key Swap — allows you to swap the entire contents of one keyer with the contents of 
the other key location within the Effects Keyer Group. 

Please note that there are no copy/swap functions available for the Downstream Keyer. 

Copy Key
The Copy Key function allows you to copy the entire contents of one keyer to the other keyer in the 
Effects Keyers Group. 

Use the following procedure as a basic key copy method: 

1. In the Effects Keyers Group, ensure that the key you wish to copy has control of all key 
modifier buttons and knobs. That is, the key type and all modifiers of your source key 
must be displayed.

2. Press and hold the Key Type of the key you wish to copy. 

Effects Keyer – Key Types

3. Press the KEY2 button in the Effects Keyers Group. 

4. Release both buttons.

This completes the procedure to copy a key.

Key Swap 
The Key Swap function allows you to swap the entire contents of one keyer with the contents of the 
other keyer in the Effects Keyers Group. 

Use the following procedure to swap the Keyers:

1. Press and hold the KEY2 button in the Effects Keyers Group. 

2. Press KEY1 in the Transition Group. 

3. Release both buttons. The keyers swap their contents, as indicated by a pop-up message 
that appears on the preview monitor.

This completes the procedure to swap the Keyers.

Note When you copy a keyer to another keyer, the entire contents (except 
matte fill color) of the source keyer are copied to the destination — 
including the selected key crosspoint.

Operating
Tip

The procedure can also be performed in the reverse order — pressing 
KEY1 first, followed by the KEY2 button

SELF
KEY

AUTO
SELECT

CHROMA
KEY

PST
PATT
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Synergy Slots
The Synergy 100 incorporates a special mode in which pseudo-random information is statistically 
measured on a cumulative basis. This function is accessed as follows: 

• Press and hold the SEL buttons in the System Control and Mattes groups.

• Press KEY2 in the Effects Keyers Group. 

This action causes all button LEDs to turn off, with only the display area in the upper section of the 
panel and the fader remaining active. The seven segment displays in the System Control group shows 
100, which represents the starting number of credits. 

 The fader serves as a “slot machine arm”. Moving it first to the upper limit and then to the lower 
limit, will cause the 3 four-character MODE displays to cycle for several seconds, and then settle on 
various pay line symbols.

When a winning combination of pay line symbols occurs, the panel reacts as follows:

• the button LEDs on the lower area of the control panel flash randomly

• the number of credits won flashes alternately with the new total number of credits 

• the winning pay line symbol (or symbols) flashes.

Winning pay line symbol combinations award credits as per the payout table below. The average 
payoff rate is approximately 239.4 percent. 

Pay Line Payout Table

Pay Line Symbols Panel Display Credit Payout
3 “S100”s S100 1000

3 “Lucky 7”s =7= 250

3 Oranges Orng 30

3 Lemons Lemn 25

3 Apples Appl 20

3 Cherries Chry 20

3 Bells Bell 15

3 Bars Bar 15

3 Stars Star 10

3 Plums Plum 10

2 “S100”s S100 10

1 “S100” S100 3
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The amount of credits won on any one pull of the arm will determine the number of flashing buttons 
on the panel. There are three “levels” of a “win”. Refer to the following table for detailed information.

The highest number of credits you can accumulate is 9999, and the lowest is 0. 

When you wish to exit the Synergy Slots, press any button in the upper pattern area. You are now 
ready to switch your next show.

LED Illumination Levels Table

Level % of LEDs 
Illuminated

Credits Won

1 6.25% < 10 

2 12.5% 10 to 100 

3 25% > 100 
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Peripheral Device Control and 
More

In This Chapter
This chapter provides instructions for using your switcher’s Memory System, plus additional features 
such as Effects Functions and Aux Buses. The following topics are discussed:

• GPIs

• Serial Tally Protocol Interface

• Remote Audio Mixer Control Interface

• Editor Interface

• Aux Bus Control

• Remote Aux Panels
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GPIs 
The Synergy 100 switcher’s GPI function provides 12 input ports, each of which can be programmed 
for specific functions. A GPI input pulse can be associated with a specific area and button on the 
switcher, which triggers when that pulse is received from an external device. 

In order for the GPIs to function, the GPIs option in the Effects Menu must be set to On.

Use the following procedure to enable the GPIs feature:

1. Ensure that your GPIs are connected and properly configured to communicate with your 
Synergy 100 Switcher. Refer to Chapter 7, “Communications Setup” in the Synergy 
100 Installation Guide, for full instructions on configuring your GPIs.

2. Navigate to the Effects Menu as follows:

• Press MENU to display the Main Menu.
• Press to display the Effects Menu.

Effects Menu

3. Enable the GPI feature as follows:

• Press 1. GPIs.
• Toggle the 1. GPIs button between On and Off as follows:

~ On — Use this option to enable GPIs. 

~ Off — Use this option to disable the GPIs feature.

• Press the right SEL button to accept the new settings.
4. Press MENU to display the Installation Change Screen.

5. Accept or cancel these changes as follows:

• Press 0. Confirm to accept the changes.
• Press 1. Cancel to exit the menus safely, without making any changes. The system 

returns to the previously stored settings.

This completes the procedure to enable the GPIs feature.

Effects

MENU
Exit

100
Previous

10
Down

1
Up

SEL
Accept

0. Editor          On
1. GPIs            Off
2. Center         Off
3. SafeTitle      Off
4. Menu Bkgd  On
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Serial Tally Protocol Interface
The Serial Tally Protocol option provides a means of communication between the Synergy 100 
switcher and tally system interface equipment using industry standard protocol. The standard parallel 
tally interface will continue to operate normally when this option is enabled. Note that the Serial Tally 
Interface software option must be enabled.

Software Options Menu — Serial Tally Option Installed

Refer to Chapter 7, “Communication Setup” of the Synergy 100 Installation Guide for full 
instructions on configuring your peripheral ports for the Serial Tally Interface.

Look Ahead Serial Tally
The Look Ahead Serial Tally (L.A.S.T.) protocol enables you to inform external devices of a key 
crosspoint change before the crosspoint change is performed on any bus of the Synergy 100 switcher. 
When a key source changes, the L.A.S.T. protocol informs the device while delaying the crosspoint 
change for the duration you set in the Communication Menus. Once set up, the L.A.S.T. protocol 
will continually transmit the information about every Synergy 100 switcher bus.

The Look Ahead Serial Tally protocol has extra options that must be setup to properly communicate 
with a serial tally interface device. Refer to the section, “Serial Tally Protocol Setup” in Chapter 7 of 
the Synergy 100 Installation Guide for setup information.

Note Refer to the section titled “Options Menu” in Chapter 2 of the 
Synergy 100 Installation Guide to ensure that the Serial Tally 
Protocol option is installed. If not, please contact Ross Video 
Technical Support for details.

Software Options - S/N:F422342234

MENU
Exit

100
Previous

10
Down

1
Up

SEL
Accept

0. Add
1. Editor

A6F8
On

2. DVE Off
3. Audio On
4. Ser Tal On
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Remote Audio Mixer Control Interface
The Audio Mixer Interface option provides audio-follow-video capability to the Synergy 100 
switcher. The option offers audio channel grouping and individual channel level adjustments. Note 
that the Audio software option must be enabled.

Software Options Menu — Audio Option Installed

Refer to the section, “Setting Up Audio Inputs” of the Synergy 100 Installation Guide for full 
instructions on configuring your audio inputs. For full instructions on configuring your Peripheral 2 
port and Audio Cut setup, refer to the section, “Remote Audio Mixer Communications Setup” of 
the Synergy 100 Installation Guide .

Note Refer to the section titled “Options Menu” in Chapter 2 of the 
Synergy 100 Installation Guide to ensure that the Audio option is 
installed. If not, please contact Ross Video for details.

Software Options - S/N:F422342234

MENU
Exit

100
Previous

10
Down

1
Up

SEL
Accept

0. Add
1. Editor

A6F8
On

2. DVE Off
3. Audio On
4. Ser Tal On
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Editor Interface
The Editor option in the Effects Menu allows the switcher to be controlled by an editing system 
using GVG 100, GVG 200, or GVG 4000 protocol. The Editor software option must be enabled.

Use the following procedure to enable the Editor option from the Synergy menu system:

1. Ensure that one of your edit controller’s serial ports is properly connected to the 
EDITOR connector on the rear of the Synergy 1 chassis and properly assigned to 
switcher control from within your editing system. 

Refer to your edit controller’s installation and operating manuals for details on the 
capabilities of your system’s remote switcher interface.  

2. Navigate to the Effects Menu as follows:

• Press MENU to display the Main Menu.
• Press 0. Effects to display the Effects Menu.

Effects Menu

3. Toggle the 0. Editor button to toggle remote control from an external edit controller as 
follows:

• On — Use this option to enable remote control from an external edit controller. 
Local operations can still be performed.

• Off — Use this option to disable remote control from an external edit controller. 
The Synergy 100 switcher is entirely “local.”

4. Press the right SEL button to accept the new settings.

5. Press MENU to display the Installation Change Screen.

Note Refer to Chapter 2 of the Synergy 100 Installation Guide to verify that 
the Editor option is installed. If not, please contact Ross Video 
Technical Support for details. For more information on setting up 
communications with your device and the Synergy 100 Switcher, refer 
to Chapter 7, “Communication Setup” of the Synergy 100 
Installation Guide.

Note The Editor option can also be enabled by pressing (or double pressing) 
the MENU button in the System Control group. Refer to Chapter 8 of 
the Synergy 100 Installation Guide for configuration instructions.

Effects

MENU
Exit

100
Previous

10
Down

1
Up

SEL
Accept

0. Editor          On
1. GPIs            Off
2. Center         Off
3. SafeTitle      Off
4. Menu Bkgd  On
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6. Accept or cancel these changes as follows:

• Press 0. Confirm to accept the changes.
• Press 1. Cancel to exit the menus safely, without making any changes. The system 

returns to the previously stored settings.

This completes the procedure to enable the Editor option from the Synergy menu system.
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Aux Bus Control
The Synergy 1 frame provides 8 Aux Buses, each of which can be used to route video to monitors, 
DVEs, still stores, VTRs, etc. The video sources for these Aux Buses are selected using the Key Bus 
and special Preset Bus crosspoints on the Synergy 100 control panel.

Use the following procedure to use the Aux Bus Control feature:

1. Press and hold the SEL button in the Effects Control group until the AUX”#” mode 
appears in the four-character display. If you prefer, you can also cycle through the modes 
by repeatedly pressing the SEL button.

Effects Control Groups

2. The pattern buttons in the Effects Control group are used to select the Aux Bus that you 
wish to route video to. Select the desired Aux Bus by pressing the corresponding pattern 
button. Refer to the following table: 

Note The “#” sign in the Effects Control Mode display represents the 
number of the Aux Bus (3-10) that you are controlling, with Aux Bus 
10 being displayed as AUX0. Aux Buses 1 and 2 are not available for 
this function.

Pattern Buttons for Aux Bus Control

Pattern Button Aux Bus Controlled
0 Aux 1 (Available for Preview Overlay only)

1 Aux 2 (Available for Preview Overlay only) 

2 Aux 3

3 Aux 4

4 Aux 5

5 Aux 6

6 Aux 7

7 Aux 8

8 Aux 9

9 Aux 10

EFFECTS  CONTROL

SEL

CNTR

REV

MODE

MATTES

SEL

MODE

L
E
A
R
N

EFFECTS   CONTROL

ROTATE MEM

ASPECT

ASPECT

BORDERSOFT

AUX3
E
F
F

D
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3. When AUX“#” is displayed in the Effects Control Group, the Key Bus crosspoints 
(and special Preset Bus crosspoints) function as Aux Bus crosspoints. The button for the 
input source that is currently feeding the selected Aux Bus will flash. 

4. Select the source to feed to the Aux Bus as follows:

• To route one of the 16 input sources to the Aux Bus, press the button for the desired 
source on the Key Bus crosspoint row. This includes shifted crosspoints.

• To route the MLE Preview output to the assigned Aux Bus destination, 
simultaneously press the SHIFT button on the Key Bus and the first button on the 
Preset Bus. Please note the AUX PV label above this button. 

• To route the Clean Feed output to the assigned Aux Bus destination, 
simultaneously press the SHIFT button on the Key Bus and the second button on 
the Preset Bus. Please note the AUX CLEAN label above this button. 

• To route the Program output to the assigned Aux Bus destination, simultaneously 
press the SHIFT button on the Key Bus and the third button on the Preset Bus. 
Please note the AUX PGM label above this button. 

This completes the procedure for controlling the Aux Buses from the Synergy 100 control panel. 

Note If one of the 16 input sources on the Key Bus is feeding the Aux Bus, 
the selected crosspoint will flash orange. If you choose one of the three 
outputs on the Preset Bus to feed the Aux Bus, the corresponding 
crosspoint on the Key Bus will flash red.

Note Preview Overlay can be switched to use AUX 1 and AUX 2. For 
details on the procedure, refer to Chapter 2 “Installation” of the 
Synergy 100 Installation Guide. 
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Remote Aux Panels
Remote Aux Panels are one-piece panels that provide remote control (or monitoring) capability of 
one (or more) of the switcher frame’s Aux Buses. These panels are typically mounted close to the 
destination devices to which they route their sources. Video does not flow through the panels — the 
actual Aux Bus outputs originate from the frame using separate wiring paths to the destination 
devices.

There are two types of Remote Aux Panels available:

• A Dedicated Remote Aux Panel controls one Aux Bus output. It allows you to route 
sources to one destination only.

• An Assignable Remote Aux Panel controls all 8 Aux Bus outputs, allowing you to 
route sources to eight different destinations.

Both types of Remote Aux Panels are discussed below.

Using a Dedicated Remote Aux Panel
A Dedicated Remote Aux Panel controls one Aux Bus output only. 

Dedicated Remote Aux Panel 

Use the following method to use a Dedicated Remote Aux Panel:

• Using the Aux Bus Crosspoint Row or the group of Special Aux Bus Crosspoints, 
press the button for the desired source.  

This completes the discussion on using a Dedicated Remote Aux Panel.

Using an Assignable Remote Aux Panel
An Assignable Remote Aux Panel controls or monitors all 8 Aux Bus outputs. Assignable panels 
also include an Aux Bus Assign group that is used to select which Aux Bus the panel is controlling. 
All panel types include a bright “on-air” or “active” LED that indicates (when lit) that the Aux Bus 
controls a signal that forms a part of the program output.

Assignable Remote Aux Panel

In addition to crosspoints, the panels include dedicated “special” crosspoint buttons for MLE PV, 
DVE Send (not implemented), Clean Feed, and Program. 

Note To have access to BLACK on a Remote Aux Panel, you must feed the 
“601 REF IN” BNC on the rear of the chassis with a stable black signal 
that is low in jitter and that originates from a reliable digital source.

BLACK 2 3 4 5 6 7 8 9

MLE
PV

CLEAN
FEED PGM

1
SHIFT

10

DVE
SEND

2 3 4 5 6 7 8

MLE
PV

CLEAN
FEED PGM ASSIGN

10
ASSIGN

9
ASSIGN

8
ASSIGN

7
ASSIGN

6

ASSIGN
5

ASSIGN
4

ASSIGN
3

ASSIGN
2

ASSIGN
1

SHIFT

109BLACK
1

DVE
 SEND
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Assignable Remote Aux Panel – Special Crosspoints

Refer to Chapter 7 of the Synergy 100 Installation Guide, for instructions on assigning “rights” to 
your Remote Aux Panel.

Use the following procedure to use an Assignable Remote Aux Panel:

1. Select the Aux Bus that you want to control (or monitor) using the Aux Bus Assign 
Group.

2. Using the Aux Bus Crosspoint Row or the group of Special Aux Bus Crosspoints, 
press the button for the desired source. 

This completes the procedure to use an Assignable Remote Aux Panel.

Remote Aux Panel Notes
Please note the following important points regarding Remote Aux Panel operation:

• As the DVE Send feature is not implemented, selecting the DVE SEND crosspoint on a 
remote Aux panel will route the Program output to the Aux Bus.

• Selecting BKGD Color (Shifted button 1) on a remote Aux panel will route the Program 
output to the Aux Bus. 

• When the Synergy 100 control panel is tracking sources being routed by a remote Aux 
panel, the MLE PV, CLEAN FEED, and PGM crosspoints on the remote Aux panel 
correspond to the first, second, and third Preview Bus crosspoint, respectively.

Note Although selecting Assign 1 or Assign 2 is possible, changing the 
crosspoints routed to these Aux Buses is not. The default setting of 
these two unimplemented Aux Buses is BLACK.

2 3 4 5 6 7 8

MLE
PV

CLEAN
FEED PGM ASSIGN

10
ASSIGN

9
ASSIGN

8
ASSIGN

7
ASSIGN

6

ASSIGN
5

ASSIGN
4

ASSIGN
3

ASSIGN
2

ASSIGN
1

SHIFT
109BLACK

1

Special Aux Bus Crosspoints Aux Bus Assign Group
(Assignable Panels Only)

Tally
(Aux Bus "Active")

DVE
 SEND
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Ultimatte Insider

In This Chapter
This chapter provides an overview and instructions for operating the optional Ultimatte Insider™ 
chroma keyer function. The following topics are discussed:

• Ultimatte Insider Option Overview

• Ultimatte Setup

• Ultimatte Insider Operations

In Appendix B of the Synergy 100 Installation Guide, refer to the “Ultimatte Insider Installation” 
section for details on installing the Ultimatte board in the frame.
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Ultimatte Insider Option Overview
Ultimatte Insider is a hardware option that adds true Ultimatte capability — directly inside the 
Synergy 100 switcher. The option comprises a hardware board designed by Ultimatte, the 
Oscar™-winning industry leader in compositing technology. 

Please note the following important points:

• The Ultimatte Insider board is allocated to only one of the MLE’s two keyers. The 
Ultimatte will automatically be associated with the first keyer in which a Chroma Key 
key type is selected.

• The Ultimatte Insider board creates two signals from a selected video source – a 
processed fill and a processed alpha signal.

• Even though the Ultimatte Insider board is allocated to only one of the keyers, any of 
the 16 inputs can be used as an Ultimatte key source.
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Ultimatte Setup
Once the Ultimatte Insider board is physically installed into the Synergy 1 frame, there is no set-up 
required.

During switcher operations, when you select one of the inputs on the Key Bus and select CHROMA 
KEY as the “type”, the Ultimatte Insider pop-up help will automatically appear on the preview 
output. However, the Ultimatte Insider will only be associated with the first Chroma Key you set up. 
If you select Chroma Key as the key type on the other Effects Keyer as well, it will be a standard 
Chroma Key.

Important The source that you select on the Key Bus activates the Ultimatte and 
internally calls up the Ultimatte’s processed alpha and fill signals. The 
selected source’s panel button on the Background and Preset buses 
remains the original unprocessed video signal. 
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Ultimatte Insider Operations
Use the following procedure to operate the Ultimatte Insider option:

1. In the Transition Control group, select the appropriate KEY button (KEY1 or KEY2) 
to preview the key. 

2. Select the desired key source on the Key Bus.

3. In the Effects Keyer group, press CHROMA KEY. This action automatically selects the 
output of the Ultimatte board, and causes the following to occur:

• The auto chroma key function is activated and crosshairs appear on the preview 
output.

• A pop-up help message, saying “Ultimatte Insider Activated”, is temporarily 
displayed on the preview output. 

• The switcher sets a temporary background transition (in the Transition Control 
Group) and changes the source on the PST bus to the source selected on the key 
bus. 

4. Use the positioner to place the crosshairs on top of the color you want to key out. 

5. You will notice that the right-most, four-character mode display in the System Control 
Group reveals the text “Grab”. Press the associated SEL button to obtain the best 
automatic chroma key. This action causes the following to occur:

• The bus returns to the previously selected crosspoint.
• The “Next Transition” buttons in the Transition Control Group return to the state 

that they were in prior to the auto chroma key function being activated.
6. Typically, no adjustment is required. However, if you feel adjustment is necessary, the 

following parameters can be modified:

• Rotate the CLIP knob in the Effects Keyers Group to control the level of Matte 
Density (opacity). This important step determines the level of separation that 
corresponds to the point at which the foreground is opaque. The default setting is 
one in which neutral colored foreground objects are opaque, but any color which is 
a shade of the background color is partially transparent. Increasing the Matte 
Density level permits foreground objects that are the same shade as the background 
color to be made opaque in the composite image.
For best results, lower the level until some portion of the foreground subject starts 
to become gray in the matte signal. Then increase the level until any area which 
should be opaque, has just become black in the matte signal. Do not increase the 
level too much, as it can cause hard dark edges around your foreground subjects.

• Rotate the GAIN knob in the Effects Keyers Group to control the Black Gloss 
level of foreground objects or surfaces that may be reflecting color from the 
background. The control introduces a negative offset which helps interpret the 
object as a foreground object. Adjust the Black Gloss (GAIN) level while viewing 
the matte signal on the monitor. Increase the level only enough to make the black 
glossy area of the foreground subject appear solid black in the matte signal. 
Note that adjusting the Black Gloss (GAIN) level may permit the Matte Density 
level to be lowered. Readjust Matte Density (CLIP) after adjusting Black Gloss 
level to ensure that both levels are set as low as possible, without permitting 
print-through in the foreground. Do not advance the level too far, as it can cause 
hard, dark edges around your foreground subjects.
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• Rotate the HUE/TRANSP knob in the Effects Keyers Group to adjust the Matte 
Gain level from the white end. The control can lower the Matte Gain output gain 
to 0%, or push it into the legal ceiling.
Note that the Matte Gain (HUE/TRANSP) control is a gain adjustment that affects 
only the processed matte output signal. This control does not have any effect on the 
matte signal used internally in the Ultimatte Insider.

7. Three additional parameters are adjustable by holding down the CHROMA KEY button 
and using the following knobs:

• Rotate the LUM knob in the Mattes Group to adjust the Grey Balance, making 
mid-range foreground colors warmer or cooler with minimal effects on lighter and 
darker colors. In addition to controlling flare suppression at mid-level values, the 
Grey Balance control also provides you with an added degree of flexibility in 
suppressing flare and contamination from the background spill onto the foreground 
subject.
Note that flare suppression may alter certain foreground colors. In most cases, this 
adjustment makes the foreground appear as if it is placed in front of a neutral 
(black) background and not a colored one, and overall, makes the composite more 
realistic (free of any influence from the background color). 

Because alteration of foreground colors may not be acceptable using flare suppression, 
two selective color gates are provided, Flare Gate 1 and Flare Gate 2. These “Gate” 
adjustments let you override the suppression so that “problem” colors can be used in the 
foreground. Problematic colors can be reproduced (with the addition of some flare on 
certain colors), while maintaining full suppression on the rest. 

• Rotate the HUE knob in the Mattes Group to adjust Flare Gate 1.
• Rotate the SAT knob in the Mattes Group to adjust Flare Gate 2.
The effect of the Flare Gate controls vary depending on the background color. The 
tables on the following pages illustrate the benefits and trade-offs of each Flare Gate 
adjustment. Columns 1 and 2 list the two Flare Gate controls, and the varying degree of 
adjustment.
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Background Color: Blue
Flare Gate Adjustment Table — Background Color: Blue

Flare Gate 
1 (HUE)

Flare Gate 
2 (SAT)

Benefits Trade-Offs

0% 0% • Removes Blue Spill while 
permitting some shades of blue 
to be reproduced in the 
foreground.

• Allows BLUE to exceed 
GREEN by the amount 
GREEN exceeds RED.

• Unable to reproduce Magenta 
in foreground (or any shade of 
pink in which the Blue should 
exceed Green.) Magenta will 
be reproduced as Red.

• Unable to remove blue spill 
from green foreground objects.

100% 0% • Removes Blue Spill from 
Green foreground objects as 
well as all other foreground 
colors.

• Limits BLUE to the LOWER 
of RED or GREEN.

• Unable to reproduce Cyan or 
Magenta in foreground.

• Cyan will be reproduced as 
Green.

• Magenta will be reproduced as 
Red.

0% 100% • Permits reproduction of 
Magenta in the foreground 
(and any shade of Pink in 
which Blue exceeds Green).

• Allows BLUE to exceed 
GREEN by the amount RED 
exceeds GREEN (or by the 
amount GREEN exceeds RED 
when RED is lower than 
GREEN.

• Will not remove Blue Spill 
from shades of Red in the 
foreground.

• Will not completely remove 
Blue Spill from shades of 
Green in the foreground.

100% 100% • Removes Blue Spill from 
shades of Green in the 
foreground.

• Permits reproduction of 
Magenta in foreground.

• BLUE is limited to the level of 
RED regardless of the level of 
GREEN.

• Cannot reproduce shades of 
Blue in the foreground.

• Cyan will become Green.
• Cannot remove Blue Spill from 

Red or Yellow. (Blue spill will 
desaturate Yellows.)
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Background Color: Green
Flare Gate Adjustment Table — Background Color: Green

Flare Gate 
1 (HUE)

Flare Gate 
2 (SAT)

Benefits Trade-Offs

0% 0% • Removes Green Spill while 
permitting some shades of 
Green to be reproduced in the 
foreground.

• Allows GREEN to exceed 
BLUE by the amount BLUE 
exceeds RED.

• Unable to reproduce Yellow in 
foreground (or any shade of 
Brown in which the Green 
should exceed Blue.) Yellow 
will be reproduced as Red.

• Unable to remove Green Spill 
from Blue foreground objects.

100% 0% • Removes Green Spill from 
Blue foreground objects as 
well as all other foreground 
colors.

• Limits GREEN to the LOWER 
of RED or BLUE.

• Unable to reproduce Cyan or 
Yellow in foreground.

• Cyan will be reproduced as 
Blue.

• Yellow will be reproduced as 
Red.

0% 100% • Permits reproduction of Yellow 
in foreground (and any shade 
of Brown which Green exceeds 
Blue).

• Allows GREEN to exceed 
BLUE by the amount RED 
exceeds BLUE (or by the 
amount BLUE exceeds RED 
when RED is lower than 
BLUE.

• Will not remove Green Spill 
from shades of Red in the 
foreground.

• Will not completely remove 
Green Spill from shades of 
Purple in the foreground.

100% 100% • Removes Green Spill from 
shades of Blue in the 
foreground.

• Permits reproduction of Yellow 
in foreground.

• GREEN is limited to the level 
of RED regardless of the level 
of BLUE.

• Cannot reproduce shades of 
Green in the foreground.

• Cyan will become Blue.
• Cannot remove Green Spill 

from Magenta or Red. (Green 
Spill will desaturate 
Magentas.)
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Background Color: Red
Flare Gate Adjustment Table — Background Color: Red

Flare Gate 
1 (HUE)

Flare Gate 
2 (SAT)

Benefits Trade-Offs

0% 0% • Removes Red Spill while 
permitting some shades of Red 
to be reproduced in the 
foreground.

• Allows RED to exceed 
GREEN by the amount 
GREEN exceeds BLUE.

• Unable to reproduce Magenta 
in foreground (or any shade of 
pink in which the Red should 
exceed Green.) Magenta will 
be reproduced as Blue.

• Unable to remove Red spill 
from Green foreground 
objects.

100% 0% • Removes Red Spill from Green 
foreground objects as well as 
all other foreground colors.

• Limits RED to the LOWER of 
BLUE or GREEN.

• Unable to reproduce Magenta 
or Yellow in foreground.

• Magenta will be reproduced as 
Blue.

• Yellow will be reproduced as 
Green.

0% 100% • Permits reproduction of 
Magenta in foreground (and 
any shade of Pink in which 
Red exceeds Green).

• Allows RED to exceed 
GREEN by the amount BLUE 
exceeds GREEN (or by the 
amount GREEN exceeds 
BLUE when BLUE is lower 
than GREEN.

• Will not remove Red Spill 
from shades of Blue in the 
foreground.

• Will not completely remove 
Red Spill from shades of Green 
in the foreground.

100% 100% • Removes Red Spill from 
shades of Green in the 
foreground.

• Permits reproduction of 
Magenta in foreground.

• RED is limited to the level of 
BLUE regardless of the level 
of GREEN.

• Cannot reproduce shades of 
Red in the foreground.

• Yellow will become Green.
• Cannot remove Red Spill from 

Blue or Cyan. (Red Spill will 
desaturate Cyans.)
10–8  • Ultimatte Insider Synergy 100 Operation Guide (v16.10-S100)



Appendix A. Menu Trees

In This Appendix
For your reference, this appendix lists the various menu trees that are used to set up the configurable 
areas of your Synergy 100 SD switcher. The following topics are discussed:

• Effects and Options Menu Trees

• BNC Configuration Menu Tree

• Additional Installation Setup Menu Tree

• GPI Setup Menu Tree

• Editor Communication Menu Tree

• Monitor Communication Menu Tree

• Audio Communication Menu Tree

• Serial Tally Communication Menu Tree

• Disk Menu Tree

• Squeeze & Tease 3D Menu Tree

• Default Menu Tree
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Effects and Options Menu Trees
The following figure illustrates portions of the menu that are used to turn on various options and user 
preferences and to identify both the software and hardware options that have been installed in your 
system. 

Effects and Options Menu Trees

Main Menu - Synergy 100

0. Effects
1. Inputs

MENU
Exit

100
Previous

10
Down

1
Up

SEL
Accept

2. Outputs
3. GPIs
4. Communication

vX.XX-S100

5. Disk
6. Personality
7. Options
8. S&T 3D
9. Default

Effects

MENU
Exit

100
Previous

10
Down

1
Up

SEL
Accept

0. Editor          On
1. GPIs            Off
2. Center         Off
3. SafeTitle      Off
4. Menu Bkgd  On

Off, On

Off, On

Off, On

Off, On

Off, On

Options  S/N:F422342234

0. Software Options
1. Opt Card   Ultimatte

MENU
Exit

100
Previous

10
Down

1
Up

SEL
Accept

2. S&T DVE 3D
3. Border Yes
4. Tallies 16

Software Options - S/N:F422342234

MENU
Exit

100
Previous

10
Down

1
Up

SEL
Accept

0. Add
1. Editor

A6F8
On

2. DVE Off

None, Ultimatte
2D, 3D, None
Yes, No
16, 32

3. Audio On

On, Off

On, Off
4. Ser Tal On On, Off

5. Panel ID
6. Frame ID

4100-2
4216-4
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BNC Configuration Menu Tree
The following figure illustrates the portion of the menu tree that is used to configure your BNC inputs.

BNC Configuration Setup Menu Tree 

BNCs

0. Input
1. Type

BNC 1
Off

2. AutoKey
3. Reserved
4. Shaped

Black

No

5. Aud Chan1
6. Aud Chan2

Main Menu - Synergy 100
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5. Disk
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0% - 100%

Group 1 - 6

NONE, Channel 1 - 16 
NONE, Channel 1 - 16 

NONE, Channel 1 - 16 
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Additional Installation Setup Menu Tree
The following figure illustrates the portion of the menu tree that is used for additional installation 
setup procedures. 

Additional Installation Setup Menu Tree

Outputs
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4:3
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2. Clean BeforeKeys

Main Menu - Synergy 100
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Accept

10
Down

1
Up

2. SleepTime 10 min

Off to 240 min

3. Menu Bttn Menu Only

Menu - Edit, Edit - Menu, Menu Bttn, Menu Only

4. RemAuxPrg  Off

Off, On

4. AutoRcall On

Off, On 

5. GPI Mode    Enabled
6. Show Knob  0

Disabled, Enabled 
0 to 100 

7. Audio Cut On

On, Off

5. Fld Dom   Field1  

Field1, Field2 
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GPI Setup Menu Tree
The following figure illustrates the portion of the menu tree that is used for GPI setup procedures. 

GPI Setup Menu Tree

GPIs

0. Frame GPIs
1. Remote GPIs

MENU
Exit

100
Previous

SEL
Accept

10
Down

1
Up

2. GPI Outputs

Main Menu - Synergy 100

0. Effects
1. Inputs
2. Outputs
3. GPIs
4. Communication

vX.XX-S100

5. Disk
6. Personality
7. Options
8. S&T 3D
9. Default

MENU
Exit

100
Previous

SEL
Accept

10
Down

1
Up

GPI 1 - 12
None, AutoTrans, Cut
FTB, MLE, DSK 
Low, High
Edge, Level

Frame GPIs

0. Input
1. Function

GPI 1
Cut

2. Area
3. Polarity

FTB
Low

4. Type Edge

MENU
Exit

100
Previous

SEL
Accept

10
Down

1
Up

Remote GPIs

0. Rem Panel
1. GPI Input

 1
1

2. Aux Bus
3. BNC

3
1

MENU
Exit

100
Previous

SEL
Accept

10
Down

1
Up

Frame GPIs

0. Input
1. Function

GPI 1
MemRecall

2. Memory
3. Polarity

Mem 23
Low

4. Type Edge

MENU
Exit

100
Previous

SEL
Accept

10
Down

1
Up

1 - 8

1 - 8
3 - 10

1 - 16

OR

GPI 1 - 12
MemRecall
Mem 00 - Mem 99 
Low, High
Edge, Level

4. Type/Edge Low Override

Off, Low Override, Low Toggle, High Toggle, Latch

GPI Outputs

0. Output
1. Type

GPI 1
Edge

2. Polarity
3. BNC

Low
None

MENU
Exit

100
Previous

SEL
Accept

10
Down

1
Up

GPI 1 - 12

Low, High

Edge, Level

None, 1 - 16
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Editor Communication Menu Tree
The following figure illustrates the portion of the menu tree that is used for setting up communication 
with external editors.

Communications Menu Tree – Editor Setup

Communication

0. Port
1. Type

Editor
Editor

MENU
Exit

100
Previous

10
Down

1
Up

SEL
Accept

2. Device
3. Baud
4. Parity

GVG4000
38400
Odd

5. Protocol
6. Input

RS232
None

Main Menu - Synergy 100

0. Effects
1. Inputs
2. Outputs
3. GPIs
4. Communication

vX.XX-S100

5. Disk
6. Personality
7. Options
8. S&T 3D
9. Default

Editor
Editor (Greyed)
None, GVG100, GVG200
GVG4000
9600, 19200, 38400, 57600, 115200
Odd, Even, None

RS232, RS422

MENU
Exit

100
Previous

SEL
Accept

10
Down

1
Up

OR

7. Monitor
8. Option
9. Use Break

Yes, No

Odd, Even, None

Communication

0. Port
1. Type

Editor
Editor

MENU
Exit

100
Previous

10
Down

1
Up

SEL
Accept

2. Device
3. Baud
4. Parity

GVG100
38400
Odd

5. Protocol
6. Input

RS232
None

Editor
Editor (Greyed)
None, GVG100, GVG200, 
GVG4000
9600, 19200, 38400, 
57600, 115200

RS232, RS422
None (Greyed)

7. Monitor
8. Option
9. Pattern

Pattern
Pattern #

Pattern #, Wipe Bttn

OR

Odd, Even, None

Communication

0. Port
1. Type

Editor
Editor

MENU
Exit

100
Previous

10
Down

1
Up

SEL
Accept

2. Device
3. Baud
4. Parity

GVG200
38400
Odd

5. Protocol
6. Input

RS422
None

Editor
Editor (Greyed)
None, GVG100, GVG200, 
GVG4000
9600, 19200, 38400, 
57600, 115200

RS232, RS422
None (Greyed)

7. Monitor
8. Option

OR

Yes
Use Break

None  (Greyed)

Communication

0. Port
1. Type

Editor
Editor

MENU
Exit

100
Previous

10
Down

1
Up

SEL
Accept

2. Device
3. Baud
4. Parity

GVG100
38400
Odd

5. Protocol
6. Input

RS232
None

Editor
Editor (Greyed)
None, GVG100, GVG200, 
GVG4000
9600, 19200, 38400, 
57600, 115200
Odd, Even, None

RS232, RS422
None (Greyed)

7. Monitor
8. Option
9. Editor

Editor
Editware

Editware, Sony, Generic

Communication

0. Port
1. Type

Editor
Editor

MENU
Exit

100
Previous

10
Down

1
Up

SEL
Accept

2. Device
3. Baud
4. Parity

GVG100
38400
Odd

5. Protocol
6. Input

RS232
None

Editor
Editor (Greyed)
None, GVG100, GVG200, 
GVG4000
9600, 19200, 38400, 
57600, 115200
Odd, Even, None

RS232, RS422
None (Greyed)

7. Monitor
8. Option
9. Use Break

Use Break
Yes

Yes, No

OR

Use Break
9. Use Break

Yes, No
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Monitor Communication Menu Tree
The following figure illustrates the portion of the menu tree that is used for monitoring the data 
transmitted and received through various communication ports.

Communication Menu Tree – Monitor Setup

Communication

0. Port
1. Type

Periph2
Ser.Tally

MENU
Exit

100
Previous

10
Down

1
Up

SEL
Accept

2. Device
3. Baud
4. Parity

Contrib
38400
Odd

5. Protocol
6. Input

RS232
None

7. Monitor
8. Option
9. Rate

Rate
24

Monitor

0. Port
1. Format

Panel
Hex

MENU
Exit

100
Previous

10
Down

1
Up

SEL
Accept

2. Tx/Rx
3. Freeze
4. Clear

Rx
No

5. Address 000

Main Menu - Synergy 100

0. Effects
1. Inputs
2. Outputs
3. GPIs
4. Communication

vX.XX-S100

5. Disk
6. Personality
7. Options
8. S&T 3D
9. Default

MENU
Exit

100
Previous

SEL
Accept

10
Down

1
Up

Panel, Editor, DVE,
Periph1, Periph2, Aux

ASCII, Hex

Tx, Rx

Yes, No

Buffer Location
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Audio Communication Menu Tree
The following figure illustrates the portion of the menu tree that is used for setting up communication 
with audio mixers.

                     Audio Communication Setup Menu Tree

Communication

0. Port
1. Type

Periph2
Audio

MENU
Exit

100
Previous

10
Down

1
Up

SEL
Accept

2. Device
3. Baud
4. Parity

Ya 01V
38400
Odd

5. Protocol
6. Input

RS232
None

Main Menu - Synergy 100

0. Effects
1. Inputs
2. Outputs
3. GPIs
4. Communication

vX.XX-S100

5. Disk
6. Personality
7. Options
8. S&T 3D
9. Default

Periph1, Periph2
Audio, Ser.Tally, Editor
Ya01V, Ya01V96, 
YaD1K, None
9600, 19200, 38400, 
57600, 115200
Odd, Even, None

RS232, RS422
None (Greyed)

MENU
Exit

100
Previous

SEL
Accept

10
Down

1
Up

7. Monitor
8. Option
9. Converter

Converter

Converter (Greyed)

MIDIator

MIDIator, None
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Serial Tally Communication Menu Tree
The following figure illustrates the portion of the menu tree that is used for setting up serial tally 
communication parameters.

     Serial Tally Communication Setup Menu Tree

Main Menu - Synergy 100

0. Effects
1. Inputs
2. Outputs
3. GPIs
4. Communication

vX.XX-S100

5. Disk
6. Personality
7. Options
8. S&T 3D
9. Default

MENU
Exit

100
Previous

SEL
Accept

10
Down

1
Up

Communication

0. Port
1. Type

Periph2
Ser.Tally

MENU
Exit

100
Previous

10
Down

1
Up

SEL
Accept

2. Device
3. Baud
4. Parity

Contrib
38400
Odd

5. Protocol
6. Input

RS232
None

- Periph1
- Periph2

- Ser.Tally
- Audio
- Off

- None
- Contrib*
- L.A.S.T.**

- 9600
- 19200
- 38400 
- 57600
- 115200

- Odd
- Even
- None

- RS232
- RS422

- None7. Monitor
8. Option
9. Rate

Rate
- Rate*
- Data Txfr*
- Start*
- At Black*
- Delay**

24

- Rate*
   - 2 to 60 inclusive
- Data Txfr*
   - Normal
   - Complete
   - Minimal
- Start*
   - None
   - Init
- At Black*
   - All Off
   - Active On
- Delay**
   - 0 to 120 inclusive
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Disk Menu Tree
The following figure illustrates the portion of the menu tree that is used for storing and recalling your 
switcher installation setup, memories, personality, and 3D wipes to and from a floppy disk or USB 
key.

Disk Setup Menu Tree

Main Menu - Synergy 100

0. Effects
1. Inputs

MENU
Exit

100
Previous

10
Down

1
Up

SEL
Accept

2. Outputs
3. GPIs
4. Communication

vX.XX-S100

5. Disk
6. Personality
7. Options
8. S&T 3D
9. Default

Recall

0. Recall All
1. Recall Memories

MENU
Exit

100
Previous

10
Down

1
Up

SEL
Accept

2. Recall Personality
3. Recall Installation

Disk

0. Recall
1. Store

MENU
Exit

100
Previous

10
Down

1
Up

SEL
Accept

Store

0. Store All
1. Store Memories

MENU
Exit

100
Previous

10
Down

1
Up

SEL
Accept

2. Store Personality
3. Store Installation

Store All

Memory Transfer: 1% Complete

100
Cancel

Recall All

Memory Transfer: 1% Complete

100
Cancel

4. Recall 3D Wipes

4. Store 3D Wipes

5. Recall Indiv 3D Wipe

Recall Indiv 3D Wipe

From Disk : Seq 00

To Switcher : PageRoll
ShockWve

Seq 01

Use HUE or SAT to scroll list and the System
Control SEL to accept.

5. Store Indiv 3D Wipe

Store Indiv 3D Wipe

From Switcher : PageRoll
ShockWve

To Disk : Seq 00
Seq 01

Use HUE or SAT to scroll list and the System
Control SEL to accept. 

6. Store All Pre V12

*
*
*
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Squeeze & Tease 3D Menu Tree
The following figure illustrates the portion of the menu tree that is used for configuring your Squeeze 
& Tease 3D effects.

                             Squeeze & Tease 3D Setup Menu Tree

Main Menu - Synergy 100

0. Effects
1. Inputs
2. Outputs
3. GPIs
4. Communication

vX.XX-S100

5. Disk
6. Personality
7. Options
8. S&T 3D
9. Default

MENU
Exit

100
Previous

SEL
Accept

10
Down

1
Up

0. Position/Crop

S&T 3D

1. Border
2. Sequence
3. Preprocessor
4. Lighting

5. Object Builder
6. StillStore

MENU
Exit

100
Previous

SEL
Accept

10
Down

1
Up

Object Builder

0.  Modify Object 1
1.  Modify Object 2
2.  Object Presets
3.  Modify Preset Obj.
4.  Create Preset Obj.

  Position/Crop

0.  Position
1.  Rotation
2.  Pivot Preset
3.  Pivot Position
4.  Aspect    Off

5.  Crop Horizontal
6.  Crop Vertical
7.  Transp.    Off
8.  Freeze    Off
9.  Adv. Positioning

Use positioner or Hue, Sat, Lum to modify

 Warp

0.  Warp List WARP Off

Warp: WARP Off

Use positioner or Hue, Sat, Lum to modify

Border

0.  Size
1.  Textures
2.  Corners
3.  Color
4.  Auto Default Off

1   01   02     Key 1

Preprocessor

0.  Defocus
1.  Mosaic
2.  Posterize
3.  Colorize
4.  Strobe

Use positioner or Hue, Sat, Lum to modify

Off

Off
Off
Off

Off

1   01   02     Key 1

1   01   02     Key 1  Lighting

0.  Lighting Setup
1.  Position
2.  Presets
3.  Auto Follow
4.  Luminance Clipping

Use positioner or Hue, Sat, Lum to modify

1   01   02     Key 1

None

Off

Sequence

0.  Load/Save Sequence
1.  Previous Keyframe
2.  Next Keyframe
3.  Insert Keyframe
4.  Duration

5.  Overwrite Keyframe
6.  Delete Keyframe
7.  Delete Workspace
8.  Wipe Modifier

Key 1

**EMPTY**

7. Warp

StillStore

0.  StillStore
1.  Mode
2.  Capture Still
3.  Name Still
4.  Delete Still

Chan 1:
Using Live Video

1                Key 1

5.  Delete All Stills

Still:

Use positioner or Hue, Sat, Lum to modify

Off
Frame

10000001
10000002
10000003

                  Key 1

9.  Hold         Off

Note: 
Refer to your Squeeze & Tease 3D WARP 
Owner's Guide for full details on the installation 
and operation of the Squeeze & Tease 
WARP option.
Synergy 100 Operation Guide (v16.10-S100) Appendix A. Menu Trees • 11–11



Default Menu Tree
The following figure illustrates the portion of the menu tree that is used to default your switcher 
settings.

Default Menu Tree

Default

0. All

MENU
Exit

100
Previous

10
Down

1
Up

SEL
Accept

Main Menu - Synergy 100

0. Effects
1. Inputs

MENU
Exit

100
Previous

10
Down

1
Up

SEL
Accept

2. Outputs
3. GPIs
4. Communication

vX.XX-S100

5. Disk
6. Personality
7. Options
8. S&T 3D
9. Default

WARNING!

This function will reset the switcher to its 
Factory Defaults.
Are you certain you wish to do
this?

10
Down

1
Up

SEL
Accept

0. Confirm 1. Cancel
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Glossary of Terms

Active Video Lines — All video lines not occurring in the vertical blanking interval; the 
portion of the video signal that contains picture information.

Aspect Ratio — The numerical ratio of picture width to height, for example, 4:3 or 16:9.

Auto Transition  — An automatic transition in which the manual movement of the fader handle 
is simulated electronically. The transition starts when the AUTO TRANS button is pressed and 
takes place over a pre-selected time period measured in frames.

Border  — Effects created around the edges of a pattern or on a keyer. If an optional dual border 
generator card is installed, several border, shadow, and outline effects are available on that keyer 
as well.

Border Generator  — Circuitry which generates various border effects on keys created by the 
switcher.

Chroma Key  — An effect in which video from one source replaces video of a specific hue in a 
second video source. The blue and green hues are most commonly used for chroma keying.

Chrominance  — The “depth” or saturation of a color. The three characteristics of a TV color 
signal are chrominance, luminance and hue.

Cut  — An instantaneous switch from one video signal to another.

Dissolve  — A transition from one video signal to another in which one signal is faded down 
while the other is simultaneously faded up. The term “mix” is often used interchangeably with 
“dissolve”.

Downstream Keyer (DSK)  — A keyer that places a key “downstream” of the MLE effects 
system output. This “top level” effect usually consists of a character generator title.

External Key  — A video input (non-primary video) used to produce a key effect. Examples of 
external key sources are character generators and cameras.

Fade-to-Black  — A controlled change of the on-air picture signal level down to black level.

Field  — One half of a complete picture (or frame) interval containing all of the odd, or all of the 
even lines in interlaced scanning. One scan of a TV screen is called a “field”; two fields are 
required to make a complete picture (which is a “frame”).
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Field Frequency  — The rate at which one complete field is scanned, approximately 50 times 
per second in 625 video or 60 times per second in 525 video.

Frame — One complete picture consisting of two fields of interlaced scanning lines. 

GPI — An abbreviation for General Purpose Interface, a device which typically allows remote 
control of the switcher’s automatic transition functions.

Hue — The characteristic of a color signal that determines whether the color is red, yellow, 
green, blue, purple, etc. (the three characteristics of a TV color signal are chrominance, 
luminance, and hue). White, black, and gray are not considered hues.

Internal Key — The use of a primary input to produce a key effect.

Key — An effect produced by “cutting a hole” in background video, then filling the hole with 
video or matte from another source. Key source video cuts the hole, key fill video fills the hole. 
The video signal used for cut and fill can come from the same or separate sources.

Key Fill — A video input which is timed to “fill the hole” provided by the key source video. An 
example of key fill is the video output of a character generator.

Key Invert — An effect which reverses the polarity of the key source so that the holes in the 
background are cut by dark areas of the key source instead of bright areas. The KEY INV 
push-button selects this effect.

Key Mask — A keying technique in which a pattern is combined with the key source to block 
out unwanted portions of the key source.

Key Source — The video signal which “cuts a hole” in the background video to make a key 
effect possible. Also called “Key Video”. In practice, this signal controls when a video mixer 
circuit will switch from background to key fill video.

Key Video — See Key Source.

Linear Keys — Linear keys make it possible to fully specify the transparency of a key from 
opaque, through transparent, to fully off. The transparency is specified by the key signal (also 
known as the “hole cutter” or “alpha channel”) that is associated with the key fill. A keyer 
capable of a linear key converts the key signal voltage directly to the transparency effect on the 
screen. Our switcher’s KEY MEM button allows the user to store the CLIP and GAIN settings 
required to match the incoming key signal to the keyer’s requirements.

Line Frequency — The number of horizontal scans per second. For 525 line 60 Hz systems, 
this is approximately 15734 scans per second.

Luminance Key — An effect in which video from one source is replaced by video that exceeds 
a set level in a second video source.

Mask — See Key Mask.

Matte — A solid color signal which is generated by the switcher and can be adjusted for hue, 
saturation, and luminance levels.

Matte Key — A key effect in which the fill video is matte, provided by one of the switcher’s 
matte generators.

Memory — The memory feature provides storage and recall of complete switcher setups.
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MIX — See Dissolve.

MLE — An abbreviation for multi-level effects.

PGM Output — The on-air video output of the system.

Primary Input — Video sources selected by the control panel push-buttons for the crosspoint 
buses. These buses are normally labeled “KEY”, “PGM” or “BKGD”, and “PST”.

PV Output — A switcher output which shows the scene that will go on-air when the next 
automatic or manual transition takes place.

Self Key — A key effect in which the same video signal serves as both the key signal and key 
fill.

Soft Edge — A pattern edge effect produced by mixing key source and key fill signals in such a 
way that the edge of the pattern is not sharp.

Split Screen — An effect in which a wipe pattern provides the key source signal. This is known 
as a “preset pattern” key.

Tally — An indicator which illuminates when the associated push-button or control is selected or 
is on-air.

Termination — A means of closing a circuit by connecting a resistive load to it. In video 
systems, a termination is typically a 75 ohm resistive load.

Transition — A controlled change from one video input to another video input or black. The 
change can occur through a wipe, cut, dissolve or “DVE Send” effect.

Transition Preview — A transition seen only on the preview monitor. It may be observed and 
adjusted without disturbing the program or “on-air” output.

Video — The electrical signal produced by a television camera, character generator or other 
image source. The signal amplitude varies in relation to the tonal scale from black to white 
presented at the source. White produces the highest amplitude; black produces the lowest signal 
amplitude.

Wipe — A transition from one video signal to another, in which the change proceeds according 
to the shape of a specific pattern. A moving transition line separates the two picture signals.
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